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1 Safety and Warranty 

1.1 Cautions and Warnings 

1.1.1 Use of Equipment 

The C8000 Battery Testing System is designed with adequate safeguards to 
protect you from shock and other hazards when used as specified within this 
document.  However, if the equipment is used in a manner not specified by this 
documentation, the protection provided by this equipment may be impaired.  
Please read this document and equipment labeling before using the equipment.  

1.1.2 Modification of Equipment 

CE, FCC, Safety Agency, and other approvals apply only to the C8000 Battery 
Testing System in the factory-authorized configuration. Changes or modification 
to the equipment not expressly approved by Cadex will void the approvals and 
void your authority to operate the equipment.  
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1.1.3 Hazard Symbols 

The following symbols are used to warn of potential hazards:  

  Warning or Danger 
Information that, if ignored, can result in serious injury or death. 

  Caution 
Information that, if ignored, can result in damage to the C8000 Battery Testing 

System, battery adapters, or the battery. 

  Potential Electrical Shock Hazard 

 Potential Explosion Hazard 
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1.1.4 Disposal of Waste Electrical and Electronic Equipment (WEEE) 
in the European Union 

 
 

This symbol on the product and package indicates that 
this product must not be disposed of with unsorted 
municipal waste.  Instead, it is your responsibility to 
dispose of WEEE by handing it over to a designated 
collection point for the disposal.  

The separate collection and recycling of waste 
equipment will help conserve natural resources and 
ensure that it is disposed of in a manner that protects 
human health and the environment.  For more 
information about where to drop off waste equipment 
for disposal, please contact your local municipal office, 
waste disposal service, or wherever you purchased the 
product. 

1.1.5 Radio Interference 

  Caution 

This equipment generates, uses, and radiates radio 
frequency energy. If the equipment is not installed 
and used in accordance with the instructions in 
this manual, it may cause interference with radio 
communications. 

The equipment has been tested and found to comply with the limits for a Class 
“A” digital device pursuant to Subpart B of Part 15 of the FCC Rules, which are 
designed to provide reasonable protection against such interference when 
operated in a commercial environment.  Operation of this equipment in a 
residential area may cause interference, in which case you must take whatever 
measures needed to correct the interference, at your own expense.  

EN55011/EN55022 Warning: This is a Class A product according to 
EN55011/EN55022. In a domestic environment, this product may cause radio 
interference, in which case you must, at your expense, take adequate corrective 
measures. 

The equipment is designed with adequate safeguards to protect the user from 
shock and other hazards when used as specified within this document. If the 
equipment is used in a manner not specified by this documentation, the 
protection provided by the equipment may be impaired.  Please read the 
documentation and equipment labeling before using the equipment. 
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The equipment may be affected by interference from other devices. If the 
equipment is running abnormally, please ensure that the equipment is moved 
away from any source of radio interference. 

 

1.1.6 Explosion Hazard 

  Warning 

Batteries can burst if treated improperly. Follow 
these precautions at all times: 

 

Do  

 Clean battery contacts before servicing.  To clean battery 
contacts, use a lint-free cotton swab dipped in 100% 
isopropyl alcohol. 

 Press the battery firmly into the adapter. 

 Observe battery temperature, which is displayed on the 
C8000 Status screen.  Internal battery temperature must be 
between 5°C (41°F) and 50°C (122°F) during testing.  Stop 
service if the battery's internal temperature exceeds 50°C. 
Allow cold batteries to warm up and hot batteries to cool 
before charging.  The temperatures cited here are the 
battery temperatures, not the ambient temperatures. Fast 
charging outside this temperature range may damage or 
reduce the life of the battery.  

 

Do Not 

 Do not attempt to charge non-rechargeable and primary 
batteries such as alkaline, carbon-zinc, or non-rechargeable 
lithium batteries. 

 Do not short the positive and negative battery terminals 
together at any time. 

 Do not connect leads from one channel to another.  Failing 
to follow the guidelines in this manual could result in 
venting with flame, explosion, fire and personal injury. An 
electrical short to any point outside the channel bypasses 
the current regulation loop and may blow a fuse or cause 
permanent component damage. 
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 Do not exceed the battery manufacturer’s recommended 
charge current and voltage limits for batteries. 

 Do not remove the battery from the adapter while the test 
is running. To minimize arcing, stop or cancel battery 
service before removing the battery from the adapter. 

1.1.7 Charge and Discharge Lithium-ion (Li-ion) Batteries 

Lithium-ion (Li-ion) batteries are safe when used as directed.  Battery safety 
cannot be assured when a battery pack is built with individual cells of an 
unknown nature with a serial and parallel connection.  Not all Li-ion cells are 
suited for multi-cell packs. Only cells that meet tight voltage and capacity 
tolerances can be used for serial and parallel connection.  Mismatched packs are 
subject to overcharge resulting in venting with flame and fire. Check with the cell 
manufacturer to see if the cells are suitable for multi-cell packs.  

In the past, single Li-ion cells were only available to authorized battery 
manufacturers. Today, imports are becoming readily available and often fall 
into the hands of the inexperienced. While most brand name cells are 
equipped with an internal cell disconnect that permanently opens the current 
path on high pressure, some brands do not provide this safeguard. Many 
brands don’t use a separator that shuts down the battery when high 
temperatures are reached. The internal safety features are omitted for cost 
reasons. 

  Warning 

Please follow these guidelines when charging and 
discharging lithium-ion cell(s) and packs.  Failing 
to follow these rules could result in venting with 
flame, explosion, fire and personal injury. 

 

Explosion Hazard 

 Never connect cells in parallel and/or series that are not designed for that 
purpose. A cell mismatch may overcharge and vent with flames. 

 Never charge or discharge the battery without connecting a working 
protection circuit. Each cell must be monitored individually and the current 
disconnected if an anomaly occurs. 

 Always attach a temperature sensor when charging and discharging the 
battery. The temperature sensor must disconnect the current on excess 
temperature. 
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1.1.8 Shock Hazard 

  Warning 

The C8000 Battery Testing System contains high-
voltage circuits, and can pose a shock hazard 
when the upper cover is removed. Do not attempt 
to perform any service procedures on the tester 
other than replacement of the external fuse or 
internal backup battery. 

 

Shock Danger 

 To reduce the risk of electrical shock hazard, service batteries only when 
they are removed and disconnected from their end-use equipment.  

 Use the tester only as specified in the documentation. Other uses may impair 
the protection provided by the unit. 

 Use only a grounded AC outlet to power the tester. 

 Before attempting any internal service, remove all batteries from the battery 
channels, turn the C8000 Battery Testing System off and disconnect the 
power cord from the wall socket. Wait a few minutes before opening the 
cover. 

 Replace fuses only with fuses of the same type and rating.  

 Replace the internal backup battery only with the same type of battery.  
Observe the correct polarity when installing the backup battery. Discard the 
used battery according to the battery manufacturer’s instructions. 
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1.2 Warranty and Service 
Cadex Electronics Inc. warrants your C8000 Battery Testing Unit against 
defective materials and workmanship for a period of two (2) years from the 
original purchase date.  

The warranty does not cover: 

 Damage caused by abusive operation, negligence, accident, or improper 
installation. 

 Damage caused by an attempted repair not authorized by Cadex. 

 Cosmetic damage caused by normal wear and tear. 

 Damage from external causes such as leakage spills, power fluctuations, 
power failures, or inadequate shipping. 

 Product received without the appropriate model number, serial number, or 
safety markings. 

 Products used for rental purposes. 

1.2.1 Warranty Service 

Before sending the unit for service, contact Cadex Technical Support.  If your 
product requires warranty service, the representative will provide a Material 
Return Authorization Form or Material Return Authorization (MRA) and the 
location of the nearest service center.  

 Ship the product to the service center with freight, insurance, and customs 
duties prepaid. The MRA must be included to obtain warranty service. 

 Ensure that each unit is properly packed before shipping, preferably in the 
original Cadex boxes. Damage caused in transit due to improperly packed 
items is not covered under warranty. 

 Products returned from warranty service are shipped with freight prepaid 
by Cadex. 
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1.2.2 Non Warranty Repairs 

Before sending the unit in for service, contact Cadex Technical Support at 1-800-
565-5228 or 1-604-231-7777. If your product is not covered by warranty, the 
representative will provide the contact information for the nearest service center.  
You may contact the service center directly to arrange to send the product in for 
service.  A Return Authorization form or number will be provided only if the 
product is returning to the Cadex Head Office.  

 Ship the product to the service center with freight, insurance, and customs 
duties prepaid. 

 Ensure that the unit(s) is properly packaged before shipping. 

Cadex Electronics Inc. and Cadex authorized service centers require a Purchase 
Order or written authorization to precede with repairs. 

 

1.3 Back Up and Restore Calibration Data 
It is possible to manually back up the calibration data for each 
C8000 using the System Update window. This calibration data 
includes the settings used on the unit, such as the IP address and 
mask. Back up of the calibration data from the PC to removable 
media (writeable CD, DVD, or magnetic tape) is recommended.   

1.3.1 Back Up Calibration Data 

 
If required, following the instructions below can perform a 
manual backup of the calibration data. Note:  By default the 
calibration data is stored in the following location; C:\Documents 
and Settings\All Users\Application Data\Cadex Batlab\DB\ 
Calibration   

1. From the Tools menu, click System Update. 

2. Select the check box for each C8000 to back up calibration 
data for. 

3. Under the Calibration tab, click Backup Calibration Data.  

4. Click OK. 

1.3.2 Restore Calibration Data 

BatteryLab copies (restores) backed up calibration data from the 
database. 

To restore calibration data:  
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1. From the Tools menu, click System Update. 

2. Select the check box for each C8000 to restore calibration 
data for. 

3. Under the Calibration tab, click Restore Calibration Data 
to restore previously backed up data. 

4. Click OK. 

 

  Important 

Each new C8000 has been calibrated at the factory, 
and has its factory calibration data stored on the 
C8000.  This calibration data is essential to providing 
accurate testing of batteries. 

On receipt of each new C8000, configure the unit with 
a static IP address, the network mask address, and the 
PC Host IP address. Then run BatteryLab and 
configure BatteryLab to allow connection from the new 
C8000. Choose Connect to allow BatteryLab to 
automatically backup the calibration data for the new 
C8000. 

This calibration data is essential to providing accurate 
testing of batteries. After installing and configuring 
Cadex BatteryLab to communicate with the C8000, use 
BatteryLab to back up the calibration data to the 
computer. 

Each new C8000 should be connected to the PC for 
BatteryLab to automatically back up the calibration 
data. 

If, for any reason, the calibration data on the C8000 
gets corrupted, the calibration data can be restored 
from the backup copy. Otherwise, the C8000 must be 
shipped to a Cadex Service Centre for re-calibration.  
The shipping and service cost is not covered by the 
warranty. 
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2 Battery Tester 

2.1 Getting Started with the Battery Tester 

2.1.1 The C8000 Battery Tester User Manual 

Welcome to the Cadex C8000 Battery Tester User Manual.  This 
manual provides instructions to configure the C8000 and to test 
batteries. Up to four batteries can be tested at any time using one 
of several testing programs.  

2.1.1.1 Topics You Need to Know 
To properly use the C8000, review the following sections of this 
manual:  

 Cautions and Warnings 

 Configure the C8000 

 Test Batteries 

 View Test Results 
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  Caution!  

The C8000 has been calibrated at the factory and has 
its factory calibration data stored on it.  The calibration 
data is automatically backed up to a file in the 
\Batlab\DB folder (or the folder indicated in the About 
window) when a C8000 connects to Cadex BatteryLab. 

If for any reason, the calibration data on the C8000 
gets corrupted, restore the calibration data from the 
backup copy provided by Cadex Electronics. 

For more information, see 1.3 Back Up and Restore Calibration Data. 

2.1.2 What is in the Box 

The C8000 box contains: 

 (1) C8000 Battery Testing System (Part #11-308-0000) 

 (4) 1.8m (6’) Power port cables (for battery ports)   

   Power Port Cable (Part #17-670-0058)  

Alligator Clips: 

 Part #62-634-0002 (Red 2mm) 

 Part #62-634-0003 (Black 2mm) 

 Part #62-634-0010 (Red 4.4mm) 

 Part #62-634-0011 (Black 4.4mm) 

 Specifications:  

o Voltage:  0~48V 

o Current: 0~10A 

o Wattage: 0~100W 

 (4) 1.8m (6’) Auxiliary data cables (for I/O ports) (Part#17-
670-0059) 

 (1) C8000 DUAL POWER PORT CABLE (Part# 17-070-
1008) 

 Specifications:  

o Voltage:  0~48V 

o Current: 0~20A 

o Wattage: 0~200W 
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 (3) Power cords 

(1) North American power cord (Part #68-723-1815) 

(1) British power cord (Part #68-723-1806) 

(1) European power cord (Part #68-723-1805) 

 (1) 3m (10’) Ethernet cable 

 (The supplied Ethernet cable is only required for 
communication between BatteryLab and the 
C8000.) (Part #68-931-0010)  

 (1) BatteryLab PC software on CD-ROM (Part #84-100-
0010)  

 

Before configuring the C8000 Battery Tester, become familiar with 
the Front Panel, Back Panel and Components of the Battery 
Adapter sections of this manual.  When ready, see section 2.5 
Configure the C8000 to continue.  

 

  Caution 

The case of the C8000 has air vents to allow cooling 
airflow.  Do not cover, block, or obstruct the air-vents. 

2.1.3 Optional C8000 Accessories 

2.1.3.1 C8000 Adapter Unit 
Desktop converter unit that provides cross platform compatibility 
with SnapLockTM and RigidArmTM Battery Adapters (4-wire 
version only). Battery applications include Cellular phones, 2-way 
radios and other custom applications. 

Specifications: 

Supports all RigidArm and SnapLock 4-wire series adapters. 

2.1.3.2 RigidArmTM Universal Battery Adapter 
RigidArmTM allows for easy connection to cellular batteries of any 
size. Spring-loaded arms lock in position to allow quick and 
accurate setup for repetitive testing. A retractable floor holds 
batteries vertically or horizontally; adjustable magnetic battery 
guides are included. Requires C8000 Adapter Unit. 

Specifications:  

Voltage: 18V 



C8000 Battery Testing System User Manual  

Battery Tester  13 

Current: 3A 

2.1.3.3 SnapLockTM Universal Battery Adapter (4-wire versions only) 
SnapLockTM gives a precise connection to the battery allowing for 
easy hook up. The adapter contains C-Codes that can be used to 
configure the C8000 and other Cadex platforms to the correct 
setting. Specialty adapters available on request. Requires C8000 
Adapter Unit. 

Specifications:  

Voltage: 18V 

Current: 3A 

 

2.1.3.4 Load Capture Unit (LCU) 
LCU captures and stores load signatures (in BatteryLab) of any 
device up to 100A in real-time. Capture a power tool load 
signature (or any other electronic device) by drilling through a 
steel beam. Then apply a repeatable load signature to any battery 
to determine; performance characteristics, battery life, time of use, 
etc. Other applications for the LCU include spinning up a hard 
drive on a laptop or accelerating an electric motor. 

Specifications:  

Buss-bar Current: 

o 0-10A (2% of Full Scale, Ripple: 20mA) 

o 0-100A (2% of Full Scale, Ripple: 50mA) 

External Current Clamp: 
o 0-400A (1% of Full Scale, Ripple: 500mA) 

Voltage Input Terminals: 

o 500mV~48V (2% of Scale, Ripple: 20mV)  

Capture Frequency: 

o DC to 250Hz 

Thermal Couple:  

o Supports K-type – 

  ±2°C plus Thermal Couple accuracy  

 

2.1.3.5 C8000 Rack Mounting Bracket Set  

                                                     For 19” 3U mounting type rack. (PN# 92-470-0054) 
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Display and Controls 

2.1.4 Front Panel  

  

2.1.4.1 LCD Settings 
The LCD screen displays the fields that you need to fill in prior to 
executing a test and also displays test status and results. Use the 
keypad and arrow buttons to enter information into the fields on 
the screen.  

2.1.4.2 Channel Key Buttons 
There are four channel key buttons below the LCD screen. The 
functions of these buttons vary depending on the window 
displayed on the LCD.  The function (if any) of each button is 
displayed on the screen, just above the button.  
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2.1.4.3 Arrow and ENTER Buttons 

 

Use the arrow buttons to move from 
field to field.  

Use the ENTER button to accept the 
information entered into the fields 

 

 

 

Note: The Menu and Print buttons are not used. The Edit button 
activates the onscreen keypad when an editable field is selected on 
the C8000. 

2.1.4.4 Navigating the LCD Display 

 Use the , and  arrow keys to move from one field to 
another. 

 Press the Edit key to activate the selected remark field for 
edits. 

 Use the  and   keys to scroll through the alphabet. 
Press ENTER to select the letter. 

 Use the numeric keypad to enter numbers in the selected 
field. 

 Press ENTER to save the data you have entered in the field 
and move to the next field. 

 Press OK to save the data you entered in the screen. 
 

2.1.4.5 Numeric Keypad 

 

Use the Numeric Keypad to enter 
numbers in the selected field. 

To exit from a field without saving 
changes, press the ESC key.  
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2.1.4.6 Battery Port Connections 
There are four port connections, to attach up to four battery 
adapters.  

Each channel has a battery port, an auxiliary input/output, and a 
circuit breaker.  

 

Each Battery Port is used to plug 

a Power Port Cable and I/O Port 

is used for secondary 

measurements and control. A 

C8000 Adapter Unit use both 

ports for the SnapLock
 TM

 

/Rigidarm
 TM

 series adapters For 

more information about the 

SnapLock Adapter, see 2.1.3.3 

SnapLockTM Universal Battery 

Adapter (4-wire versions only). 

If the plastic button on a circuit 

breaker pops out, the breaker has 

tripped. Determine and correct 

the condition that caused the 

breaker to trip. 

Allow the breaker to cool for 15 
minutes before pushing in the 
button to reset the breaker. 

 

A battery adapter may not always be available. 

In most cases, the channel cable will terminate with 
positive/negative wires and have a magnetic temperature probe 
to attach to the battery. 

If the breaker button does not stay in when you push it, allow 
more time for the breaker to cool. (The breaker does not 
automatically reset.)
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2.1.5 Back Panel 

  

2.1.5.1 AC Input 
The AC Input connects the C8000 to an AC electrical power source 
with the provided power cord. The power entry uses standard 
IEC320 socket on the back panel. A fuse protects the C8000 from 
AC overload.  

2.1.5.2 Ethernet Port 
The Ethernet port is used to connect the C8000 to the network or 
the host computer. The Ethernet Port (on the back panel) has two 
LEDs to indicate communication between the C8000 and a 
computer.  

Use this port with the TCP/IP Settings menu.  For more 
information, see 3.1.8.5 TCP/IP Settings. 

 

2.1.5.3 Serial Ports and USB Port 
The first Serial Port (DB9 Female I/O sockets) on the C8000 is 
reserved. The intended uses of the remaining Serial Ports are for 
Cadex-approved External Loads (Serial Port 2) and Thermal 
Chamber (Serial Port 3) controls.  

Pinout Serial Ports (2) and (3) 

1 – Not Used 

2 – RX (Receive signal) 

3- TX (Transmit signal) 

4- DTR (Digital Terminal Ready) 5V 
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5 – GND (Ground) 

6 – Not Used 

7 – RTS (Request To Send) 

8 – CTS (Clear To Send) 

9 – Not Used 

USB functionality is not enabled. 

2.1.5.4 Cooling Fans 
The thermostatically controlled fans operate automatically to keep 
the inside of the C8000 at optimum temperature. Keep all case 
vents and fan openings clear to ensure free airflow through the 
C8000. 

2.2 Cadex C8000 Adapter Unit 

 

 

2.2.1  Cadex C8000 Adapter Unit  

The Cadex C8000 Adapter Unit allows C7x00 adapter to be used 
with the C8000.  
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2.2.2 Connect the C8000 Adapter Unit to the C8000. 

1. Align the notch on the battery connector cable plug with the 
notch on the battery connector and push in the cable.  

2. Push the battery connector plug in while turning the ring on 
the battery connector clockwise until the lock is engaged. 

 See 2.3.2 Connect the Power Port Cable to the C8000 for 
instructions on how to connect the Power Port Cable. 

3. Push the DB25 female connector in to corresponding 
Auxiliary connector of the C8000 channel and tighten the 
connector hand screws. 

 

To remove the battery connector cable from the C8000, turn the 
ring on the connector plug counter-clockwise and then pull the 
cable plug out of the connector.  
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2.3  Cables 

2.3.1 Power Port Cable 

 

The Power Port Cable conducts electric power between a 
connected battery and the C8000. The Power Port Cable is used 
only for power transfer, voltage measurement and temperature 
reads – all other functions operate via the Auxiliary Input/Output 
(I/O) cable. 

To achieve better accuracy, the C8000 utilizes a four-wire design, 
where the two main wires provide a path for charge and 
discharge currents while the other two paths measure the voltage 
as close to the battery as possible. 

 

 

2.3.2 Connect the Power Port Cable to the C8000 

a. To connect a Power port cable or Dual power port cable. 

i. On the C8000 front panel, choose your desired battery channel. 

Note: The Dual power port cable can be connected to channels 1 & 2 

and/or 3 & 4. 

ii. Align the notch with the tab on the power port cable connector (see 

connector end diagrams). 
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Figure 1 – Power port cable connector end-view 

 

Figure 2 – Dual power port cable connector end-view 

iii. Push the battery connector plug into the desired battery channel outlet 

(on the C8000), then rotate the locking wheel to secure the connector to 

the battery channel outlet. 
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Figure 3 – Channel 1 outlet (on C8000) 

iv. The Power port cable is now ready to connect to a battery. 

To remove the battery connector cable from the C8000, turn the 
ring on the connector plug counter-clockwise and then pull the 
cable plug out of the connector. 

 

 

 

The following diagram shows how the Drive and Sense lines of 
the cable should be connected for normal operation. 

The cable has six leads as follows: 

 Two drive lines with heavy gauge wire to supply the 
charge and discharge current 

 Two sense lines to measure the voltage on the battery 
terminals. Warning: Sense lines should be connected to the 
battery terminals and correctly installed - otherwise, 
incorrect operation may occur. 

The sense plugs can be plugged into the drive plug molded 
body for single connection to the battery. 

 Two for the magnetic temperature sensor. The magnetic 
temperature probe should be attached to the casing of the 
battery. 
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2.3.3 Auxiliary data cables (for I/O ports) 

The Auxiliary data cables (for I/O ports) enables the C8000 to 
interface with third-party devices, the Cadex 
SnapLock/RigidArm series (when using the C8000 Adapter Unit), 
and SM-Bus batteries. 

Custom programs can be configured to control and respond to 
states of the configurable lines. 

The connector provides the following interfaces: 

 SM-Bus 

 Four configurable Digital Inputs or Outputs (Program 
Configurable) (Pull-up Required) 

 Two Analog outputs (Program Configurable) 

 Four Differential Analog inputs with selectable ranges 
(Program Configurable). 
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Note: Once theC8000 Adapter Unit is connected, the input/output 
ports become reserved. 

The following diagrams show the pin and electrical specifications 
of interfaces for the Auxiliary Input/Output Connector. 

Auxiliary data cables (for I/O ports) Pinout Diagram 
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Auxiliary data cables (for I/O ports) Wiring Chart 

Pin # Function  Wire Color 

1 Digital I/O 1 White 

2 Digital I/O 2 Yellow 

3 Digital I/O 3 Orange 

4 Digital I/O 4 Pink 

5 Analog Out 1 Gray 

6 Analog Out 2 Brown 

7 Ground Black 

8 +5VDC Red 

9 SMBC Purple/white 

10 SMB D I/O Brown/white 

11 SMB DO Black/white 

12 Reserved Yellow/black 

13 Reserved Pink/black 

14 Ground Green 

15 Temperature (T+) Blue 

16 Pressure (P+) Purple 

17 Differential Analog Input 1 Positive (+) Red/white 

18 Differential Analog Input 1 Negative (-) Red/black 

19 Differential Analog Input 2 Positive (+) Orange/white 

20 Differential Analog Input 2 Negative (-) Orange/black 

21 Differential Analog Input 3 Positive (+) Green/white 

22 Differential Analog Input 3 Negative (-) Green/black 

23 Differential Analog Input 4 Positive (+) Blue/white 

24 Differential Analog Input 4 Negative (-) Gray/black 

25 Ground Light green 

Shell Earth Drain 
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2.4 C8000 Specifications 

2.4.1  C8000 System Techincal Specifications 

 Channels 4 Independent Channels each including: 

 1 Battery Port + 1 I/O Port 

Physical  

 Dimensions 480mm x 380mm x 140mm (18.9” x 15.0” x 5.5”) 

 Weight 15.5 kg (34 lb) 

 Mounting Options Desktop or 19” (483mm) 3U Rack-mount  

 Display 5.7” (145mm) QVGA 320x240 graphics with 
backlight 

 Battery Ports (front panel) 4 Ports each including: 

 Battery Positive (+) 

 Battery Negative (-) 

 Sense Positive (+) 

 Sense Negative (-) 

 Thermistor Input 

 Thermistor Ground 

 Auxillary Ports (I/O) (front panel) 4 x DB25 Type each including: 

 4 Differential Analog Inputs: 0-5V, 0-10V, or 
0-15V 

 4 Digital Inputs: 0-5V 

 2 General Purpose Analog Outputs: 0-5V 

 SMBus Enabled: 5 Possible Termination 
Signals 

 Active Data Ports (back panel)  Ethernet 10/100MB for connection to PC 

 Designated Serial Port for External Load 

 Designated Serial Port for Environmental 
Chamber 

Environment 

 Operating Temperature 5ºC-35ºC (40ºF-95ºF) 

 Storage Temperature -20ºC-70ºC (-4ºF-160ºF) 
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Battery Compatibilty 

 Chemistries All Standard Battery Types 

 Lead Acid 

 Ni-based: NiMH, NiCd 

 Li-based: Li-ion, Li-Phosphate 

 Capacity Range 50mAh to 1000Ah 

  

Electrical 

 Input Power  100-240 VAC 

 50-60 Hz 

 Battery Voltage Range Nominal 1.2V-36V (max 45V) supports serial 
connection of: 

 Up to 10 Li-ion cells (3.6V/cell) 

 Up to 18 Lead Acid cells (2.0V/cell) 

 Up to 30 Nickel-based cells (1.2V/cell) 

 Maximum Charge Power 100W per channel = 400W total 

 Maximum Discharge Power 80W per channel = 320W total 

Dual Power Port cable may be to increase the 
maximum Power Rate to 160W per channel pair  

External Load may be used to increase 
Discharge Rate up to 2400W 

 Maximum Charge/Discharge 
Current 

30mA to 10A set in 1mA increments 

Dual Power Port cable may be to increase the 
maximum Discharge Rate to 20A per channel 
pair 

External Load may be used to increase 
Discharge Rate up to 240A 

 Output Frequency Square 2 kHz (500 microseconds) 

 C8000 Accuracy  Voltage = 0.1% full scale 

 Current = 0.25% full scale 

Other Specifications 

 Power Management Current automatically scaled down if power 
limits are exceeded – message indicates scaled 
test 

 Charge Methods Charge methods are dependent upon chemistry: 

 Li-ion + Lead Acid = constant current/ 
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constant voltage 

 Nickel-based = constant current (DC 
charge) with optional Reverse Load Charge 
method  

 Discharge Methods  Constant current 

 Constant power 

  

Data Acquisition 

 System Sample Rate 500 microseconds 

 Termination Data (last 500 
samples) Capture Rate 

2~200 milliseconds 

 Capture/Display Rate (non-
termination) 

1~60 seconds 

  

Certification 

 Safety CSA, UL, CE 

 Environmental RoHS, WEEE 

  

 

2.4.2 Auxillary Port Absolute Maximum Ratings 

When using the Auxiliary Input/Output Connector, the voltage 
settings for the pins must not exceed the absolute maximum 
ratings – otherwise the C8000 may become damaged. The absolute 
maximum ratings for the Auxiliary Input/Output Connector are 
as follows: 

 Voltage Setting Maximum Rating 

Voltage at Digital I/O 1-4: -0.1 to +6V 

Voltage at SMBC, SMBD or 

SMBDIO: 

-0.1 to +5.5V 

Voltage at Analog Output 1-2: -0.1 to +6V 

Voltage at T+ or P+: -0.1 to +5V 

Voltage at Differential Analog 

Input 1-4 (either input, relative 

to ground): 

-50 to +50V 

Voltage at Differential Analog ±50V 
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Input 1-4 (differential): 

Current at Digital I/O 1-3: -20mA (open collector / sinking 

only) 

Current at Digital I/O 4: -100mA (open collector / 

sinking only) 

Current at Analog Out 1-2:  ±5mA 

Current at +5VDC:  +100mA 

2.4.3 Auxillary Port Operating Ratings 

When using the Auxiliary Input/Output Connector, the operating 
ratings must be set according to the following settings: 

Voltage Setting Operating Rating 

Voltage at Digital I/O 1-4:   0 to +5V (A Pull-up is required) 

(open collector) 

Voltage at SMBC, SMBD or 

SMBDIO: 

0 to +5V 

Voltage at Analog Output 1-2: 0 to +5V (±1mA) 

Voltage at T+ or P+: 0 to +3.3V 

Voltage at Differential Analog 

Input 1-4 (either input, relative 

to ground): 

0 to +48V 

Voltage at Differential Analog 

Input 1-4 (differential, + relative 

to -):  

0 to +15.5V 

 

Impedance of Analog Input + to 

-  

~1.1MOhm 

Impedance of Analog Input + to 

gnd  

~100kOhm 

Impedance of Analog Input - to 

gnd 

~1MOhm 
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2.5 Configure the C8000 

2.5.1 Set Up the C8000 

To set up and configure the C8000 perform the following steps: 

1. Plug in the power cord and ensure the battery adapter cords 
are properly connected to the C8000.  

2. Switch ON the C8000 set the clock and enters user information. 
For instructions, see 2.11.1 Set the Clock and 2.11.2 User 
Information. 

3. If required, use LCD Settings to adjust the contrast of the LCD 
display.  See 2.11.3 LCD Settings for more information.  

 

2.6 User Maintenance for the C8000 

2.6.1 User Maintenance Warnings 

  Warning 

There are no internal user-serviceable parts in the 
C8000 other than the internal backup battery. 

Except for changing the battery, unauthorized 
disassembly and/or repair of the C8000 by anyone 
other than an authorized Cadex Service Center may 
cause a risk of injury or death and will void the 
warranty. 

For more information, see 1.1 Cautions and Warnings. 
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2.6.2 Clean the C8000 

  Caution 

Before cleaning, turn off the power and unplug the AC 
power cord. 

Do not allow any liquids to enter the case under any 
circumstances. 

Clean the C8000 only with a damp cloth moistened 
with mild soap and water.  Allow to thoroughly dry.  

For more information, see  1.1 Cautions and Warnings. 

2.6.3  
Replace the Fuse 

If the C8000 does not power up, make sure that the power cord is 
properly inserted and that power is available.   

If the C8000 still does not power up, the main (AC input) fuse may 
need to be replaced.  

Replace fuses only with fuses of the same type and rating:  
Fuse 5x20mm T8A 250V, Cadex part number 52-546-0800. 

  Caution 

Before replacing the fuse, unplug the power cord and 
allow the C8000 to cool for at least one minute.  

The C8000 contains capacitors that could retain a 

charge after the AC power is disconnected. 

For more information, see  1.1 Cautions and Warnings. 

To replace the main fuse: 

1. Remove all batteries and adapters, turn off the C8000, and 
unplug the power cord from the AC Input.  

 Wait at least one minute before continuing. 

2. Using a flathead screwdriver, position the screwdriver at 
the top of the fuse cover (beneath the AC Input) and pry 
open the fuse cover.  

3. Carefully pull out the fuse. 
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4. If the filament inside the glass tube is broken, replace the 
fuse. Be aware that the filament can sometimes appear 
intact even when it is broken. 

5. With the fuse inserted, push the fuse cover back into place. 

6. Connect the power cord and turn ON the C8000. 
 

2.6.4 Replace the Backup Battery 

  Caution!  

Test results may be lost when the backup battery is 
removed. Backup the calibration data to the PC hard 
disk. Retrieve test results stored on the C8000 to the 
BatteryLab database. To download the test results to 
BatteryLab, select Retrieve Results from the File menu 
on the Test Results window. For more information, 
see 3.6 View Test Results in BatteryLab. 

The C8000 uses a 3-volt lithium coin battery (type CR2032 or 
equivalent, Cadex part number 45-206-0001) to preserve settings 
while the C8000 is turned OFF.  With normal use of the C8000, 
you will seldom need to replace the backup battery. 

 

 

  

You will need the following items to replace the battery: 

 A #2 Phillips screwdriver. 

 A new 3-volt lithium battery. 

 A wrist strap or other device to eliminate electrostatic discharge. 



C8000 Battery Testing System User Manual  

Battery Tester  33 

  Caution! Electrostatic Sensitive Device 

Do not open the C8000 or touch any part of its internal 
components if you are not grounded.  

Do not attempt to open the C8000 while it is plugged 
into an electrical outlet or any peripheral device.  
Severe electrical shock to the operator and/or damage 
to the C8000 could result! 

For more information, see  1.1 Cautions and Warnings. 

To replace the backup battery in the C8000: 

1. Remove all batteries and adapters, turn off the C8000 and 
unplug the power cord and I/O port cords.  

 

 

Wait at least one minute before continuing. 
Do not attempt to open the C8000 while it is 
plugged into an electrical outlet or any 
peripheral device. Severe electrical shock to 
the service person and/or damage to the 
C8000 could result! 

2. Use a Phillips screwdriver to remove the following screws: 

 Two screws on the right side. 

 Two screws on the back panel. 

 Two screws on the left side. 

 One screw on the top. 

3. Remove the top cover by sliding it back slightly and then lifting. 
The backup battery is located at the back of the C8000, in 
front of the expansion slot and between two fans. 

4. Move the upper clip of the battery holder out of the way.  

5. Using your fingers or insulated pliers or tweezers, gently 
pull the old battery out of the holder. Be very careful not to 
damage the battery.  
 

 

Do not use pliers or tweezers with bare 
metal tips.  They will short the battery and 
could cause it to explode. 
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Ensure correct battery polarity. 

 
Insert the new battery in the holder, with the positive terminal 
facing toward the fan until the clip slips in place.  

1. Replace the cover, making sure that no interior wires or 
cables are caught or pinched between the cover and the 
C8000 case.  

2. Replace the seven cover screws. 

3. Plug in the power cord and cables. 

4. Turn ON the C8000. The settings may have returned to 
factory defaults, in which case you will need to reprogram 
settings. 
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2.7 The Battery Tester Application 
Customizing features not available in standalone: 

1. Waveform creation (Waveform revision information only) 

2. Custom Programs (Version/Comment/ “I/O” port 
configuration only) List feature only. 

3. No Graphing or Detail information for Test Results. 
(Summary of information only). 

4. No Load Capture capabilities. 
 
When you power on the C8000 without any batteries 
connected, the Main screen appears:  When connected to 
BatteryLab, the C8000 displays the Unit # that corresponds 
to BatteryLab’s windows.  

 

The Main screen displays six menu items: 2.7.2 Test Results, 2.7.3 
Battery Profiles, 2.8 C-Codes, 2.9 Programs, 2.10 Waveforms, and 
2.11 Specify System Options.  
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The date appears in the top left corner of the Main screen while 
the time appears in the top right corner. When the caption says 
C8000 – Unit 3, it means the C8000 is connected to BatteryLab. If 
the caption says Cadex C8000, it means the C8000 is in standalone 
mode. The bottom portion of the Main screen shows the channel 
status on the first line and the channel voltages on the second line. 

2.7.1 Execute a Program on a Battery 

2.7.1.1 Execute a Program without BatteryLab 
To execute a program (test) on a battery in standalone mode 
without using BatteryLab:  

1. Connect the battery. 

2. Select a battery ID or C-Code from the StartUp screen. 
Note: If the StartUp screen is minimized, the channel 
status indicates “Startup”. Press the Channel button to 
maximize the screen. 
 

 
 

3. Select a program from the list of available programs on the 
C8000. The list of available programs includes all Default 
programs and any custom programs that have been 
transferred to the C8000. 

4. The test starts. 
 

If a test is currently running, press the corresponding Channel 
button to view current status on the Channel screen. The Channel 

screen displays the status of this channel. From the Channel 
screen you can suspend a program (2.7.1.2), resume a suspended 
program (2.7.1.2), abort a program (2.7.1.3), jump to another step 
in a multi-step program (2.7.1.5), and view auxiliary input and 
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output port information (2.7.1.4) 
 

The following table describes the fields shown in the Channel 
screen. 

 

 

 

Field Description 

Battery ID The battery’s identification. This field is 
blank of a Battery ID has not been added to 
BatteryLab. 

Program The name of the program that is being run. 

Cycles Indicates the number of charge and 
discharge cycles that have been run during 
any given program. 

Test Results Indicates the file name to which the current 
program’s results will be saved to, during 
operation. On completion of a program, 
indicates the file to which the results have 
been saved. Note: BatLab will generate an 
impendent TEST ID and will incorporate the 
data from the C8000 test result file.) 

C-Code The battery parameters being applied by the 
C8000. 

Step The step number for the action currently 
executing within the program. 

Volts Across the battery terminals. The current 
Voltage across battery sense terminal lines. 
(Screen is updated once per second.) 

Amps Charge or discharge current. (Screen is 
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updated once per second.) 

Temp Displays the current temperature at all 
times. If a thermistor is not attached, 
displays N/A. (Screen is updated once per 
second.) 

Capacity A percentage value showing the battery’s 
latest measured capacity. (Note: Only after a 
Discharge Cycle has been run); otherwise 
this displays N/A. 

M-Ohms The resistance of the battery measured in 
milliohms. Displays the latest resistance 
measurement otherwise N/A when 
resistance measurement is not selected. 

Elapsed The time since starting the program on this 
battery. Test times vary depending on the 
program chosen and the condition of the 
battery.  

 

1. From the Main screen, press the Channel button for the 
C8000 to test. The Channel screen appears. 
 

 

2. The Channel screen shows the status of this channel, 
providing a test is currently running. 

3. To view additional information, press MORE. A second 
Channel screen appears.  



C8000 Battery Testing System User Manual  

Battery Tester  39 

 

 

2.7.1.2 Suspend and Resume a Running Program 
While a program is running, it can be temporarily suspended. 
Later, the program can be resumed. 

1. From the Channel screen, click Suspend. The program is 
immediately interrupted. 

 

2. Press Resume to restart the program. 

2.7.1.3 Abort a Running Program 
To terminate a running program: 

1. From the Channel screen, press ABORT. The Confirm 

Action screen appears. 
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2. Press OK. The Aborted screen appears. 
 

 

2.7.1.4 View Auxiliary Port Information 
While a program is active, the current program configuration can 
be viewed.  

1. From the Channel screen, press MORE. A second Channel 
screen appears. 
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2. Press AuxPorts. The Auxiliary Ports screen appears. 
 

 

3. Press BACK twice to return to the Channel screen. 

 

2.7.1.5 Jump to a Specific Program Step 
A program may contain one or more action steps. The “JUMP” 
command allows the ability to move immediately from the 
current action step to any of the other action steps, within the 
active program - for example, Charge, Discharge, Rest, and so on. 
The Jump function moves to a specific step in the program.  

1. From the Channel screen, press MORE. A second Channel 
screen appears. 



 C8000 Battery Testing System User Manual 

42  2 Battery Tester 

 

 

2. Press JUMP. The Jump screen appears. 
 

 

3. The Current Step field shows the current step that the 
program is in. Enter the step number to move to in the 
Jump To field and press OK. The C8000 will resume 
program operation at the selected step. 

2.7.1.6 View SM-Bus Information 
Before using any SM-Bus battery functions, ensure the SM-Bus 
lines from the I/O port are connected to the battery. Note: The 
temperature reading for SM-Bus batteries will still use the 
Cadex thermistor that is attached to the Power Port Cable. 

All SM-Bus c-codes, both factory and custom, will contain only 
the actions to be executed, when the status/alarm bit is 
received. 

A factory SM-Bus c-code is available with the following 
parameters. (Note: To change any of the status/alarm bit 
actions, create a new SM-Bus code.) 
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A Fully Charged Finished 

B Terminate Charge Alarm Finished 

C Overcharged Alarm Finished 

D Fully Discharged Finished 

E Terminate Discharge Alarm Finished 

F Over-Temperature Alarm Two retries 

 
The following are definitions for available actions on the 
status/alarm bits: 

A Finished The C8000 will end the 
current step as a success. 

B Fail The C8000 will end the 
current step as a failure. 

C Ignore The C8000 will ignore this 
flag and continue the current 
step. 

D # Retries # indicates a value between 1 
and 10. This option is 
available for Over-
Temperature Alarm bit only. 
The setting will indicate to the 
unit the number of SM-Bus 
samples with the over-
temperature alarm bit set 
before the C8000 will 
terminate the step as a fail. 
(Note: SM-Bus is sampled at 
15-second intervals.) 

 

2.7.1.7 Select a Program to Run 
Select a program with which to test the connected battery. 

(Note: All programs require battery parameters to be 
established by selecting either a Battery ID or a C-Code. 
Pressing C-Code “Edit” button, for either Battery ID or C-code 
can modify the battery parameters). 
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1. Select the program by battery ID or C-Code. 
 

 

2. In the Program field, press ENTER. The Select Program 
screen appears. 
 

 

3. Select the program to run and press ENTER. Note: When 
scrolling through the list of programs, all factory programs 
are indented. All custom programs have the 
creation/modification date of the program at the bottom of 
the screen. 

4. Press START. The program begins. 
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2.7.2 Test Results 

2.7.2.1 View Test Results  

1. From the C8000 Main screen, select Test Results. The Test 

Results screen shows the results sorted by battery ID, 
followed by the sequential number if the test was started 
using a battery ID or Cx (where x is the channel number, 
followed by the sequential number). 
 
The date shown is the date the test result file was created 
for the currently selected test result. Click the  and 

buttons to view the previous and next list of test 
results. 
 

 

  

2. Use the arrow keys to select the test result to view and 
press ENTER. The Results screen appears. 
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The following table describes the fields that appear in the 
Results screen. 
 

Field Description 

ID The battery’s identification. 

Date The date the test was performed. 

Program The program run during the test. 

Result Indicates whether the battery completed 
or failed the test. 

Capacity The battery capacity, if available. 

m-ohms Show the battery’s results of impedance 
in milli-Ohms. 

Chrg Cycles The number of charge cycles performed 
during the test. 

Dchg Cycles The number of discharge cycles 
performed during the test. 

Duration The time it took to complete the test. 

Status Codes Displays the last five status codes, 
regardless if test completed or failed. 

Failed Step Displays the step number where the test 
failed. 

Step Name Displays the name of the step where the 
test failed. 

 

When finished viewing the results, press CANCEL. 
  

2.7.2.2 Print Test Results 
Use BatteryLab to print test results. For more information, see 
3.6.3 View and Print Test Details. 

2.7.2.3 Delete a Test Result 
Delete a specific test result if it is no longer needed:  

1. From the Main screen, select Test Results. The Test 

Results screen shows the results sorted by battery serial 
number. 
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2. Select the test result to delete. 

3. Press DELETE. The Confirm Action screen appears. 
 

 

4. Press OK to delete the test result. 
 

2.7.2.4 Delete All Test Results 
To delete all test results: 

1. From the Main screen, select Test Results. The Test Results 
screen shows the results sorted by battery serial number. 
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2. Press, "DELETE ALL." The Confirm Action screen appears. 
 

 

3. Press OK to delete all test results. 
 

2.7.3 Battery Profiles 

To add, edit, and delete battery profiles in the C8000: 

From the Main menu, select Batteries. The Battery Profiles screen 
appears. 
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2.7.3.1 View and Edit a Battery Profile 
To view a battery profile, select the profile in the Battery Profiles 
screen and press ENTER. The Battery Profiles screen appears. 

 

Edit the information for the battery profile, as required, and press 
OK to save the changes. 

When adding or editing a battery profile, select the c-code by 
scrolling to the C-Code field. Press ENTER to view a list of 
available c-codes in the C-Codes screen. 
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Select the c-code for the battery profile and press ENTER. 

 

For a description of the fields, see 2.8.1.2 View and Edit a C-Code. 

Edit the details of the battery c-code as required and press OK to 
save the changes. Press CANCEL to discard any changes just 
made to the c-code. 

To view the next page of information for this c-code, press PAGE 
2. The Page 2 screen appears. 
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Edit the details of the battery c-code as required. (For instructions 
on editing a c-code, see  2.8.1.2 View and Edit a C-Code.) Press 
BACK to return to the Page 1 screen. 

2.7.3.2 Delete a Battery Profile 
To delete a battery profile: 

From the Main screen, select Batteries and press ENTER. The 
Battery Profiles screen appears. 

 

Select the battery profile to delete and press DELETE. The 
Confirm Action screen appears. 
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Press OK to delete the battery profile. Note: The referenced C-
Code is not deleted. 

2.8  C-Codes 
To create, view, and edit c-codes, and to import or export c-codes 
to and from the C8000: (Note: The Import and Export functions 
apply only to SnapLock/RigidArm Adapters when using the 
C8000 Adapter Unit.) 

From the Main screen, select C-Codes and press ENTER. The C-

Code Options screen appears. 

 

 

 

2.8.1 Add, Edit, and Delete C-Codes 

To manage c-codes, select View/Edit from the C-Code Options 
screen. The C-Codes screen lists the c-codes in the C8000.  
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2.8.1.1 Create a C-Code 
To create a c-code, select View/Edit in the C-Code Options screen 
and press NEW.  

Enter the c-code identification. To select the chemistry, use the 
Enter key or the arrow keys. Press NEXT. 

 

Enter the cells and rating and press ENTER. 

Press Next and the battery c-code information appears. Make any 
required changes and press OK to save the changes. See section  
2.8.1.2 View and Edit a C-Code for detailed information on the 
displayed fields. 

 

2.8.1.2 View and Edit a C-Code 
To view a c-code’s information, select the c-code in the C-Codes 
screen and press ENTER. The Battery C-Code screen appears. 
(Note: This screen may differ slightly, depending on the selected 
chemistry.) 
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Edit the details as required and press OK to save the changes. 

See Section 4 C-Code Parameters for system limitations during 
C-code Creation. 

Field Description 

C-Code ID A unique identification name for the C-
Code. 

Chemistry Selects the desired chemistry (Options: 
SLA/NiCD/NiMH/Li/LiPH/Primary) 

Cells Enter the number of cells. Number of 
cells supported by Battery chemistry: 

 NiCD and NiMH up to 30 cells in 
series (36 Volts nominal). 

 SLA batteries up to 18 cells in 
series (36 Volts nominal). 

 Li-ion batteries up to 10 cells in 
series (36 Volts nominal). 

 LiPH batteries up to 10 cells in 
series (32 Volts nominal). 

 Primary batteries up to 30 cells in 
series (36 Volts nominal. 
Discharge only). 

Rating The capacity rating of the cell(s) or 
battery pack. Supported Range 0.050-100 
(values are stated in Milli-amperage 
hour (mAh)). 

Chrg Rate The rate of charge current to be applied. 
(Unit (A)) 
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Dchg Rate The rate of discharge current to be 
applied (Unit (A)) 

End Dchg The end-of-discharge voltage (Unit (VV)) 

Rapid Chrg The required voltage level for the battery 
before a full charge current (as per Chrg 
Rate) is applied. Otherwise, charge 
current is equal to CTP (LiPh/SLA) or 
trickle rate (NiCD/NiMH) (Unit (V)) 

Temp Low Minimal temperature reading of battery 
for a current o be applied (Unit (°C)) 

Temp High Minimal temperature reading f battery 
for a current to be applied Unit (°C)) 

Target The minimal capacity value required to 
determine a Pass/Fail condition. Value is 
stated in percentage of the total rating 
field (Unit (%)) 

m-Ohms The minimal resistance/impedance 
value is required to determine a 
Pass/Fail condition. (Unit (m-ohm)) 
Range” 1-1000 

Trickle Rate The current rate of charge/discharge 
when a trickle current is required (Unit 
(A)) (NiCD/NiMH only) 

Record Rate The rate of discharge during a 
recondition action step (Unit (AA)) 
(NiCD/NiMH only) 

End Record The end-of-recondition voltage during a 
recondition action step (Unit (V)) 
(NiCD/NiMH only) 

Neg Slope The negative slope value to determine 
End-of-Charge for NiCD/NiMH 
batteries only (Unit (mV)) 

dT/min The rate of temperature battery 
temperature increase over a one minute 
period (Unit (°C)) (NiCD/NiMH only) 

Rev Load Percentage of reverse current to be 
applied (Unit (%)) (NiCD/NiMH only) 

Standby (V) The rated nominal or standby voltage of 
the battery (Unit (VV)) 

Max Chrg (V) The maximum voltage of a battery for 
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Constant Voltage charge (Unit (V)) 
(SLA/LiPH only) 

CTP End of Charge point for a battery charge 
(Unit (A)) (SLA/Li/LiPH only) 

Min Voltage The minimal voltage the C8 allows 
before terminating action (Unit (VV)) 

Max Voltage The maximum voltage the C8 allows 
before terminating action (Unit (VV) 

Chrg Timeout The maximum length of time that a 
Charge current can be applied before 
terminating (Unit (C-minutes)) 

Dchrg Timeout The maximum length of time that a 
Discharge current can be applied before 
terminating (Unit (C-minutes)) 

Max Chrg Curr The maximum allowable Charge current 
allowed to be applied to the battery 
before terminating (Unit (AA)) 

Max Dchrg Curr The maximum allowable discharge 
current allowed to be applied to the 
battery before terminating (Unit (AA)) 

Max Temp The maximum allowable temperature 
allowed before terminating (Unit (°C)) 

 

2.8.1.3 Delete a C-Code 
To delete a c-code, select the c-code to delete and press DELETE. 
The Confirm Action screen appears. 

 

Press OK to delete the c-code. 
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2.8.2 Import a C-Code 

To import a c-code from a SnapLock/RigidArm Adapter to the 
C8000 (an adapter unit is required), select C7 Import from the C-

Code Options screen and press ENTER. The Import C-Codes 
screen appears. 

 

Select the channel to import the c-codes from. The Import C-

Codes screen appears, showing which c-codes (1-10) were 
extracted from the SnapLock/RigidArm Adapter. 

 

Next, select the c-codes to import. To select a c-code for import, 
select the c-code by its corresponding numeric value (0 through 9). 
The selected c-code is highlighted. This name is used to store the 
c-code on the SnapLock/RigidArm Adapter. 

When finished selecting the c-codes to import, press SAVE. The c-
codes are imported from the SnapLock/RigidArm Adapter to the 
C8000. The imported c-code name is renamed with a prefix of 
Cxxx. 
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2.8.3 Export a C-Code 

To export a c-code from the C8000 to a SnapLock/RigidArm 
Adapter (a C8000 Adapter Unit is required), select SnapLock 

Adapter Export from the C-Code Options screen and press 
ENTER. Select the c-code to export and press ENTER. The Export 

C-Codes screen appears. 

 

Select the channel to export the c-codes to. The Export C-Codes 
screen shows which c-codes were extracted from the C8000. 

 

The numbered (1 through 10) fields list all c-codes contained 
within the SnapLock/RigidArm Adapter. In the C-Code field, 
press Enter to retrieve a list of c-codes currently on the C8000 and 
select one. The name of the c-code you just selected appears in the 
Export Name field – you can rename this c-code before you export 
it, if needed. The Setup # field tells the C8000 the memory location 
on the SnapLock/RigidArm Adapter to save to. 

Next, select the c-code to export. To select a c-code for export, 
select the memory location for the C8000 c-code to be exported to. 
The selected c-code is highlighted. When finished selecting the c-
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code to export, press SAVE. The c-codes are exported from the 
C8000 to the SnapLock/RigidArm Adapter. 

1. Select a channel. 

2. Select the C8000 C-Code to export. 

3. Edit the Export name, if needed. 

4. Select the location to export the C8000 C-Code to. 

5. Save the C-Code. 

2.9  Programs 
The C8000 includes factory default programs. See 3.10.1 Factory 
Default Programs for information on the default programs. 

From the Main screen, select Programs. The Custom Programs 
screen appears. 

2.9.1 View a Custom Program 

View the details of a custom program. 

1. From the Main screen, select Programs. The Custom Programs 
screen appears. 
 

  

 

2. Select the program to view and press ENTER. The Program 

Details screen appears. The Version field displays the program 
version that was entered when the custom program was 
created in BatteryLab, otherwise this field displays V0.00. The 
Waveform field displays the custom waveform, if it is associated 
with the program; otherwise this field is blank. The Comment 1 
and Comment 2 fields displays any comments for the program 
that were entered when the custom program was created (the # 
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indicates the part number). The Digital I/O, Analog Output #, 
and Analog In # fields display the settings for the port as 
programmed. 
 

 

3. When finished viewing the information about the custom 
program, press CANCEL to return to the Custom Programs 
screen. 

2.9.2 Delete a Custom Program 

Custom programs can be deleted only if the security setting is set 
to Disabled. For more information on security settings, see 2.11.8 
Security. 

1. From the Main screen, select Custom Programs and press 
ENTER. The Custom Programs screen appears. 
 

 

2. Select the custom program to delete. 
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3. Press DELETE. The Confirm Action screen appears. 
 

 

4. Press OK. 

 

2.10  Waveforms 
To view information about a waveform or delete one or more 
waveforms: 

From the Main screen, select Waveforms. The Custom 

Waveforms screen appears. 

 

The Custom Waveforms screen lists all custom waveforms stored 
in the C8000. 

2.10.1 View Information about a Waveform 

To view information about a waveform: 
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Select the waveform and press ENTER. The screen shows the 
version, the waveform, and comments about the selected 
waveform. Note: if a version number is not entered when the 
waveform is created, V0.00 is displayed. 

 

When finished viewing the waveform’s information, press 
CANCEL to return to the Custom Waveforms screen. 

2.10.2 Delete a Waveform 

To delete a waveform, select the waveform to delete and press 
DELETE. The Confirm Action screen appears. 

 

 

Press OK to delete the waveform(s). 
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2.11  Specify System Options 
To specify system options on the C8000: 

From the Main screen, select System. The System Options screen 
appears. 

 

The System Options screen shows 10 menu items: Set Clock, User 
Information, LCD Contrast, Serial Ports, TCP/IP Settings, 
Maintenance, Options, Security, System Information, and Factory 
Defaults.  

 

2.11.1 Set the Clock 

To set the time and date on the C8000:  

1. From the Main screen, select System and press 
ENTER. The System Options screen appears. 

2. Select Set Clock and press ENTER. The System Time 

screen appears. 
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3. Using the numeric keypad, enter the time (in 24-hour 
format) and the date (year/month/day). 

4. Press OK.   

2.11.2 User Information 

To enter user information:  

1. From the Main screen, select System and press ENTER. 
The System Options screen appears. 

2. Select User Information and press ENTER. The User 

Information screen appears. 
 

 

3. To activate the onscreen keyboard, press Edit. Using the 
arrow buttons to select alphabetic characters and the 
numeric keypad to enter numbers, enter the name of the 
company in the Company field. 
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4. Enter the company’s address in the Address 1, Address 2, 
and Address 3 fields.  

5. Press OK. 
 

For instructions to enter alphabetic characters see 2.1.4.4 
Navigating the LCD Display. 

2.11.3 LCD Settings 

To set the contrast of the C8000’s LCD screen:  

1. From the Main screen, select System and press ENTER. 
The System Options screen appears. 

2. Select LCD Contrast and press ENTER. The Set LCD 
Contrast screen appears. 
 

 

3. Use the   and  buttons to adjust the contrast. 

4. Press OK. 

2.11.4 Serial Ports 

To set the serial ports for the C8000: 

1. From the Main screen, select System and press ENTER. 
The System Options screen appears. 

2. Select Serial Ports and press ENTER. The Serial Ports 
screen appears. 
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3. Use the  and  keys to select the bits per second, data 

bits, and parity for each port. Use the  and  keys to 
move to the previous or next field. 

4. Press OK. 

5. Restart the C8000 after modifications. 

2.11.5 Specify the TCP/IP Address on the C8000 

Note that the TCP/IP addresses must be static IP addresses. For 
more information, see 3.1.10 Selecting a TCP/IP Address for the 
C8000.  

1. From the Main screen, select System and press ENTER. 
The System Options screen appears. 

2. Select TCP/IP Settings and press ENTER. The TCP/IP 

Settings screen appears. 
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3. In the TCP/IP Settings screen, press  to select Enabled 
and press ENTER. 

4. Enter the following information:  

 Address: This is the IP address for the C8000 from your 

network administrator. 

 Mask: This is the network mask obtained from your network 

administrator. 

5. Press OK two times and let the C8000 reboot. 

Note: Ensure that the IP Address is unique on the network system and 
the IP Address assigned to the C8000 has been removed from the DCHP 
server assignment list. 

2.11.6 Maintenance 

Test results for each battery test are saved on the C8000 and are 
automatically deleted after the specified number of days.   

1. From the Main screen, select System and press 
ENTER. The System Options screen appears. 

2. From the System Options screen, select Maintenance 
and press ENTER. The File Maintenance screen 
appears. 
 

 

3. Enter the number of days to keep test results.  To 
prevent results from being deleted automatically, enter 
(0) zero - the default is 30 days. 

4. Press OK. 

2.11.7 Options 

If the Save Termination Data option is enabled, the C8000 can 
capture the last 500 Voltage and Current readings for each 
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channel. You can specify the capture rate (5-100 readings per 
second).  

If the Save Results Data option is enabled, the C8000 saves test 
results for each completed test. This is open default to ON. 

If a power failure occurs while a test is executing, and the power is 
restored within the specified timeout, the interrupted test will be 
resumed. To disable this feature, set the Resume Hours value to 0 
(default value). To enable this feature, set the Resume Hours field 
to any other value. 

1. From the Main screen, select System and press 
ENTER. The System Options screen appears. 

2. From the System Options screen, select Options and 
press ENTER. The System Options screen appears. 
 

 

3. To save termination data, select Yes. 

4. To save results data, select Yes. 

5. Enter the number of hours before an interrupted test 
will be resumed. 

6. Enter the number of minutes before the screen saver is 
activated (the default value of 0 will disable this 
option). 

7. To enable SnapLock/RigidArm Adapter auto import, 
select Yes (the default is No). 

8. Enter the Low RDD in kilobytes. The default value of 0 
means only a console error message is displayed when 
space reaches zero bytes. 

9. Press OK. 



C8000 Battery Testing System User Manual  

Battery Tester  69 

2.11.8 Security 

When security is enabled on the C8000, you (or another operator) 
cannot delete test results or alter c-codes stored in the unit. Note 
that the password is a numeric password only; alphabetic and 
alphanumeric characters are not valid in the password. 

When security is on (enabled) and the password is entered to 
disable the security, the security will automatically enable after a 
reboot or after 10 minutes of no activity. To deactivate the security 
permanently, disable the security temporarily and enter a new 
password of “0000”. 

1. From the Main screen, select System and press 
ENTER. The System Options screen appears. 

2. From the System Options screen, select Security and 
press ENTER. The Security screen appears. 
 

 

3. In the Enter Password field, enter your password. 

4. In the Confirm Password field, enter your password a 
second time. 
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5. Press OK. 

A valid password can be changed in BatteryLab. To receive 
additional help with passwords, contact Cadex Electronics Inc. or 
an authorized service center. To disable the password, enter a 
value of “0000”. 

2.11.9 System Information 

To view the C8000’s system information: 

System information includes the unit number, the version of 
firmware that is installed, both DSP versions, the LCD version, 
both PIC versions, the RDD free space, and whether security is 
enabled or disabled. The units MAC and serial number are also 
shown. 

Each C8000 contains three microprocessors – one Coldfire 
processor and two Digital Signal processors (DSP). The System 

Information screen reports the versions of both DSP firmware 
installed in the C8000. 

The System Information screen displays the version of firmware 
programmed into the C8000’s Liquid Crystal Display (LCD). 

Field Description 

Unit Number The unit number assigned by 
BatteryLab. N/A indicates in standalone 
mode. 

Firmware 
Version 

The version of firmware installed. 

DSP Version Both versions of the DSP firmware 
installed on the C8000. 
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LCD Version The version of the Liquid Crystal 
Display. 

PIC Version Both versions of the PIC installed on the 
C8000. 

RDD FreeSpace The amount of free memory remaining 
in the C8000, shown in bytes. 

Security Enables or disables the C8000’s security 
feature. 

MAC The MAC version. 

Serial No The C8000’s serial number. 

Power on time The last time the C8000 was turned on 

 

The security password enables or disables the C8000’s security 
feature. The default password is 0000 and security features are 
disabled by default. If a security password is specified, security 
will be enabled. For more information on setting security 
passwords, see 2.11.8 Security. 

1. From the Main screen, select System and press ENTER. 
The System Options screen appears. 

2. From the System Options screen, select System 

Information and press ENTER. The System Information 
screen appears. 
 

 

3. Press CANCEL when finished viewing the system 
information. 
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2.11.10 Factory Defaults 

Use this option to restore the C8000 back to its factory default 
settings. Warning: Restoring factory defaults erases all saved 
data, customized programs, waveforms, and c-codes. This data 
should be backed up before proceeding to restore factory 
defaults.  

1. From the Main screen, select System and press 
ENTER. The System Options screen appears. 

2. From the System Options screen, select Factory 

Defaults and press ENTER. The Factory Defaults 
screen appears. 
 

 

3. Press OK to reset the C8000 to factory defaults. 
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2.12  External Devices 
The C8000 system supports the following third-party devices VIA 
the serial ports. 

2.12.1.1 Programmable DC Electronic Loads 
All programmable loads are supported on Serial Port Three only. 

Connect an electronic load 

Configure the external load to communicate with the following settings; 

BAUD: 384000 (Recommended), Data bits: 8, Parity: N, Stop Bits: 1 

Connect a 9-pin Serial Cable to the C8000 and DC load. 

Reboot the C8000. 

Note:  

1) Ensure that all waveforms used in conjunction with an electronic load are within 
the capabilities of the DC load. 

2) Some DC loads have only a TTL output. Contact the manufacturer of the DC 
load for a TTL to Serial convertor. 

Supported DC Electronic Loads 

BK Precision 8510 - BK Precision 8514 - BK Precision 8518 - BK Precision 8520 

BK Precision DC Electronic Load Limits; 

 The programming of the DC Load will take between 10~90 seconds to complete. All waveforms 
will be programmed at the start of the EXTERNAL LOAD steps. 

 Minimal pulse width supported by the BK DC Loads is 1ms. 

2.12.1.2 Thermal Chambers 
All programmable Thermal Chambers are supported on Serial Port Two only. 

Connect to a Thermal Chamber 

Configure the Thermal Chamber to communicate with the following settings; 

BAUD: 19200 (Recommended), Data bits: 8, Parity: N, Stop Bits: 1 

Connect a 9-pin Serial Cable to the C8000 and DC load.. 

Reboot the C8000. 

Note: Ensure that all program steps and commands used in conjunction, with the thermal 
chambers, are within the capabilities of the thermal chamber units. 

Supported Thermal Chambers 

Thermotron 2800 - Thermotron 3800- Thermotron 8800- TestEquity Watlow F4
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3 Cadex BatteryLab 

3.1  System Setup 
Welcome to Cadex BatteryLab – the PC software that provides a 
visual interface to start, monitor, and control custom battery tests 
on up to eight Cadex C8000 Battery Testers simultaneously. The 
software provides interfaces to create or edit password-protected 
c-codes, battery IDs, waveforms, and custom programs to test 
batteries. Tests can be viewed in real-time via the results panel or 
program listing and monitored on multi-variable graphs. (Note: 
Real-time is defined as the rate of data acquisition. By default, all 
data is acquired at a rate of 60 seconds. Programs can be defined 
to acquire data at a rate of 1 second. Only status code changes are 
acquired immediately.)  
 
Customizable reports can be generated from historical results 
retrieved from the database. Test data can also be exported to tab 
delimited files for further analysis. 

3.1.1 System Requirements 

To use BatteryLab, a dedicated Windows - based personal 
computer (PC) system is needed with the following features:   

 1GHz Processor (minimum). 

 Windows XP with Service Pack 2, with at least 512MB 
RAM and 10 GB of free hard drive space. 

 An Ethernet Port for primary communication between the 
PC and C8000. 

 A 100-BASE-T Ethernet network switch or hub with 
sufficient free ports, to connect the hub to the local 
network, a port for the Host PC, and one for each Cadex 
C8000 Battery Tester. A switch or hub is not required if the 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  75 

PC and C8000 are connected directly and are not required 
to be connected to the local network. 

 An SVGA color monitor with 1024 x 768 or better 
resolution, and 16-bit color minimum. 

 A writable CD or DVD drive, for installing software and 
creating backups. 

 A keyboard and mouse. 

 A printer. 

Correct operation of Cadex BatteryLab requires that a printer 
driver be installed. Windows comes with an extensive database of 
printer drivers. Alternatively, commercial software, such as 
Adobe Acrobat PDF Writer, can be installed as the default printer 
driver.  

3.1.2  Set Windows Explorer and My Computer to Display File 
Extensions. 

 

A file extension describes a file type. A filename and its extension 
are separated by a period ".", for example “Setup.exe”. The 
extension .exe indicates an executable program file. 

To set Windows Explorer and My Computer to display file 
extensions in the lists of files:  

1. Open Windows Explorer (explorer.exe) or My Computer. 

2. From the Tools menu, click Folder Options. 

3. Click the View tab. 

4. Clear the Hide extensions of known file types check box.  

5. Click OK. 
 

3.1.3 Create a Database for BatteryLab 

To create a database for BatteryLab: 

1. Exit BatteryLab. 

2. Backup the following two folders to backup media (Note: 
Installation Location can be viewed on the About window): 
\(Installation Location)\DB 
\(Installation Location)\Export 

3. Delete all files in the folder \(Installation Location)\DB 
except the newc8000.mdb file. If the newc8000.mdb file is 
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accidentally deleted, retrieve a copy of this file from the 
backup media and save it to the \(Installation Location)\DB 
folder. 

4. Copy the newc8000.mdb file in the same directory and then 
rename this second copy to c8000.mdb.This way, you can 
repeat this function multiple times, if required. 

5. Start BatteryLab. 

 

3.1.4 Back Up the Data Files on the PC 

All hard disk drives eventually fail, with the loss of all saved data.  
Hard drive files can also be destroyed or corrupted by: an AC 
power surge, a computer virus (that slips through antiviral 
software), failure of electronic parts in the computer, or by human 
error.  

 Caution 

Back up BatteryLab data files regularly onto separate 
media, such as writable DVD, or CD, or magnetic tape. 

It is possible to reinstall software, but the data files on your 
computer (including test records and calibration data for your 
C8000s) can be restored only if a backup copy exists.  

Scheduled data backups are recommended on a weekly basis 
using Windows Backup, which is accessed from the Start menu: 
Start > Programs > Accessories > System Tools > Backup. 

Windows Backup is described in Windows Help, which you 
access from the Start menu.  Use the Help Index to find topics 
under "Backup".  

Using Windows Backup, schedule a periodic backup of the batlab 
folder located, by default, under C:/Program Files. 

Discuss backup procedure and frequency of backups with your 
System Administrator. 

 

3.1.5 Install and Uninstall BatteryLab 

Before installing Cadex BatteryLab, ensure your computer meets 
the 3.1.1 System Requirements to run the software. BatteryLab and 
its database can be installed in the default folder locations or 
different locations, as needed. Note: If BatteryLab is already 
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installed, the Upgrade window appears – BatteryLab’s database is 
automatically preserved during the upgrade. 

3.1.5.1 Install BatteryLab 

1. Insert the installation CD into the CD drive. 

2. Browse your CD drive in Windows Explorer and double-
click Setup.exe. If BatteryLab is already installed on the 
computer, the Upgrade Prompt window appears. Click 
Upgrade to continue. 
 

 

The Welcome Dialog window appears. 
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3. Click Next. The License window appears. 
 

 

4. Read the license agreement and click I Agree. The Choose 
Program Location window appears. 
 

 

5. BatteryLab is installed in the C:\Program Files\Batlab folder 
by default. To install BatteryLab in a different location, 
click Browse. The Select Destination Directory window 
appears. Select the location and click OK. If BatteryLab is 
already installed in that location, the Install window 
appears. Click Yes to overwrite the existing copy of 
BatteryLab. 

6. Click Next. The Choose Data Location window appears. 
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BatteryLab's database is installed in the C:\..\Application 
Data\Cadex\Batlab folder by default. To install 
BatteryLab's database in a different location, click Browse. 
The Select Destination Directory window appears. Select 
the location and click OK. Click Yes to overwrite the 
existing copy of BatteryLab's database. 

7. Click Next. The Start Installation window appears. 
 

 

8. Click Next. The Installing window appears, showing the 
files being installed. 
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9. The Installation Complete window appears. Click Finish. 
 

 
 

3.1.5.2 Uninstall BatteryLab 

1. In Control Panel, click Add Remove Programs.  

2. Select Cadex BatteryLab and click Remove. 

3. You can select either Automatic or Custom. If you select 
Custom, select All followed by Next on each successive 
dialog box until the software uninstall is complete.  
 If you choose Automatic, the uninstall process will retain 
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shared system components that were installed by the 
installer during setup.  

4. Follow the steps through the uninstall wizard. 
 

Uninstalling removes all BatteryLab information, including the 
test results database. 

3.1.6 Software Updates 

3.1.6.1 Software Version 
To see what version of BatteryLab is installed on the computer, 
select About from the Help menu. The build number and the 
location of the database files appears in the About window. 
  

 
  

3.1.6.2 Update BatteryLab Software 
When a new version of BatteryLab becomes available, registered 
users can download it from the Cadex website.  

The download is a compressed executable file (with file extension 
.EXE). 

Running the downloaded executable will run Setup and install a 
new version of the software. 
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 Important 

If the computer or network uses a firewall, it may 
be necessary to reconfigure firewall access to the 
new version of BatteryLab. 

3.1.7 BatteryLab Security Information 

Cadex BatteryLab security serves to secure the software and 
connected battery analyzers to preserve settings configured by 
operators who administer the Battery Testing System. Report 
templates, configuration settings, battery ID databases, c-code 
databases, programs databases, and waveform database are 
secured, preventing inadvertent changes by operators. 

Password Setting 

You must have a password to disable BatteryLab security. Note 
that creating a password does not automatically enable security in 
BatteryLab and connected analyzers. To enable and disable 
security, see 2.11.8 Security. 

To select a password, select Password Setting from the Database 
menu. You must specify a four-digit number, re-type the four-
digit number, and then click OK. 

Security Setting 

Security setting in BatteryLab is either enabled or disabled. To 
enable or disable security setting, select Security Setting from the 
Database menu. You must specify a four-digit number, re-type 
the four-digit number, and then click OK. You can then enable or 
disable security setting. For more information, see 3.1.13 Set 
Security Setting on the C8000. 

 

3.1.8 Set Up BatteryLab 

Before starting to test batteries with BatteryLab, set up the 
following items: 

 The cables connecting each C8000 to the network. 

 The “Host” IP Address of the PC where BatteryLab is 
installed and the IP Address for each C8000 connected to 
the local network. 
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3.1.8.1 Connect the C8000 to the Network 
To use BatteryLab with C8000, each C8000 must be connected to 
the network and be assigned a static IP Address and a network 
mask.   

The static IP addresses for each C8000 must be unique and belong 
to the same network.  For more information on assigning an IP 
address to a C8000, see 3.1.10.3 Add IP Addresses for C8000s on the 
PC 

Note that the TCP/IP addresses must be static IP addresses.  A 
Network Administrator can supply static IP addresses for each 
device that is to be connected to the local network. 

3.1.8.2 Set Up the C8000 to Use BatteryLab 
The procedure for setting up the network connections is: 

 Acquire a unique IP Address from your network 
Administrator. 

 On each C8000, enter a unique IP address and the 
(network) mask. 

 Launch BatteryLab, on the host PC, to enter the IP 
address for every C8000 that the host PC will 
communicate with. See 3.1.10.3 Add IP Addresses for 
C8000s on the PC for information on entering the IP 
addresses into BatteryLab. 

 

Once the IP address information is entered, connect the C8000 
directly to the PC or to a hub/switch connected to the network. 
Use the Ethernet cable provided. On the C8000 side, the Ethernet 
cable connects to the Ethernet port at the back of the C8000. 

 

3.1.8.3 Choose IP Addresses for the Local Network 
An IP address is a set of four numbers that identifies a single 
computer or device on a TCP/IP network.  Each of the four 
numbers can range from 1 to 254.  

1. Click Start and choose Run. 

2. In the Run dialog box, type cmd and click OK. 
The Command Prompt window appears. 

3. Type ipconfig /all in the command prompt window 
(cmd.exe) and press ENTER. 

4. Make a note of the PC IP Address that is shown in the 
Command Prompt window under Ethernet adapter 

Local Area Connection.  
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5. Close the Command Prompt window. 
 

The IP address for each C8000 will likely have the same numbers 
for the first three parts of the PC IP Address and a different 
number, in the range 1-254, as the final part of the IP address.  The 
final number for a C8000 cannot be the same as the final number 
in the IP Address of the PC or the final number in the IP Address 
of any other device on the Local Area Network. 

3.1.8.4 Find the IP Address for Your PC 
To find the IP address for your PC:  

1. Choose Start > Programs > Accessories > Command 

Prompt. 
The Command Prompt window appears. 

2. Type ipconfig and press Enter. 
The IP Address and Subnet Mask for your computer are 
displayed. 

3. Make a written note of these numbers and then close the 

Command Prompt window. 
 

3.1.8.5 TCP/IP Settings 
Use the Cadex C8000 standalone or connected to a TCP/IP 
network and use with Cadex BatteryLab PC software. 

In the standalone option, information is specified manually into 
the C8000 to start tests and test results are accessible via the C8000 
display. However, because of hardware memory limits, not all 
customizable features will be available and the test results must be 
deleted periodically to make memory available for new test 
results. A message appears if RDD space is low (space can be 
configured in Systems > Options). (Default: 250 Kbytes) 
 

In the networked option, Cadex BatteryLab software can be used 
to start tests, store test result histories, and print test reports. 
Cadex BatteryLab is also required to update the firmware on the 
C8000. This documentation refers to the computer on which 
BatteryLab runs as the “host” PC. 

The C8000 must be assigned an IP address with a network mask 
that matches the network mask of the host computer to 
communicate and update firmware with Cadex BatteryLab.  
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3.1.8.6 Network Cable 
A network connection between the computer and C8000 can occur 
using a hub or switch or directly using the network cable 
provided.  
 
The host PC’s IP address must connect the C8000 to the PC 
directly via the provided cable. 

3.1.9 Firewalls 

All operating systems from Microsoft windows XP Service pack 2 
and newer will by default have a Firewall installed and active or a 
third party application may have been installed, regardless of the 
operating system. For BatteryLab to communication with the 
C8000 a rule will be required to be configured and granted or 
allowed communications to the network.  

On the initial execution of the BatteryLab application, the majority 
of firewall applications will recognize the communication attempt 
and will prompt the user for permission. Always “ALLOW” or 
“GRANT” full communication permissions to the BatteryLab 
application.  

Depending on the firewall application the application may be 
expressed as BATLAB.exe.  

If the firewall application does not prompt for permission or 
BatteryLab has been denied access to the network, refer to the 
documentation for that firewall for instructions to open the 
required ports. 

 See 3.1.9.1 Ports for a list of the required ports, which must be 
“allowed”. 
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3.1.9.1 Ports 
The following ports on the PC firewall must be “allowed”.  

 TCP port 51935 must remain open.  

The required ports are open by default in Windows 2000. 

3.1.9.2 Other Firewall Software or Hardware 
For other firewall software or hardware,  

 

3.1.10 Selecting a TCP/IP Address for the C8000 

3.1.10.1 Before Entering the Settings 
 
Ask the Network Administrator for:  

 A static IP Address for each C8000  

 The network mask   

 

If the C8000 will be used stand-alone without BatteryLab, then ignore all 
references to TCP/IP settings for BatteryLab. The TCP/IP Settings on 
the C8000 are disabled by default.  

An IP address is a set of four numbers that identifies a single 
computer or device uniquely on a TCP/IP network. Each of the 
four numbers can range from 0 to 255. If a Network administrator 
is unavailable, follow the instructions below on a computer to 
determine a unique IP address for each C8000, other proceed to 
step 2: 

Note: If the network system uses dynamic IP address assignment, 
ensure that any IP addresses assigned, to a C8000, are exempted from the 
Dynamic IP Address range of the server/router.  

1. Determine a unique IP address for each C8000 to be 
connected to the local network. 
Ping the network for each IP address (from the PC) to 
determine that the IP address is not already in use on the 
local network. If an IP address is “in use”, determine 
another unique IP address. To ping an IP address, see 
3.1.10.2 Ping the Network to Check for Available IP address 

2. To enter a unique IP address for each C8000, follow the steps 
in the section 2.11.5 Specify the TCP/IP Address on the C8000. 
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IP Address This is the Internet Protocol (IP) address for 
the PC on the local network. 

An IP address is a 32-bit number that is 
notated by using four numbers from 0 
through 255, separated by periods 

Subnet Mask This number identifies the network segment 
on which the PC is located. 

A subnet mask is a 32-bit number that is 
notated by using four numbers from 0 
through 255, separated by periods. 
Typically, default subnet mask numbers use 
either 0 or 255 as values (such as 
255.255.255.0), but other number values can 
appear. 
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3.1.10.2 Ping the Network to Check for Available IP address 
To “Ping” an IP address on the network, enter the keyword 
“ping” followed by a space followed by the IP address into the 
Command Prompt window and press Enter on the keyboard. If 
the Command Prompt window is not visible, choose Run from 
the Start menu and type "cmd" in the Run dialog and click OK. 
The Command Prompt (cmd.exe) window appears. 

Example: “ping 192.168.4.3” 

If a device on the local network uses the IP address, the ping 
response will return a message indicating that the IP address is in 
use and cannot be assigned to a C8000: 

Reply from 192.168.4.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.4.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.4.3: bytes=32 time<10ms TTL=128 

Reply from 192.168.4.3: bytes=32 time<10ms TTL=128 

Note: Should the computer receive a reply when the 

C8000 has not been programmed with an IP Address, 

select another IP Address. 

If there is no device on the local network currently using this 
address, the ping request will not return a reply indicating that 
the IP address is available and can be assigned to one C8000: 

Request timed out. 

Request timed out. 

Request timed out. 

Request timed out. 

Note: Different versions of the Windows operating system may 
reply differently. 

 

 

3.1.10.3 Add IP Addresses for C8000s on the PC 
BatteryLab can be set up to communicate with up to eight C8000 
Battery Testers, each of which can test up to four batteries 
simultaneously. 

All the C8000s must be switched ON and connected to the 
network.  When there is only one network port available, connect 
a switch or hub to the network first and then connect the C8000s 
and PC to this switch or hub. 

Assign a static IP address to each connected C8000. Also, specify 
the network mask into each C8000. For more information, see 
3.1.8.1 Connect the C8000 to the Network.  

To add IP addresses for the C8000 units: 
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1. From the Tools menu, select BatteryLab Configuration. 
The Set Up System Options window appears. 

 

 

2. In the IP Address fields, enter the IP Address for each 
C8000 and select the Enabled check box. Do not enter 
leading zeros in any of the four parts of an IP address. 

3. If you want to verify that a C8000 is available and online, 
click Verify Connection. The firmware version number for 
each connected C8000 appears in green type below the IP 
Address field. 

4. To configure BatteryLab to automatically establish 
connections with C8000s on startup, select the Auto 
Connect on BatteryLab Startup check box. 

5. To automatically execute BatteryLab on logon, select the 
Automatically run BatteryLab when I log on to Windows check 
box. In case of a power loss, the PC can be forced to restart 
and resume logging the service (test). First, configure the 
PC’s BIOS to auto-resume on power loss (see the PC’s 
Motherboard manual on how to set the BIOS). Note: Not 
all BIOS are capable of auto-power on AC power loss. 
Next, configure the Windows operating system to 
automatically log on using the same user profile as 
BatteryLab (see the Windows technical guides for 
information on configuring Windows). When used in 
conjunction with the C8000’s Automatic Resume on Power 
Loss function, BatteryLab can resume logging data after an 
AC power loss (see 2.11 Specify System Options).  
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6. Click OK. 
 
 

3.1.10.4 Disable an IP address 
To temporarily disable communications with a C8000, clear the 
Enabled check box for the IP address:  

1. Open the IP Address Manager. 

2. Under the IP address, of the C8000 to disable, clear the 
Enabled check box. 

3. Click OK. 
 

3.1.11 Start the BatteryLab Program 

To execute BatteryLab, double-click the BatteryLab icon on the 
desktop. 

If there is no BatteryLab icon on the desktop, from the Start menu, 
select: Programs > BatteryLab > BatteryLab. 

The main window for BatteryLab appears. 

 

3.1.11.1 The Menu Bar 
The menu bar on BatteryLab’s main window displays four menus:  
C8000, Tools, Database, and Help. Clicking any of these menus 
displays a list of menu commands. 

The C8000 Menu 

Click the C8000 menu item to see the C8000 menu. The C8000 
menu contains 15 menu items, as follows: 

Connect: BatteryLab will detect connected devices specified in IP 
Address Manager. Note that connection will occur automatically 
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if the Auto Connect on BatteryLab Startup option is enabled in IP 
Address Manager’s settings. 

Disconnect: BatteryLab disconnects from the active C8000. 

Test Battery: Starts a test on a battery for the active channel of the 
C8000. 

Results: Short Cut to the Results window. 

Data Monitor: Displays a log of system activity between the PC 
and the C8000s. 

Alerts Window: Displays any warning or error condition, which 
BATLAB or a C8000 has reported. 

Suspend Program: Suspend a program that is running, on the 
selected channel of the C8000. 

Resume Program: Resume a program that has been suspended on 
the selected channel of the C8000. 

Abort Program: Aborts a program that is running on the selected 
channel of the C8000. 

Real-Time Status: View the real-time statuses for the selected C8000 
channel. 

Set Clock: Sets the computer’s clock for one or all C8000s. 

Set Options: Sets the system options for the selected C8000 or all 
C8000s. 

External Device Info: Retrieves the model information for the 
supported external devices that are currently connected to the 
selected C8000. 

System Info: Retrieves the system information for the selected 
C8000. 

Exit. Select the Exit menu item to close the BatteryLab application. 

The Tools Menu 

Click the Tools menu to see the Tools menu. The Tools menu 
contains three menu items, as follows: 

Report Templates: Displays the Report Template window to create 
report templates. 

BatteryLab Configuration: Displays BatteryLab Configuration 
window; to specify IP addresses for C8000s that will connect to 
BatteryLab fields; to configure the fields to display in the Results 

Panel, to indicate the location for event log; to configure the report 
header fields and default printer; to setup the default display 
fields, for all graphs 
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System Update: Displays the System Update window to update 
firmware or to backup and restore calibration data. 

 

 

The Database Menu 

Click the Database menu item to see the Database menu. The 
Database menu contains eight menu items, as follows: 

Battery ID: Displays the Battery ID Database window. 

C-Code: Displays the C-Code Database window. 

Programs: Displays the Programs Database window. 

Load Capture: Displays the Load Capture programs database. 

Waveforms: Displays the Waveforms Database window. 

Sequencer: Displays the Sequencer window.  

Security Setting: Enables or Disables the C8000 and BATTERYLAB 

Security Setting. 

Password Setting: Displays the Password window. 

The Help Menu 

Click the Help menu item to see the Help menu. The Help menu 
contains two menu items, as follows: 

Contents F1: Displays the Help window. 

About: Displays the About window, which shows details about 
the BatteryLab application.  

3.1.12 Set the Clock on the C8000 

From the C8000 menu, select Set Clock and then select Selected 

C8000 or All connected C8000(s).  

The Password window appears, if security is enabled. 
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Enter your password and click OK.  

 

 

 

An information window appears indicating a list of the C8000 that 
the clock was updated. Note: Do not update the C8000 clocks if 
there are any batteries connected. 

 

3.1.13 Set Security Setting on the C8000 

Security setting in BatteryLab is either enabled or disabled. To 
enable or disable security setting, select Security Setting from the 
Database menu. Next, select the Enable or Disable option. The 
Password window appears. Enter a four-digit number, re-type the 
four-digit number, and then click OK. Security setting is updated.  

Select the Enable option to enable system security in BatteryLab 
and on all connected analyzers. Connected analyzer windows will 
display a padlock indicating security is enabled on the analyzer. 

Note: If system security is enabled, attempts to import battery IDs, 
c-codes, programs, and waveforms from connected analyzers to 
overwrite existing BatteryLab files are denied. Attempts to start 
tests on secure connected analyzers with new custom programs, c-
codes, and battery IDs require a valid password. Attempts to 
change Report Templates and BatteryLab Configuration are 
denied. Attempts to start tests with programs, c-codes, and 
battery IDs already on the secure connected analyzer are allowed. 
Attempts to export c-codes, programs, or waveforms from 
BatteryLab to secured analyzers are denied. 

Select the Disable option to disable system security in BatteryLab 
and on all connected analyzers. 
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3.1.14 Set the Password to Configure C8000 Functions 

To secure functions that configures the C8000 (such as Set Clock, 
Set Options, etc): 

1. Select Password Setting from the Database menu. The 
Password window appears. 
 

 
 
 

2. Enter your password and click OK. The Password Updated 
window appears. 
Note: Password verification is required if a password is 
already existing. 

3.1.15 C8000 Settings 

BatteryLab can customize system options on the C8000 

1. From the C8000 menu, select Set Options.  

i. The Password window appears, if security is 
enabled. 
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2. Enter your password and click OK.  

 

 

 

3. The C8000 Options window appears. 
 

 

4. In the Save Results Data field, click the field and select Yes 
or No. The C8000 saves the results for all tests performed if 
set to Yes (recommended). For more information, see 2.11 
Specify System Options. 

5. In the Resume Hours field, enter a value 0-24 where 0=off. 
The C8000 will resume a test if this option is set after a 
power interruption. The C8000 will only resume a service, 
after a power interruption, up to the number of hours 
specified. For example, if the unit is set to 2 hours, and a 
service is interrupted because of power failure, the C8000 
will resume the test only if the power is restored within 2 
hours. 
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6. In the File Storage Duration field, enter a value 0-999, where 
0=off. This is the number of days the C8000 will keep all 
test results before automatically deleting all files that are 
older than the specified number of days. Note that no 
warning is issued before deletion. 

7. In the Screen Saver field, enter a value 0-60, where 0=off. 
This is the number of minutes before a Cadex screen saver 
is enabled. (If pixel retention occurs, the active screen saver 
and the pixel retention will be corrected.) 

8. In the SnapLock Auto Import field, select Yes or No. This 
option automatically imports all c-codes stored on a 
SnapLock/RigidArm Adapter, when inserted. (Note: C-
codes will remain until the adapter is removed.) The 
naming scheme used during auto-import is as follows: The 
assigned name will be “C7xyy” where x=Channel # (1-4), 
yy=c-code # (location) in the adapter (01-10). For example, 
a c-code imported from Channel 3, with a C-Code in 
memory location #1 would be: C7301. 

9. In the RDD Free Space Alert field, enter 0-1000 (kilobytes). 
The C8000 will issue a warning when the available free 
space reaches or surpasses the specified value. 

10. Adjust the LCD contrast for the C8000 by moving the 
slider to the left or right. Note: Moving the cursor to the 
right will darken the screen, while moving the cursor to 
the left will lighten the screen. 

11. Click OK. 

3.1.16 Alert Window 

The Alert window may appear when BatteryLab is first 
executed and will display and warning or error information. 

For each warning/error condition, the Alert window displays 
the unit number and IP address of the C8000 that has issued 
the warning; the date and time the warning occurred; the test 
identification number (ID) of the service issuing the warning, 
and text with an explanation of the warning/error. The Alert 

window may also display information on how to correct the 
warning/error condition. 
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Click Clear to erase the error message. Click Copy to 

Clipboard to copy the error information to the Windows 
Clipboard – the error information can then be copied to 
another Windows application. 

All warning/error messages are displayed in the sequence of 
issue. 

To view information about the next warning/error condition, 
click Next. To view information about the previous 
warning/error condition, click Prev.  

Click Close to close the Alert window. Note: Closing the 
window will erase any warning that have been issued, from 
the Alert window. All C8000 service warning/error(s) will be 
recorded in the Test record for the service. 

3.1.17 Exit BatteryLab 

From the C8000 menu, click Exit to terminate BatteryLab. The 
Confirm window appears. 

 

Click Yes to close the BatteryLab application. 
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3.2 Configure BatteryLab 

3.2.1 Results Panel 

BatteryLab can be customized to display specific fields in the 
Results window. The Available Fields column lists the fields that 
can be displayed in the Results window. The Display Fields 
column displays the fields that will be displayed in the Results 
window. 
 
The following table describes the variables that are available for 
display by the Results window. 
 

Variable Description 

Voltage Voltage reading from the C8000 

Current Current reading from the C8000 

Step Current step within a program 

Step Duration The duration of the current step  

Step Description A user-defined description of the current step 

Status The current status of the C8000 channel or program 

Pgm Name The executing program’s name 

Result The test result of the current program 

Test ID Test Identification (ID) number that has been 
assigned automatically to the service/test 

Duration The total duration of the entire program 

Cap % Capacity reading from the C8000 

Chrg Cnt Number of Charge steps that have been applied 
during the program 

Dchg Cnt Number of Discharge steps that have been applied 
during the program 

Battery ID The Battery Identification (ID) that has been 
assigned. 

AnalogOut1 Voltage level of the first Analog output  

AnalogOut2 Voltage level of the second Analog output 

DigitalOut1 Status of Digital 1 when configured as an output 

DigitalOut2 Status of Digital 2 when configured as an output 
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Variable Description 

DigitalOut3 Status of Digital 3 when configured as an output 

DigitalOut4 Status of Digital 4 when configured as an output 

DigitalIn1 Status of Digital 1 when configured as an input 

DigitalIn2 Status of Digital 2 when configured as an input 

DigitalIn3 Status of Digital 3 when configured as an input 

DigitalIn4 Status of Digital 4 when configured as an input 

AnalogIn1 Voltage level of Analog Input 1 

AnalogIn2 Voltage level of Analog Input 2 

AnalogIn3 Voltage level of Analog Input 3 

AnalogIn4 Voltage level of Analog Input 4 

Deg C Temperature reading from C8000 

MOhm Impedance milli-ohm reading from C8000 

Thml Chm 
Status 

Indicates the basic condition of the Thermal 
Chamber. (Hold and Running) 

Thml Chm Tmp The temperature reading from supported thermal 
chambers 

 
 

1. From the Tools menu, select BatteryLab Configuration. 
The BatteryLab Configuration window appears. 
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2. Click Results Panel. The Results Panel window appears. 
 

 

3. To add a field to the Results window, select the field in the 
Available Fields column and click Add. 

4. To remove a field from the Results window, select the field 
in the Display Fields window and click Remove. 
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5. To select the order the fields appear in the Results 
window, select the fields in the Display Fields column and 
click Up and Down. Note: The first field listed will appear 
on the left side of the Results panel. 

6. Click OK to save the field changes. 

3.2.2 Event Logging 

BatteryLab creates log files for events occurring in BatteryLab and 
for real-time status events in C8000s. 

To select the location of the log file and Enable: 

1. From the Tools menu, select BatteryLab Configuration. 
The BatteryLab Configuration window appears. Click 
Event Logging. The Event Logging window appears. 

 

 

2. Click the Browse icon to select the location to store the log 
file.  

3. Click Clear Log File to delete the events in the selected log 
file. By default, the log file is always the same file – only 
the location can be changed. 

4. Click Copy Log File to create a back up copy of the 
selected log file. By default, the backup log file is always 
the same file – only the location can be changed. 
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5. Select the Enable Communication Data Log check box to log 
all communications between the C8000 and BatteryLab for 
debug purposes only. Note: Multiple files maybe stored in 
this location if the file size exceeds 100MB. Any additional 
files will be numerically appended in the order of 1. 

3.2.3 Report Template Options 

BatteryLab test reports can be customized with a logo and report 
headers.  

1. From the Tools menu, select BatteryLab Configuration. 
The BatteryLab Configuration window appears. Click 
Report Template Options. The Report Template Options 
window appears. 
 

 

2. Click Select Printer to select the default printer for test 
reports. 

3. In the Lines 1 through 4 fields, type the text that will appear 
as headers in the test report. 

4. Click Select Bitmap to select a logo bitmap file. The 
recommended size for a BMP logo is 1.5 inches x 1.5 inches. 

5. Click OK. 

 

3.2.4 Graph Options 

Altering the Plot Variables can customize the default variables for 
the graphs; 
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1. From the Tools menu, select BatteryLab Configuration. 
The BatteryLab Configuration window appears. Click 
Graph Options. The Graph Options window appears. 
 

 

2. To add a variable, select the variable in the Available 
Variables column and click Add. Note: A maximum of 4 
variables can be plotted at anytime. 

3. To remove a variable, select the variable in the Plot 
Variables column and click Remove. 

4. To adjust the order of display for a variable in the plot, 
select the variable in the Plot Variables column and click Up 
or Down. 

5. To display the separate Y-axis for the selected variables, 
select the Separate y-axis check box. 

6. Specify the last range of points to plot (the default is 10000) 
in the graph in the Last x available data points field. Note: All 
Real-time graphs have a maximum of 10000 points. 

7. To Display the program’s Status Code during the service 
select the check box. 

8. Auto Reduce Resolution will decimate the graph, reducing 
the number of points displayed for large graphs over 1000 
points, increasing the graph display response.  All points 
are still viewed as the graph is zoomed in. 

9. Click OK. 
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3.3 View Battery Status in Real-Time 
When BatteryLab successfully connects to one or more batteries, 
select a channel and click the Real-Time icon in the C8000 Result 
Panel or right-click the channel, to view the status of a battery. 
The Real-Time Status window appears. 

 

The Real-Time Status window defaults to the “program steps” 
being currently executed for this battery channel. 

Program Step – shows all the steps within the program being 
currently run. Selecting a step will display all the parameters of the 
step, within the Action Parameters sub-window. The parameters 
for the entire program can be found in the Program Parameters sub-
window. 

To view a real-time graph for the selected channel, click Graph. 
The Real-Time Graph window appears. Note: If the service on the 
C8000 was started before BatteryLab was connected, the graph 
will not appear. In this case, the message No Data appears. 

BatteryLab will create a service record if the service on the C8000 
was started before BatteryLab was connected. 
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Graph –displays all the recorded data. The graph can display up 
to five individual variables, simultaneously.  

Located in the bottom right. 

Options - Allows the selection of the variables to be displayed. 

All Data- Shows the entire graph. The standard real-time graph is 
limited to a maximum of 10000 points. 

Zoom Out – undo all zoom commands.  

Separate y-axis – Separates all graphs into individual scales.  
Default checked. 

Auto Scale – Automatically scales each graph, on the y-axis. To 
manual scale the y-axis, select the graph (Drop box) to manual 
scale and uncheck the box. Enter in the range in the “Min” and 
“Max” boxes and press enter. 

 

To zoom in on an area of the graph select the left mouse button 
and hold. Drag and hold the mouse cursor until the required area 
is within the zoom box, release the mouse button.  
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To view the current C-Code for this channel, click C-Code. 

 

 

To view waveforms for this channel, click Custom Waveform. The 
Waveforms real-time information appears. 

 

To view the playback of a waveform, click Playback Waveform. 
The Playback Waveform window appears. 
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To view smart battery real-time information, click Smart Battery. 

 

 

To view the schedule of programs for this channel, click Schedule. 
The Schedule window displays the program steps that were 
executed. 
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3.4 Test Batteries with BatteryLab 
 

To test a battery: 

1. From the BatteryLab Main menu, click Connect. 
The C8000 window appears.  

 

BatteryLab waits for C8000s to connect. When a C8000 connects to 
BatteryLab, the C8000 window title updates to reflect the IP 
Address of the connected C8000. The C8000 also updates its Title 
Header from C8000 to the Unit # indicated on the analyzer 
window. Wait for the C8000 to connect to BatteryLab before 
starting to test a battery. 

If the C8000 and software do not connect within 15 to 60 seconds, 
check the IP addresses and verify that no IP address is duplicated 
on the network.  (An error message appears if the time-out limit is 
reached.) Recycle power on the C8000, and restart BatteryLab.  If 
problems persist, see Communication Issues. 

1. Select a C8000, choose a channel, select and right-click on 
the channel and choose Test Battery. The Test Battery 
window appears. 
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2. Enter the following information.  

 Program: Select a program.  

o There are two type of programs available (SM-
BUS and STANDARD) 

 C-Code or Battery ID: Enter the battery ID or c-code.   

o The type of program selected will filter the 
available C-codes.  Example: SM-BUS program 
will only filter all non-SM-BUS C-codes from 
the available list. 

o To automatically create a SM-BUS C-code, 
select Import from Smart Battery. See section 
3.9.2 Add a SM-BUS (Smart Battery) C-Code for 
details. 

3. Click OK. 

4. Connect correct battery channel terminals on C8000 to 
battery. The prompt clears automatically when the test 
starts. 
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3.4.1 View the Status of a Test in BatteryLab 

The C8000 window in Battery Lab displays the status of each test 
running on the C8000:  

 Channel 

 Volts  

 Current  

 Program step 

 Status message 

 

To modify the information that appears in the Result Panel, select 
Result Panel in the BatteryLab Configuration window. 

3.4.1.1 Background Color of Tests Running 
The background color displayed for each test running indicates 
the status of the test.  

Status Color Description 

No Color Change Status unchanged 

White No battery 

Red with Status Code in White Fail 

White with text in Red Unknown Error -Fail 

Yellow Service Running 
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Yellow with text in Red Warning 

Green  Pass 

 

3.4.2 Cancel or Suspend a Test in BatteryLab 

You can cancel a running test; suspend a test that is running, or 
resume a suspended test. 

3.4.2.1 Cancel a Test 
In the C8000 window, right-click the channel of the C8000 Result 

Panel and choose Abort.  

3.4.2.2 Suspend a Test 
In the C8000 window, right-click on the channel and choose 
Suspend. 

3.4.2.3 Resume a Suspended Test  
In the C8000 window, right-click on the channel and choose 
Resume. 

3.4.2.4 Simulate a Battery Removal   
In the C8000 window, right-click on the channel and choose 
Remove Battery. 

 

3.4.3 Retrieve Test Results from the C8000 

Test results are automatically retrieved from the C8000s as long as 
BatteryLab is online and the C8000 is connected. When a test is 
started, BatteryLab immediately retrieves the test results. Tests 
started on the C8000 must be manually retrieved using the Test 
Results window in BatteryLab. 

1. From the C8000 menu, select Results. The Test Results 
window appears.  
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2. The Test Results window lists the 100 most recent test 
results in the database. Click Search to view all test 
results in the database 

3. To retrieve test results for battery tests started on the 
C8000, select Retrieve Results from the File menu. 

 

The Result column indicates the test result, for example Pass or 
Fail. A test result of N/A means the test result file was not found; 
a test result of N/C means the test was not completed as it is still 
running. 

Note: If results for tests NOT started via BatteryLab are retrieved 
long after Test Results on the C8000 are automatically deleted, 
then there is a chance that the wrong Test Result record will 
become associated with Test Records in the BatteryLab database. 
For this reason, it is recommended that the Retrieve Results should 
occur before associated Test Results on the C8000 are 
automatically deleted. 

3.5 Test Status 
The test results list shows status codes to indicate the status of the 
battery test. 

1. Open the test result you want to view.  
For information on viewing the test results, see View 
Test Results in BatteryLab.   

2. In the test results, note the information in the Results 

and Status Code fields. 
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3. Look up the status code in the Status Messages Listed by 
Code and Status Messages Listed by Detailed Message 
sections of this manual.  

4. Take the appropriate actions based on the information 
in the table. 

 

3.6 View Test Results in BatteryLab 
Tests started with BatteryLab are automatically retrieved from the 
C8000 when the test completes and BatteryLab is still running. 

If a test is started on a C8000 and BatteryLab is not running, the 
Test Results will be saved on the C8000. When BatteryLab is run 
the next time, use the Retrieve Results (File) menu option on the 
Test Results window to retrieve the results for the test started on 
the C8000. However, in this case, test results will not include 
graph data. 

 

 

1. From the C8000 menu, click Results. The Test Results 
window appears.  

2. In the Search for field, type part or all of the battery ID or C-
Code. 

3. Select the All Dates check box to find all test results for the 
battery.  
--or-- 
Clear the All Dates check box and select the date range to 
view. 
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4. Click Search. The results appear in the window. 

3.6.1 Import Test Results 

To import test results from a file: 

1. From the C8000 menu, click Results. The Test Results 
window appears. 

2. From the File menu, select Import Test Results. The Open 
window appears. 

3. Select the file that contains the test results to import and 
click Open. 

3.6.2 Print a Search List 

To print the search list: 

1. From the C8000 menu, click Results. The Test Results 
window appears. 

2. From the File menu, select Print Search List. The Print 

Preview Caption window appears. 
 

 

3. From the Report menu, click Print to print the search list 
report. 

 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  115 

3.6.3 View and Print Test Details 

View detailed battery test information by selecting a record in the 
Test Result list and clicking View Record.  

1. From the C8000 menu, click Results. The Test Results 
window appears with 100 of the latest results listed. Click 
Search to view all Test Results. 
 

 

2. Select a record from the list. 

3. Click View Record. The Test Record window appears. 
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3.6.3.1 Edit a Test Result Record 
To edit the remarks for a test result:  

1. From the C8000 menu, click Results. The Test Results 

window appears. 

2. In the Test Results window, search for the test result by a 
battery ID or C-Code and click Search. 

3. Select a result record. 
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4. Click Edit Record. The Edit Record window appears. 
 

 

5. Edit the remarks for the test record, as needed. 

6. Click OK. 

3.6.3.2 Delete a Battery Test Record 
If a battery test record is no longer needed, delete it from the 
database. 

1. From the C8000 menu, click Results. The Test Results 
window appears. 

2. In the Test Results window, search for the test result by 
battery ID or C-Code and click Search. 

3. Select the test record to delete. Hold the CTRL key down to 
select multiple records. 

4. Click Delete Record. The Confirm window appears. 
 

 

5. Click Yes. 

3.6.3.3 Print Test Result Document 
To print a test result document:   
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 In the Test Record window, click Print Record.  

3.6.3.4 View Details 
To the Details:  

1. In the Test Record window, click Details. 

 

2. The Details window displays a list of all the recorded data. 

 

 

3.6.3.5 View Program Steps 
To view program steps: 

1. In the Test Record window, click Program Steps. 
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2. The Program Steps window displays each program step and 
the step’s parameters. 

3.6.3.6 View a Battery Test Graph 
To view a graph of the battery test, click Graph in the Test Record 
window.  

 

3.6.3.7 View C-Code Information 
To view C-Code information, click C-Code in the Test Record 
window.  
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3.6.3.8 Custom Waveform 
To view custom waveform information, click Custom Waveform 
in the Test Record window. Note: If no Custom Waveform was 
used in the program, this option will be grayed out. 

 

3.6.3.9 Playback a Waveform 
To playback a waveform: 
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In the Test Record window, click Playback Waveform.  

Note: If no Playback Waveform was used in the program, this 
option will be grayed out. 

 

3.6.3.10 Load Capture Waveform 
To view a load capture waveform in the Test Record window, 
click Load Capture Waveform. 

Note: If no Playback Waveform was used in the program, this 
option will be grayed out. 

 

3.6.3.11 View Termination Data 
To view termination data: 
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In the Test Record window, click Termination Data. Click the 
Data Point tab to view data point information. 

 

Click the Graph tab to view termination data in graph form. 

 

3.6.3.12 Cycle Graph 
To view a cycle graph: 
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In the Test Record window, click Cycle Graph. 

3.6.3.13 Print Results 
To print a hardcopy of the test results: 

In the Test Record window, click Print Results. 

 

3.6.3.14 Print a Battery Test Graph 
To print a hardcopy of the battery test graph: 

1. In the Test Record window, click Print Graph. 

2. The Printing window appears. 
 

 

3. Click OK to print the graph. 

 

3.6.3.15 Export Test Record Results to a File 
To export test record results: 

1. In the Test Record window, click Export Results. The Save 

As window appears. 
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2. Click the File name field and type a new name for the file, if 
necessary. 

3. Click Save. 

 

3.6.3.16 Export Graph Data To a File 
To export graph data: 

1. In the Test Record window, click Export Graph Data.  The 
Save As window appears. 
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2. Click the File name field and type a new name for the file, if 
necessary. 

3. Click Save. 

 

3.6.3.17 Export Termination Data to a File 
To export termination data: 

1. In the Test Record window, click Export Termination 

Data. The Save As window appears. 

2. Click the File name field and type a new name for the file, if 
necessary. 

3. Click Save. 

 
 

3.7 Reports 
Reports can be customized using Report Templates to display 
required test result fields, and to specify optional report headers 
and a report bitmap. 

After setting the default Report Template, test results will appear 
as described by the Report Template. 

3.7.1 Print Battery Test Reports 

To print a battery test report:   

1. From the C8000 menu, click Results. The Test Results 

window appears.  

2. In the Test Results window, search for test records by 
Battery ID, c-code, or date range. 

3. Click Search. 

4. Select one or more rows in the results. 

5. Click Print Record.  
 

3.7.2 Add, Edit, and Delete Report Templates 

 

3.7.2.1 Add a Report Template: 

1. From the Tools menu, click Report Templates. The Report 

Templates window appears. 
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2. Click Add. The Password window appears 
 

 
.  

3. Enter your password and click OK. The Template Fields 
window appears. 
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4. In the Template Name field, type the name for the new 
template. 

5. By default, all field names are automatically selected. Clear 
the check box next to a field’s name to exclude that field from 
the report. Select the check box next to the field’s name to 
include that field in the report that will be created from this 
report template. To quickly select all fields for inclusion in 
the report template, click Select All; to exclude all fields from 
the report template, click Clear All. 

6. To move the position of a field up or down in the report, 
click the field name and then click Move Up or Move Down. 
This sets the order that the fields will appear in reports using 
this template. 

7. When you have finished selecting the fields for the report 
template, click OK to save the template. The new report 
template appears in the list of templates. 

3.7.2.2 Edit a Report Template: 
To edit a report template:  
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1. From the Tools menu, click Report Templates. 
The Report Template window appears. 

 

 

2. From the list of templates, select the template you want to 
edit. 

3. Click Edit. If security is enabled, a password prompt 
appears. Specify the correct password to continue with edits 
to the report template. 

4. Clear the check box next to a field’s name to exclude that 
field from the report. Select the check box next to the field’s 
name to include that field in the report that will be created 
from this report template. To quickly select all fields for 
inclusion in the report template, click Select All; to exclude 
all fields from the report template, click Clear All. 

5. To move the position of a field up or down in the report, 
click the field name and then click Move Up or Move Down. 
This sets the order that the fields will appear in reports using 
this template. 

6. Click OK to save the changes you have made to this report 
template. 

3.7.2.3 Set the Default Report Template 
When you print a report, it will be printed based on the default 
template. The first report template you create is automatically set 
as the default template.  You can select which template is to be the 
default template.  
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1. From the Tools menu, click Report Template. 
The Report Templates window appears. 

 

 

2. Place a check mark in the Default check box to set the 
template as the default report template. 

3. Click OK. 

3.7.2.4 Delete a Report Template 
A protected report can be deleted after protection is removed. The 
default report template can be deleted once another template is set 
as the default.  

1. From the Tools menu, click Report Template. 
The Report Templates window appears. 
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2. Select the report template to delete.  

3. Click Delete. A Confirmation window appears. Click 
Yes. The report template is deleted. 

4. Click OK. 

 

3.7.2.5 Copy a Report Template 
It is possible to create a report template based on an existing 
template record. Making a copy of an existing template and then 
editing the copy to create the new template do this. 

1. From the Tools menu, click Report Template. The Report 

Templates window appears. 
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2. Select the template to copy. 

3. Click Copy. The Copy Report Template window appears. 
 

 

4. Type a name for the new report template. 

5. Click OK. The Template Fields window appears. 
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Clear the check box next to a field’s name to exclude that 
field from the report template. Select the check box next to 
the field’s name to include that field in the report template. 
To quickly select all fields for inclusion in the report 
template, click Select All; to exclude all fields from the report 
template, click Clear All. 
 
To move the position of a field up or down in the report 
template, click the field name and then click Move Up or 
Move Down. This sets the order that the fields will appear in 
reports using this template. 

6. Click OK. The new report template appears in the Report 

Template window. 
 

3.7.2.6 Set Up Your Printer 
Report printing requires that a printer driver is installed on the 
operating system and that a default printer driver is specified in 
the Printers folder (Start > Settings > Printers). Next, specify the 
default windows printer driver by right-clicking the printer’s icon 
and selecting Set as Default Printer. This must be done at the 
operating system level before running BatteryLab. 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  133 

After launching BatteryLab the first time, specify the default 
Windows printer driver for printing reports. 

1. From the Tools menu, select Report Template. The Report 

Templates window appears. 
 

 

2. Click Printer Setup. The Print Setup window appears. 
 

 

3. Select the properties (paper size and source and the 
printing orientation) for the printer test. 

4. Click OK. 
After specifying printer settings, print a test. 

 Click Test Print. A sample test report is printed. 
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3.8 Battery ID Database 
A battery ID identifies a physical battery with a unique ID. The 
Battery ID Database window displays the battery ID and the 
corresponding c-code for each battery ID. (Note: The 
corresponding c-code may be changed at any time.) The C-Code 
Database window describes a specific battery type and the 
settings required to process that battery type. 

3.8.1 Add a Battery ID 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. A green check mark in the 
Smart Battery column indicates that the associated c-code is 
configured as an SM-Bus c-code. 
 

 

 

2. Click Add. The Add Battery ID Definition window 
appears. 
 

 

3. Type a name for the battery in the Battery ID field. 
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4. Click the Pencil icon next to the C-Code field. The C-Code 

Database window appears. Select a C-Code for the battery 
ID and click OK. 

5. Type any remarks in the Comment 1 and Comment 2 fields. 

6. Click OK. The new battery ID appears in the Battery ID 

Database window. 
 

3.8.2 Edit a Battery ID 

To edit a battery ID: 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 

 

2. Select the battery ID to edit. 

3. Click Edit. If database security is enabled, the Password 
window appears. 
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4. Enter your password and click OK. The Battery ID 

Definition window appears. 
 

 

5. Edit the information, as required. 

6. Click OK. 

3.8.3 Delete a Battery ID 

To delete a battery ID: 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 

 

2. Select the battery ID to delete. 

3. Click Delete. If database security is enabled, the Password 
window appears. 
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4. Enter your password and click OK. The Delete Options 
window appears. 
 

 

5. If you select Delete from BatteryLab option, the Confirm 
window appears. Click Yes to delete the battery ID. 
  

 
 
If you select the Delete from Connected C8000, the Delete 

Battery ID window appears. The top half of this window 
lists all connected C8000s while the bottom half of this 
window lists the battery IDs for the selected C8000. Select 
the battery ID to delete and click Delete. 
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3.8.4 Copy a Battery ID 

Copy a battery ID to create a battery ID: 

1. From the Database menu, click Battery ID. The Battery ID 
Database window appears. 
 

 

2. Select the battery ID to copy. 

3. Click Copy.  If database security is enabled, the Password 
window appears. 
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4. Enter your password and click OK. The Battery ID 

Definition window appears. 
 

 

5. Click OK. The new battery ID appears in the Battery ID 

Database window. 
 

3.8.5 Import a Battery ID 

To import a battery ID from a file: 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 



 C8000 Battery Testing System User Manual 

140  3 Cadex BatteryLab 

 

 

2. Click Import. If database security is enabled, the Password 
window appears. 
 

 
 

3. Enter your password and click OK. The Import a Battery 

ID window appears.  
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4. Click Browse. The Open window appears. 
 

 

5. Select the file that contains the battery ID information to 
import. 

6. Click Open. If the c-code specified in the to-be-imported 
file already exists, this error window will appear. Type a 
new name for the c-code and click OK. 
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7. An Information window appears with the number of files 
imported. 
 

 

To import a battery ID from the C8000: 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 
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2. Click Import. If database security is enabled, the Password 
window appears. 
 

 
 

3. Enter your password and click OK. The Import Battery ID 
window appears. 
 

 

4. Click From the C8000. 

5. Select the C8000 that contains the battery ID information to 
import. 

6. Click Import and click OK. 

3.8.6 Export a Battery ID 

To export a battery ID to a file: 
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1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 
 

 

2. Select the battery ID to export. Hold the CTRL key down 
to select multiple records. 

3. Click Export. Click Browse. The Save As window appears. 
 

 

4. Type a name for the export file in the File name field. 

5. Click Save. 

6. An Information window appears with the number of files 
exported. 
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To export a battery ID to the C8000: 

1. From the Database menu, click Battery ID. The Battery ID 

Database window appears. 
 

 

2. Select the battery ID to export. Hold the CTRL key down to 
select multiple records. 
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3. Click Export. The Export Battery ID window appears. 
 

 

4. Click To the C8000. A list of connected C8000s appears. 
 

 

5. Click Export.  
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3.8.7 Search for a Battery ID 

The BatteryLab database may contain hundreds, or even 
thousands, of battery IDs.  To find a battery ID, click the Search By 
Battery ID field to move the cursor to that field.  

 

Next, type the first one or two characters of the battery ID to find. 
As BatteryLab locates the partial ID, it will highlight the 
corresponding ID in the Battery ID Database window. 

3.8.8 Sort Battery IDs 

The BatteryLab database may contain many battery IDs. To sort 
the battery IDs in ascending order click the Battery ID or C-Code 
column in the Battery ID Database window. Click the column a 
second time to sort the battery IDs in descending order. 

3.9 C-Code 
The C-Code Database window displays a list of C-Code records 
in the BatteryLab database. A C-code (Configuration Code) is a 
list of parameters specific to the Battery under Test. These 
parameters determine the service algorithms that will be applied 
to the battery by the C8000.  

3.9.1 Add a C-Code 

To add a c-code to BatteryLab: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
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2. Click Add. The C-Code Definition window appears. 
 

 

 

3. If required, edit the detail fields in the C-Code Definition 
window to describe the new c-code. 

4. Type a name for the new c-code in the C-Code Name field. 

5. Select the Smart Battery check box to convert the C-Code 
into an SM-Bus compatible C-Code to be used with smart 
batteries. 

6. Select the Use External Load Maximum Discharge Rate check 
box to bypass the parameter Max. safe operating discharge 
current and use the maximum discharge current of the 
external load. Bypass only occurs if the Discharge Playback 
action is used in a program and is currently active. 

7. Click OK. The new c-code appears in the C-Code 

Database window. 

3.9.2 Add a SM-BUS (Smart Battery) C-Code 

To manually create a SM-BUS C-code see section 3.9.1 Add a C-
Code and to automatically create a SM-BUS C-code continue with 
this section. 

Note: All SM-BUS functions require that additional lines to be 
attached to the SM-BUS battery, from the Auxillary I/O port 
cable. Attach the purple/white wire (pin number nine (9)) to the 
Clock line and the brown/white wire (pin number ten (10)) of the 
data line of the SM-BUS battery. Also, ensure that one of the 
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ground lines, from the Auxillary cable, is connected to the ground 
or negative of the battery. Example: Black wire (pin number seven 
(7) is connected to the negative terminal of the SM-BUS battery. 
(Connection to the battery may vary depending on the battery 
configuration. Consult the battery specifications before proceeding with 
the connection) for a full description on the Auxillary I/O port 
cable. 

 

To automatically add a SM-BUS c-code in BatteryLab: 

1. Select a C8000, choose a channel, select and right-click on 
the channel and choose Test Battery. The Test Battery 
window appears.. 
 

 

2. Click Import from Smart Battery and Import SM-BUS C-

Code window will appear.  

 

3. After all required data has been downloaded from the 
Smart Battery registers the C-Code Definition window 
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appears. 
 

 

The following table shows, which register where 
automatically, downloaded. All other c-code fields are 
dynamically adjusted to recommended values. 

C-code Field SM-BUS Register Description 

Chemistry 0x22 Displays the chemistry type reported 

Rating 0x18 Displays the Design Capacity reported 

Charge Rate 0x14* Displays the requested Current  

Discharge Rate 0x14* Displays the requested Current  

Maximum Charge Voltage 0x15** Displays the requested Charge Voltage 

*If the requested current is ZERO (0), then the 
system will default to the a 1.0C rate 

** This register is only downloaded if the 
Chemistry type is equivalent to a CC-CV charging 
algorithm. 

4. If required, edit the detail fields in the C-Code Definition 
window to describe the new c-code. 

5. Type a name for the new c-code in the C-Code Name field. 

 The Smart Battery check box is automatically checked. 

6. Select the Use External Load Maximum Discharge Rate check 
box to bypass the parameter Max. safe operating discharge 
current and use the maximum discharge current of the 
external load. Bypass only occurs if the Discharge Playback 
action is used in a program and is currently active. 
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7. The SM-Bus codes will have an additional six (6) options 
available. These fields control the actions that will occur 
when the C8000 retrieves the associated flag from the 
Battery Status register. 

When active the C-code is enabled for SM-BUS batteries and the 
following parameters become available: 

1) Fully Charged 

2) Terminate Charge Alarm 

3) Overcharge Alarm 

4) Fully Discharged Alarm 

5) Terminate Discharge 

 Any of the above options can be set to one the following conditions; 

  a. Finished –will terminate the program successfully on flag 

  b. Fail –will terminate the program with a failure on flag 

  c. Ignore – will ignore the flag. 

6) Over temperature Alarm options; 

  a. Ignore – will ignore the flag. 

i. Retry x (1~10) – will wait for multiple flag conditions before 
terminating with a failure. (Over-temperature only). 

8. Click OK. The new c-code appears in the Test Battery 

window. 

a. This SM-Bus C-Code will have also been added to the C-code Database. 
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3.9.3 Edit a C-Code 

To edit a c-code: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Select the c-code to edit. 

3. Click Edit. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK.   The C-Code 

Definition window appears. 
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5. Edit the information as required. 

6. Click OK. 

 

3.9.4 Delete a C-Code 

To delete a c-code from BatteryLab: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Select the c-code to delete. 
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3. Click Delete. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK. The Delete Options 
window appears. 
 

 

5. If you select Delete from BatteryLab option, the Confirm 
window appears. Click Yes to delete the c-code. 
 

 
 

6. If you select the Delete from Connected C8000, the Delete C-

Code window appears. The top half of this window lists 
all connected C8000s while the bottom half of this window 
lists the c-codes for the selected C8000. Select the c-code to 
delete and click Delete. 
 
  
. 
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3.9.5 Copy a C-Code  

To create a c-code based on an existing C-Code: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Select the c-code to copy. 

3. Click Copy.  The C-Code Definition window appears. 
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4. Edit the chemistry settings for the c-code, as required. 

5. Type a name for the new c-code in the C-Code Name field. 

6. Click OK. 

3.9.6 Import a C-Code 

To import a c-code from a file: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
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2. Click Import. The Import C-Code window appears. 
 

 

3. Click Browse. The Open window appears. 
 

 

4. Select the file to import and click Open. The Information 
window appears, showing the number of c-codes 
imported. (If the c-code already exists, click Cancel to 
terminate the import process altogether, or OK to 
overwrite the existing c-code. Alternatively, specify a 
different name for the c-code and click OK to import it.) 
Note that multiple c-codes can exist in one file. 

To import a c-code from the C8000: 



 C8000 Battery Testing System User Manual 

158  3 Cadex BatteryLab 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Click Import. The Import C-Code window appears. 
 

 

3. Click From the C8000. The Import C-Code window 
appears. 
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4.  
 

5. Select the C8000 that contains the c-code to import and 
click Import or click Import from SnapLock Adapter to 
see a list of stations the SnapLock/RigidArm Adapter may 
be attached to. 
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Click Refresh to update the list of c-codes from the 
SnapLock/RigidArm Adapter. Next, select the c-code(s) to 
download. Click Import to transfer the c-code(s) file(s). 

3.9.7 Export a C-Code 

To export c-codes to a file: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Select the c-code to export. Note that multiple c-codes can 
be exported to the same file. 
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3. Click Export. The Export C-Code window appears. 
 

 

4. Click Browse. The Save As window appears. 
 

 

5. Type a name for the file in the File name field. 

6. Click Save. All selected c-codes are saved to the file. An 
Information window appears with the number of C-Codes 
exported. (If the file already exists, specify a new filename 
or opt to overwrite the existing file – click OK.) 
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7. Click OK. 

 

To export c-codes to the C8000: 

1. From the Database menu, click C-Code. The C-Code 

Database window appears. 
 

 

2. Select the c-code(s) to export. 

3. Select the C8000 to export the c-codes to and click Export. 
The Export C-Code window appears. 
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4. Click To the C8000. The Import/Export window appears. 
 

 

5. Click Export. All selected c-codes are exported to the same 
file. An Information window appears with the number of 
C-Codes exported. 
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6. Click OK. 

3.9.8 Search for a C-Code 

The BatteryLab database may contain hundreds, or even 
thousands, of c-codes. To find a c-code, click the Search By C-Code 
field to move the cursor to that field.  

 

Next, type the first one or two characters of the c-code to find. As 
BatteryLab locates the partial c-code, it will highlight the 
corresponding c-code in the C-Code Database window. 

3.9.9 Sort the C-Codes 

The BatteryLab database may contain many c-codes. To sort the c-
codes in ascending order, click the C-Code column in the C-Code 

Database window. Click the column a second time to sort the c-
codes in descending order. 

 

 

3.10  Programs 
The Program Database window lists the system and custom 
programs that are available for the C8000. For each program, the 
Program Database window shows the program’s name, the 
program’s type, and whether the program is active. A program 
contains one or more steps that will be executed in the order 
specified. 

Programs can be added, edited, deleted, copied, imported, or 
exported. Programs can also be organized in folders. 

It is possible to create as many programs as required, but a 
program cannot exceed 99 steps in length. 
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The following table provides a description of sample programs to 
use as a starting point when creating BatteryLab programs to test 
batteries. 

Emergency Lighting Battery 
Test 

1. Trickle charge for 24 hours 

2. Discharge for 15 minutes at @10A 

3. Charge 

4. Trickle charge for 24 hours 

5. Loop to step 1. 

Simulate a battery and solar 
energy-powered device (such as 
a radio repeater, weather 
stations, and so on). 

1. Charge for 3 hours @ lower current 
(Sunrise) 

2. Charge for 6 hours @ higher current 
(Daytime) 

3. Charge for 3 hours @ lower current 
(Sunset) 

4. Discharge for 12 hours @ constant 
current (Nighttime) 

Similar to the program above, 
except connect an external light 
sensor to one of the auxiliary 
inputs. 

1. Charge @ lower current; if analog 
input >= daytime value, proceed to 
step 2. 

2. Charge @ higher current; if analog 
input < daytime value, proceed to 
step 3. 

3. Charge @ lower current; if analog 
input = nighttime value, proceed to 
step 4. 

4. Discharge @ constant current; if 
analog input > nighttime value, 
proceed to step 1 

3.10.1 Factory Default Programs 

The following table describes the C8000 Factory Default 
programs. 

Program Description 

Auto Function: Exercises batteries to maintain optimum performance. This 
is the recommended program for routine maintenance of batteries. 
This test reconditions NiCD and NiMH batteries that do not reach 
Target Capacity. Li-ion and SLA batteries are not reconditioned, only 
exercised. 
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Sequence: The battery is first cycled (charged and then discharged) to 
determine its true capacity. If NiCD and NiMH batteries do not meet 
the target capacity at the end of the discharge cycle, they are 
reconditioned to reduce battery memory. Following recondition, the 
battery is cycled again to determine the recovered or final capacity. 
The battery is fully charged when the program completes. SLA and 
Li-ion batteries are cycled once. If the target capacity is not reached in 
the first cycle, it is cycled again. Recondition is not performed for Li-
ion and SLA batteries. 

Duration: Approximately 2.5 to 10 hours for NiCD and NiMH, 20 to 
40 hours for SLA and 6 to 20 hours for Li-ion using default C-Codes. 

Charge Function: Fast charge a battery. 

Sequence: A charge cycle is applied to the battery. No capacity 
readings are taken (capacity is only obtained if there is a discharge 
cycle). Charge does not perform a full analysis; use the Auto or Prime 
program to fully diagnose a battery. 

Duration: Approximately 1.5 hours for NiCD and NiMH, 10 hours 
for SLA, and 4 hours for Li-ion using default C-Codes. 

Prime Function: Prepares new or stored batteries for use. A new or stored 
battery may require several charge/discharge cycles to form the cells 
to achieve peak performance. 

Sequence: The program cycles (discharges and charges) the battery 
until the difference between capacities from one cycle to the next is 
less than 5%. Up to four cycles if the 5% capacity difference is not 
reached. This allows for batteries that cannot accept a full charge on 
the first cycle. If the battery is fully discharged, the program starts 
with a charge. No reconditioning is applied. Some batteries may 
require several Prime cycles to fully form the cells. 

Duration: Approximately 5 to 10 hours for NiCD and NiMH, from 40 
to 80 hours for SLA, from 12 to 25 hours for Li-ion using default C-
Codes. 

SelfDchg 
(Self 
Discharge) 

Function: Identifies the self-discharge or the amount of charge a 
battery loses if it is left alone for a period of time. The standard time is 
24 hours.  

Sequence: The battery is discharged for 10-minutes before charged 
and discharged to obtain its first capacity. The battery is then charged 
and left for a 24-hour rest period. During this time, the battery loses 
energy through self-discharge. After 24 hours, the battery is 
discharged to determine the second capacity. The difference between 
the second and first capacity is the self-discharge rate. 

Duration: Approximately 30 hours for a NiCD battery using default 
C-Codes. 
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Lifecycle Note: Lifecycle is a “destructive” test that continuously cycles a 
battery until a failure occurs. Do not run this program on a battery 
that needs to be used after the program completes. 

Function: Determines total battery life by the number of cycles. 
Checks whether the battery meets the standard life for its chemistry. 
This is an accelerated aging test that is designed to “destroy” the 
battery. 

Sequence: The battery is charged and discharged continuously until 
the battery fails (i.e. battery capacity falls below target capacity) or the 
maximum number of cycles has been reached. 

Duration: Approximately one month or more, depending on the 
chemistry. Batteries should provide the number of cycles as specified 
by the manufacturer. Typically, with a target capacity of 80%, NiCD 
batteries should provide about 1500 cycles, NiMH 500 cycles, Li-ion 
500 cycles, and SLA 300 cycles. 

DchgOnly 
(Discharge 
Only) 

Function: The DchgOnly program determines the residual capacity of 
a battery, prepares batteries for storage, and checks battery 
performance under load. To determine battery capacity, fully charge 
the battery using the Charge program before running the Discharge 
only program. 

Sequence: The battery is discharged until its voltage reaches the END 

OF DISCHARGE setting in the C-Code and the battery capacity is 
measured. If the battery is partially discharged, the capacity may be 
lower than the target capacity. This may give a Fail Code 115 or 116. 
The battery is not necessarily poor. 

Duration: Approximately 1 hour for a NiCD battery discharged at 
default C-Code settings. 

Note: Smart batteries (often used in laptops) should not be stored in 
a fully discharged state. If the battery’s voltage drops below the 
level required by the processor within the battery, information can 
be lost. In some cases, this data loss can leave the battery 
permanently unusable. 

ExtPrime 
(Extended 
Prime) 

Function: Exercises a battery that has been in storage or unused for 
three months or more. 

Sequence: The battery is charged for 16 hours on the TRICKLE CHARGE 
setting in the C-Code. The battery is then cycled (charged and 
discharged) up to five times until the difference between the capacities 
achieved from one cycle to the next is less than 5%. 

Duration: Approximately 24 hours for a NiCD battery charged and 
discharged at 1.00C. 

OhmTest Function: This program is similar to the IEC “DC” method of 
resistance measurement. It is recommended that the battery have a 
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high state of charge (i.e. fully charged) to provide accurate values. If 
battery SoC is less than 50%, OhmTest readings are less consistent. 
Low state of charge may produce poor or low values. It provides an 
estimate of the battery capability to handle load. If using a battery 
capacity rated under 300mah, use the IMPEDANCE program on 
Channel 1. 

Sequence: The program tests the battery’s resistance and compares 
the result with the battery’s OHMTEST SETPOINT. If the result is above 
this threshold, the program fails the battery.  

 Duration: 15 seconds for all chemistries. 

Impedance Function: This program is similar to the IEC “AC” method of 
resistance measurement. It is recommended that the battery have a 
moderate to high state of charge to provide accurate values.  Very low 
or very high states of charge may produce poor values. It provides an 
estimate of the battery capability to handle load.  Note that the 
“Impedance” program can only be run on Channel #1. 

Sequence: The program tests battery resistance and compares the 
result with the battery’s OHMTEST SETPOINT. If the result is above this 
threshold, the program fails the battery.  

Duration: 30 to 60 seconds for all chemistries. 

Runtime Function: Often referred to as a “5-5-90” test, the RunTime program 
simulates field application with three load currents and time 
intervals.  

Sequence: The battery is charged. The program then repeatedly runs 
the three different loads until the battery is fully discharged. The 
Load algorithm for the loads are 1 minute at 100% then 1 minute at 
50% and 18 minutes at 10% of the Discharge Current Specified in the 
C-code, (i.e. The end-of-discharge setting in the C-Code is reached).  
A full charge is then applied to complete the program.  

Duration: Approximately 8 – 10 hours for a NiCD battery using 
default C-Codes. 

GSM Function: Similar to the RunTime program, but uses a simulated 
GSM discharge pulse to determine the battery’s “Talk Time”.  

Sequence: The battery is charged. The program then discharges the 
battery using the GSM discharge pulse until it is fully discharged (i.e. 
The end-of-discharge setting in the C-Code is reached).  A full charge 
is then applied to complete the program. 

Duration: Approximately 8 – 10 hours for a NiCD battery using 
default C-Codes. 

CDMA Function: Similar to the RunTime program, but uses a simulated 
CDMA discharge pulse to determine the battery’s “Talk Time”.  
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Sequence: The battery is charged. The program then discharges the 
battery using the CDMA discharge pulse until it is fully discharged 
(i.e. The end-of-discharge setting in the C-Code is reached).  A full 
charge is then applied to complete the program. 

Duration: Approximately 8 – 10 hours for a NiCD battery using 
default C-Codes. 

Boost Function: Reactivates batteries with open or shorted protection 
circuits or with voltage so low that the Cadex analyzer does not 
recognize them or gives a ‘Shorted’ (Code 121) message when they 
are inserted in Battery Adapters.  

Sequence: The battery is trickle-charged for three minutes at 100mA. 
Look for stable current and voltage readings during the Boost 
program. If they are intermittent, the battery may be poorly 
connected, battery protection circuit may be damaged or the battery is 
inoperable. Typically, normal battery operation should be possible 
after the battery has reached more than 0.30V/cell on NiCD and 
NiMH batteries and more than 2.5V for Li-ion batteries. If Boost does 
not raise the voltage to detectable levels, apply the Boost program 
again. 

Duration: 3 minutes (user may repeat if unsuccessful). 

Warning: Failure to follow these precautions may result in serious 
damage to the Cadex unit and/or the battery: 

The Boost program overrides some of the analyzer’s built-in safety 
measures to recognize a battery. Do not attempt to Boost a battery if 
the polarity, chemistry, voltage, and capacity (mAh) are not known. 
Ensure that battery polarity is correct before attempting to run 
Boost. 

BatteryInfo Function: For SM-Bus batteries only.  Allows the SM-Bus information 
from a battery to be viewed before actually starting a program. 

Sequence: Reads the SM-Bus data from the battery and sends the 
information to BATLAB. Important Note: Information is not shown 
on the screen of the C8000. 

Duration: 30 seconds to 2 minutes, depending of the battery’s 
communication rate. 

Charge-1 Function: For SM-Bus batteries only.  Performs a SM-Bus “Level-1” 
charge.  This is similar to the standard “Charge” program, but also 
monitors the SM-Bus status and alarm flags during the charge. 

Sequence: A charge cycle is applied to the battery. No capacity 
readings are taken (capacity is only obtained if there is a discharge). 
Charge does not perform a full analysis; use the Auto or Prime 
program to fully diagnose a battery. 

Duration: Approximately 1.5 hours for NiCD and NiMH, 10 hours 
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for SLA, and 4 hours for Li-ion using default C-Codes. 

SMB-DChg Function: For SM-Bus batteries only.  This is similar to the standard 
“DchgOnly” program, but also monitors the SM-Bus status and alarm 
flags during the discharge. 

Sequence: The battery is discharged until its voltage reaches the END 

OF DISCHARGE setting in the C-Code. 

The battery capacity is measured during a discharge and if the battery 
is partially discharged, the capacity may be lower than the target 
capacity. This may give a Fail Code 115 or 116. The battery is not 
necessarily poor. 

Duration: Approximately 1 hour for a NiCD battery discharged at 
default C-Code settings. 

FG-Calibrate Function: For SM-Bus batteries only.  This program cycles the battery 
to allow the SM-Bus fuel gauge to be recalibrated. 

Sequence: Performs a full charge, full discharge, and a final full 
charge cycle.  The SM-Bus status and alarm flags are monitoring 
while the program is running. 

Duration: Approximately 2.5 to 10 hours for NiCD and NiMH, 20 to 
40 hours for SLA and 6 to 20 hours for Li-ion using default C-Codes. 
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3.10.2 A Custom-Program Example 

The following is a custom-program intended to test the 
performance of a solar-charged battery operating over a 10-day 
period. 

The battery charges for 3 hours at low current simulating early 
morning sun. 

The battery charges for 6 hours at a higher current simulating 
mid-day sun. 

The battery charges for 3 hours at low current simulating evening 
sun. 

The battery is discharged at a constant current to simulate energy 
consumption. 

The process is repeated 10 times. 
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Step 1 - charge at lower current for 3 hours 
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Step 2 - charge at higher current for 6 hours 

 

 

Step 3 - charge at lower current for 3 hours 
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Step 4 - discharge at constant current for 12 hours 

At the end of Step 4 there is a Loop Counter test.  If the loop 
counter is 5 or more the test finishes; otherwise, the test 
increments the loop counter and jumps to Step 1. 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  175 

3.10.3 A Custom-Program with Thermal Chamber Example 

The following is a custom-program intended to test the 
performance of a solar-charged battery operating over a 10-day 
period in an environment similar to the summer months. 

The battery is saturated at a temperature (13°C) equivalent to the 
early morning, before a sunrise for 4 hours and 30 minute. 

The environmental temperature is increased to 25°C over a 3-hour 
period, while the battery charges at low current simulating early 
morning sun. 

The battery is then allowed to rest for 30 minutes, simulating the 
sun being covered/blocked and no charge applied. 

The environmental temperature is then increased to 35°C over a 6-
hour period, while the battery charges at higher current 
simulating the mid-day sun. 

The battery is then allowed to rest for 30 minutes, simulating the 
sun being covered and no charge applied. 

The environmental temperature is decreased to 20°C over a 3-hour 
period, while the battery charges at low current simulating early 
evening sun. 

The battery is then allowed to rest for 30 minutes, simulating the 
low solar power and no charge applied. 

The environmental temperature is decreased to 13°C over a 6-hour 
period, while the battery is discharged at a constant current to 
simulate energy consumption, during the night  

The process is repeated 10 times. 
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Step 1 – Environment is configured to starting temperature 

 

Step 2 – Battery is saturated in the early morning environment 
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Step 3 – Environmental Temperature is increased over a 3-hour period. 

 

 

Step 4 - charge at lower current for 3 hours during the temperature rise 

 



 C8000 Battery Testing System User Manual 

178  3 Cadex BatteryLab 

 

Step 5 – Battery is Rested for 30 minutes 

 

Step 6 – Environmental temperature is increased 
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Step 7 – charge at high current for 6 hours during the temperature rise 

 

Step 8 – Battery is Rested for 30 minutes 
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Step 9 – Environmental temperature is decreased 

 

Step 10 – charge at low current for 3 hours during the temperature decrease. 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  181 

 

Step 11 – Battery is Rested for 30 minutes. 

 

Step 12 – Environmental temperature is decreased over a 6-hour period. 
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Step 13 – Battery is discharge for 6 hours, during the temperature fall. 

 

At the end of Step 13 there is a Loop Counter test.  If the loop 
counter is equivalent 9, the test finishes otherwise, the test 
increments the loop counter and jumps to Step 2. Step 1 is 
required, only, to setup the initial test environment. 
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3.10.4 Add a Program 

To add a custom program to BatteryLab, click Programs in the 
Database menu. The Program Database window appears. 

 

Next, click Add. T he Add Custom Program window appears. 
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The top portion of the Add Custom Program window shows the 
individual steps in the program. For each step, BatteryLab 
displays the step number, the action that will be performed, the 
amount of time the action will take to execute, the type of test to 
be performed and action to take if the test is True or False.  Note: 
If there is “No Test” the program will automatically go to the next 
step, on a successful completion of the action/step. 

 

 

When this program executes, the steps are performed in the order 
listed. To change the order of the steps, select the step and click 
Move Up or Move Down. The steps will be rearranged 
accordingly. 

3.10.4.1 Add a Step to a Program 
To add a step to a program, click Add. The No Action step appears 
in the Program Editor window. 
 

 

Click the Action field to see the list of possible actions for this step. 
Some actions require additional information, as shown in the 
following table.  
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Action Parameter Tables 

Available Actions 

Action Required Action Sub-

parameters 

Description of the Action 

Finished - No action None On completion of service, stop all monitoring. Available 

for Step zero (0) only 

Finished – Standby None On completion of service, monitor the battery. Take 

action when monitor conditions are met. NIXX – 

perform trickle charge as per C-code. 

SLA – perform float charge will occur when the battery 

voltage drops below the Standby voltage parameter in 

the C-code. The current applied shall equal the current 

termination point (CTP) in the C-code. 

All Chemistries – Recharges the battery if the voltage 

level drops below the standby voltage of the c-code. 

Available for Step zero (0) only 

Discharge Type:  

Allows the selection of the 

type of discharge to perform. 

Current: 

Discharges at a specified 

current.  Specify the current. 

C-Rate: 

Discharges at the rate 

indicated. 

Watt: 

Discharges at a constant 

power. 

Waveform: 

Performs a discharge as 

specified by the waveform 

parameters.  

Custom –Scaled: 

Scales the waveforms 

greatest amplitude pulse to 

the Discharge Rate in the C-

C-code and if required further 

scales the waveform to be 

within the C8000 power 

requirements.  

Custom –Absolute: 

Runs the Waveform as 

Performs a Discharge on the battery.  

Default: shall use the discharge current value in the C-

code to set the rate of discharge.  
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Action Required Action Sub-

parameters 

Description of the Action 

programmed (No Scaling) 

Charge Type: 

Allows the selection of the 

type of discharge to perform. 

Current: 

Discharges at a specified 

current.  Specify the current. 

C-Rate: 

Discharges at the rate 

indicated. 

Waveform: 

Performs a discharge as 

specified by the waveform 

parameters.  

Custom –Scaled: 

Scales the waveforms 

greatest amplitude pulse to 

the Charge Rate in the C-C-

code and if required further 

scales the waveform to be 

within the C8000 power 

requirements.  

.  

Custom –Absolute: 

Runs the Waveform as 

programmed (No Scaling) 

Performs a Charge on the battery.  

Default: shall use the charge current value in the C-code 

to set the rate of charge. 

Recondition None Performs a discharge at the trickle discharge rate, as per 

C-code, until the end of recondition voltage is reached. 

(As per C-code) 

For NiXX batteries only.  This step will be skipped if 

any other Chemistry is used. 

Trickle charge  Performs a charge at the rate specified in the C-code, 

until a termination condition is reached.  

Charge rate is specified in the C-code for NiXX batteries 

(Trickle Charge) and for all others charge termination 

point (CTP) current is used. 

Rest Duration: 

The length of time, the action 

is to be performed for. 

Does not apply current to a battery, but continues to 

monitor all conditions.  

Requirement:  

A Duration value is required. 

Impedance AC Impedance: 

Performs a resistance 

Calculates the resistance of a battery. 

Note: AC Impedance will only run if the program is 
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Action Required Action Sub-

parameters 

Description of the Action 

calculation using a 1Khz AC 

signwave. 

DC Impedance: 

Performs a resistance 

calculation using DC current 

as per IEC standards. 

conducted on channel 1. 

AuxOut only I/O ports must be enabled Similar to REST but allows the reconfiguring of the 

conditions of the Auxiliary ports. 

Boost None Will perform a charge to the battery for Duration of 3 

minutes, in an attempt to raise the battery voltage.  

This function will disable many of the 

safe guards. Use with EXTERME 

CAUTION. 

Pause None All functions are suspended until the user prompts to 

continue the service by selecting “RESUME”  

Discharge Playback Dchg Device 

Selection of the Device to 

perform a discharge 

Uses a playback waveform to perform a discharge on the 

C8000 or on a supported external load.  

Requires a supported Electronic DC Load 

See section 2.12.1.1 Programmable DC Electronic 
Loads 

 

Thermal Chamber Start: 

Indicates the starting 

temperature for the profile. 

End: 

Indicates the target 

temperature to be reached. 

Interval: 

Controls the temperature rise 

of the chamber. 

To calculate the temperature 

raise per minute.  

(End – Start)/interval 

(minutes) 

Deviation: 

The error allowed to the 

target temperature. 

Type: 

Selects the support thermal 

Requirement: 

Requires a supported Thermal Chamber 

See section 2.12.1.2 Thermal Chambers 

Controls the temperature environment of a supported 

thermal Chamber. 
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Action Required Action Sub-

parameters 

Description of the Action 

chambers 

Parallel Discharge Type:  

Allows the selection of the 

type of discharge to perform. 

Current: 

Discharges at a specified 

current. (The setting of  

”Default” will automatically 

double the Discharge Rate 

specified in the C-code.)  

C-Rate: 

Discharges at the rate 

indicated. 

Watt: 

Discharges at a constant 

power. 

Waveform: 

Performs a discharge as 

specified by the waveform 

parameters.  

Custom –Absolute: 

Runs the Waveform as 

programmed 

Accessory Requirement: 

See section Error! Reference source not found. Error! 

Reference source not found. 

Example of Current Rate set to Default: 

Standard Discharge: 10A/80W 

Parallel Discharge: 20A/160W 

 

 

Within each action step the program has the ability to run a test 
during the action step and take appropriate action based on the 
result of the test. The table below lists the Test Type available for 
each action step.  

Test Types Table 

Test Type Sub-Parameter Description of the Test Type Function 

No Test (Default) None No additional test is performed 

Capacity to 

Target 

None Compares the latest calculated Capacity value for the 

service against the "Target Capacity" value in a C-code.  

Note: If the service "Capacity Value" is "N/A" the test 

will not be performed. (Test is performed at the end of 

the step action) 

Capacity diff Requires capacity value. 

(Percentage) (Default: "0%") 

Compares the latest calculated Capacity value for the 

service against the previously calculated Capacity value 

within the same program.  Note: 1) A minimal of two 

"Discharge" actions are required within the same 

program.  2) If the service "Capacity Value" is "N/A" the 

test will not be performed. (Test is performed at the end 
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Test Type Sub-Parameter Description of the Test Type Function 

of the step action) 

Total Capacity Requires capacity value. 

(Percentage) (Default: "0%") 

Compares the latest calculated Capacity value for the 

service against the capacity value entered into the 

program.  Note: If the service "Capacity Value" is "N/A" 

the test will not be performed. (Test is performed at the 

end of the step action) 

Loop Counter Requires Counter Value parameter 

(Value)(Default "0") 

Compares the Loop Counter value against the parameter 

value entered in the program. (Test is performed at the 

end of the step action) 

Voltage Requires Voltage value parameter 

(V) (Default "0.000v) 

Compares the current "Voltage" reading from the 

channel to the entered voltage level in the program. 

Comparison is conducted every 100mS from the start of 

the program step. 

Current Requires Current value parameter 

(A) (Default "0.000A) 

Compares the current "Current" reading from the 

channel to the entered Current level in the program. 

Comparison is conducted every 100mS, 5 seconds after 

the start of the program step. 

Temperature Requires Temperature value 

parameter (°C) (Default "0°C) 

Compares the current "Temperature" reading from the 

channel to the entered Temperature value in the 

program. Comparison is conducted every 10s from the 

start of the program step. 

Temperature 

Increase 

Requires Temperature value 

parameter (°C) (Default "0°C) 

Compares the difference, between the current 

"Temperature" reading from the channel to the first 

temperature value taken at the being of the step, against 

the Temperature value in the program.  Comparison is 

conducted every 10s from the start of the program step. 

Impedance Requires resistance value stated in 

m-ohms (m-ohms) (Default "0-

ohms") 

Compares the Impedance value (generated by an 

OhmTest/Impedance step or by an automated Ohmtest) 

against the value entered in the program.  Comparison is 

conducted on the completion of the step action. 

Aux Port Requires Selection of input channel 

& type. Plus the Voltage value 

parameter (V) (Default "0.000v) for 

analog inputs and HIGH(1)/LOW(0) 

selection for digital inputs. 

Analog port selection; Compares the Voltage level from 

the specified Analog Port against the Voltage level 

specified with in the program; Digital Port Selection; 

Compares the Digital level against the value specified 

with in the program. Comparison is conducted every 

100mS from the start of the program step. 

Aux Port Diff Requires Selection of input channel 

& type. Plus the Voltage value 

parameter (V) (Default "0.000v) for 

analog inputs and HIGH(1)/LOW(0) 

selection for digital inputs. 

Analog port selection; Compares the difference, of two 

specified Analog ports, against the Voltage level value 

specified within the program step. Digital Port Selection; 

is ON (1) or OFF(0) 

Variable Test Requires; Selection of possible five 

numerical counters (A~E) and a 

numerical value. (Default: "0") 

Compares the selected Variable (Numerical Counter) 

against the enter numerical value in the step. 

Comparison is done of the step action 

Variable Diff Requires; Selection of two of the 

possible five numerical counters 

(A~E) and a numerical value. 

Compares the difference, between two selected variable 

counters, against the numeric value enter in the step. 

Comparison is done of the step action 
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Test Type Sub-Parameter Description of the Test Type Function 

(Default: "0") 

SM-Bus Voltage Requires Voltage value parameter 

(V) (Default "0.000v) 

Compares the Voltage level of a SM-bus register (0x15) 

against the Voltage level enter in the step. Comparison is 

conducted every 200mS, 5 seconds after the start of the 

program step. 

SM-Bus Current Requires Current value parameter 

(A) (Default "0.000A) 

Compares the Current reading of a SM-bus register 

(0x14) against the current level enter in the step. 

Comparison is conducted every 200mS, 5 seconds after 

the start of the program step. 

 

Once a Test Type is selected the action will need to be 
programmed with the comparator function to determine a “PASS” 
or “FAIL”. The available comparators available are: 

Comparator Table 

Comparator Description of the Comparator Function 

< Less than 

<= Less then or equal to 

= Equal to  

>= Greater than or equal to 

> Greater than 

<> Not Equal to 

 

The selected Test Type with the selected comparator can be 
viewed in equation format in the main window under the “Test” 
column. 

The following actions are available for selection based on a 
“TRUE” or “FALSE” action. 

TRUE/FALSE action table 

True/False Action Required Parameter Description of the Program Parameter 

Goto Next Step None Automatically proceed to the next step. If the current 

step is the last step in the program, this action will return 

to step zero (0). 

Goto Step xx (1-99) Step number Automatically proceeds to the programmed step, in the 

parameter. This action can not goto step zero (0) 

Resets loop counter, goto next 

step 

None Resets the counter to zero (0) and will proceed to the 

next step. If the current step is the last step in the 

program, this action will return to step zero (0). 

Inc loop counter, goto xx (1-99) Step Number Automatically increments the internal counter by one (1) 

and proceeds to the programmed step, in the parameter. 
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True/False Action Required Parameter Description of the Program Parameter 

This action can not goto step zero (0) 

Finished Pass None (Default for 

True Action) 

Successfully completes the test with no warning. 

Finished Fail None (Default for 

False action) 

Successfully Fails the test with any warning codes that 

where generated. (Software Failure) 

Fatal None Hard Failure. System will immediately stop all services 

and “FAIL” the service  

No Action None System will continue to run the service as is and will not 

trigger any additional steps of functions until the step 

has completed normally 

Inc A, goto next step None Increments the secondary counter “A” by one and if the 

current step is the last step in the program, this action 

will return to step zero (0). 

Inc B, goto next step None Increments the secondary counter “B” by one and If the 

current step is the last step in the program, this action 

will return to step zero (0). 

Inc C, goto next step None Increments the secondary counter “C” by one and If the 

current step is the last step in the program, this action 

will return to step zero (0). 

Inc D, goto next step None Increments the secondary counter “D” by one and If the 

current step is the last step in the program, this action 

will return to step zero (0). 

Inc E, goto next step None Increments the secondary counter “E” by one and If the 

current step is the last step in the program, this action 

will return to step zero (0). 

Reset A, goto next step None Resets the secondary counter “A” to zero (0) and 

proceeds to the next step. This action can not goto step 

zero (0) 

Reset B, goto next step None Resets the secondary counter “B” to zero (0) and 

proceeds to the next step. This action can not goto step 

zero (0) 

Reset C, goto next step None Resets the secondary counter “C” to zero (0) and 

proceeds to the next step. This action can not goto step 

zero (0) 

Reset D, goto next step None Resets the secondary counter “D” to zero (0) and 

proceeds to the next step. This action can not goto step 

zero (0) 

Reset E, goto next step None Resets the secondary counter “E” to zero (0) and 

proceeds to the next step. This action can not goto step 

zero (0) 

 

Each action step with in the program is capable of changing the 
state of the Analog/Digital Output Ports. For these options to be 
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available the Ports must be configured as Output. (See Program 

Parameter Table)  

The Digital Outputs can be set as either high, by placing a check 
mark in the box beside the corresponding Digital Output port and 
set low (Default) by clearing the check mark. 

 

The Analog Output can be set to an output a voltage level 
changing the percentage value for the corresponding Analog 
Output Port. A value of 0% will output zero (0) volts while a value 
of 100% will output a voltage of five (5) volts. 

Each step with in a program can be assigned a unique name, for 
identification purposes, by changing or adding text to the Step 

Description field. 

  

Once all the steps of the program have been added the 
information for the program may be entered. 

Click on the Program Parameter tab and enter information in to 
the fields. The fields’ functionalities are defined as shown in the 
following table. 

Program Parameter Table 

Field Default State Description of the Program Parameter 

Program Name Blank The name of the program (This is a required field) 

Active Checked Allows the program to be used in a service. 

Removing the check will remove this program from the 

available list when attempting to service a battery. 

Smart Battery Unchecked Enables the program to be used with SM-BUS C-codes 

Term. Data Sample Rate Default, 500 times 

per second (2ms) 

The C8000 will automatically save the last 500 data 

points for the Voltage and Current at a high capture rate. 

This parameter will program the rate in which the C8000 

sample the last 500 points. 

Options available: 

Default, 500 times per second (2ms) 

100 times per second (10ms) 

50 times per second (20ms) 

25 times per second (40ms) 

20 times per second (50ms) 

10 times per second (100ms) 

5 times per second (200ms) 

Comment 1 Blank Comment Field that can be used to store information 
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Field Default State Description of the Program Parameter 

about the program. 

Comment 2 Blank Comment Field that can be used to store information 

about the program. 

Custom waveform Blank Attaches a custom waveform to the program. The 

program will run the indicated waveform, for the steps 

that indicate Custom waveform. 

Dchg Playback waveform Blank Attaches a Playback waveform to the program. This 

waveform is only used if a Discharge Playback action 

step is with in a program. 

Analog Input/Output Unchecked Enables any of the Analog input or output port of the 

C8000. Check mark the Analog ports to enable 

The Analog output ports have a 0~5 volt range and the 

output value is controlled in the Action Parameter Tab. 

Analog Input Range 0~5v Configures the input voltage range for the associated 

Analog Port. 

Options available: 

0~5 volts 

0~10 volts 

0~15 volts 

Digital Input/Output Off Configures the associated Digital Port as digital input or 

a digital output. 

Options available: 

Off 

Input 

Output 

 

3.10.4.2 Remove a Step from a Program 
To delete a step, select the step and click Delete. The step is 
removed from the list. 

3.10.4.3 Copy a Step in a Program 
To create a duplicate step, select the step to copy and click Copy. 
The new step appears in the list. 

3.10.4.4 Save the Custom Program 
Click OK to save the program. 
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3.10.5 Add Folders 

Programs can be organized, or grouped, into folders. A folder is a 
directory on your hard drive. A folder icon appears adjacent to the 
folder’s name to identify it as a folder; a text document icon 
adjacent to the program’s name can identify programs. Only one 
level of folders is permitted. 

1. From the Database menu, click Programs. The Program 

Database window appears. 
 

 

2. Click Add Folder. The Add Folder window appears. 
 

 
 

3. In the Folder Name field, type a name for this folder. 

4. Click OK to create the folder. The folder’s name appears in 
the Program Database window.  
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5. To view the contents of a folder, double-click the folder’s 
name. The programs stored in that folder appear in the 
Program Database window. 

  

3.10.6 Edit a Program 

BatteryLab allows edits to custom programs created by the user. 
System and SM-Bus programs cannot be edited or copied to create 
a program. 

1. From the Database menu, click Programs. The Program 

Database window appears. 
 

 

2. Select the program to edit. 

3. Click Edit. If database security is enabled, the Password 
window appears. 

4. Enter your password and click OK. The Program Editor 
window appears. 
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5. Select the step to change. Make the required changes to the 
record. 

6. Click OK. 

3.10.7 Delete a Program 

BatteryLab allows deletion of a custom program provided there 
are no running tests using this program. Historical data related to 
this program is retained for display and reporting operations. 

Note: it is not possible to delete factory programs. 

To delete a program from BatteryLab: 

1. From the Database menu, click Programs. The Program 

Database window appears. 
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2. Select the program to delete. Click Delete. If database 
security is enabled, the Password window appears. 
 

 
 

3. Enter your password and click OK. The Delete Options 
window appears. Select the Delete From BatteryLab check 
box. Click OK. The Confirm window appears. 
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4. Click Yes. 

To delete a program from the connected C8000: 

1. From the Database menu, click Programs. The Program 

Database window appears. 
 

 

2. Select the program to delete. Click Delete. If database 
security is enabled, the Password window appears. 
 

 
 

3. Enter your password and click OK. The Delete Options 
window appears. Select the Delete From Connected C8000 
check box. Click OK. The Delete Custom Program 

window appears. 
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4. Select the custom program to delete and click Delete. 

5. The Confirm window appears. 
 

 
 

6. Click Yes. 
 

 

 

3.10.8 Copy a Program 

It is possible to create a program based on a custom program.  
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1. From the Database menu, click Programs. The Program 

Database window appears. 
 

 

2. Select the program to copy. 

3. Click Copy. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK. The Program Editor 
window appears. 
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5. Type a name for the new program in the Program Name 
field. 

6. Select the Active check box if the program is to be an active 
program. 

7. Type any notes in the Comment 1 and Comment 2 fields, as 
required. 

8. Select a waveform for the program. Click Browse. The 
Waveforms window appears. Select the waveform for this 
program and click OK. Note: specifying a custom 
waveform is optional. 

9. Click OK. The new program appears in the Program 

Database window. 
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3.10.9 Organize Programs in Folders 

Programs can be organized, or grouped, into folders. To move a 
program to a folder:  

1. From the Database menu, click Programs. The Program 
Database window appears. 
 

 

2. Select the program (identified by a text document icon) to 
move to a folder. 

3. Click Move To. The Target Folder window appears. 
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4. Double-click the name of the folder to move the program 
to. The target folder appears. 

 

5. Click OK. The program is moved to the target folder. 

 

3.10.10 Import a Program 

To import a program from a file: 

1. From the Database menu, click Programs. The Program 
Database window appears. 
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2. Click Import. If database security is enabled, the Password 
window appears. 
 

 
 

3. Enter your password and click OK. The Import Program 
window appears. 
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4. Click Browse. The Open window appears. 
 

 

5. Select the file to import. 

6. Click Open. Note that a single file can contain multiple 
programs. The Information window appears with the 
number of programs imported. (If the program already 
exists, click Cancel to terminate the import process 
altogether, or OK to overwrite the existing program. 
Alternatively, specify a different name for the program 
and click OK to import it.) 

To import a program from the C8000: 

1. From the Database menu, click Programs. The Program 

Database window appears. 
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2. Click Import. The Import Program window appears. 
 

 

3. Click From the C8000.  Select a C8000 first from the list 
(C800s are listed by their IP addresses. Select the program 
to import and click Import. The Import Program window 
shows the programs. 
 

 

4. Select the program to import. 

5. Click Import.  The Information window appears with the 
number of files imported. 
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3.10.11 Export a Program 

To export a program to a file: 

1. From the Database menu, click Programs. The Program 

Database window appears. 
 

 

2. Select the program to export. 

3. Click Export. The Export a Program window appears. 
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Click Browse. The Save As window appears. 
 

 

4. Type a name for the export file in the File Name field.  

5. Click Save. Note that multiple programs can be exported 
to a single file. The Information window appears with the 
number of programs exported to the file. 
 

 

6. Click OK. 

 
To export a program to the C8000: 

1. From the Database menu, click Programs. The Program 
Database window appears. 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  209 

 

 

2. Select the program to export. 

3. Click Export. The Export a Program window appears. 
 

 

4. Click To the C8000. The Export Program window updates 
with a list of connected C8000s. 
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5. Click the C8000 to export programs for. The window lists 
the programs found on this C8000. 

6. Click Export. Note that multiple programs can be exported 
to a single file. The Information window appears with the 
number of program files exported. 
 

3.10.12 Search for a Program 

The BatteryLab database may contain many programs. To find a 
specific program, click the Search By Program field to move the 
cursor to that field.  

 

Next, type the first one or two characters of the program to find. 
As BatteryLab locates the partial program, it will highlight the 
corresponding program’s name in the Program Database 
window. 

3.10.13 Sort Programs and Folders 

The BatteryLab database may contain many programs and 
folders. To sort the programs and folders in ascending order click 
the Name column the Program Database window. Click the Name 
column a second time to sort the programs and folders in 
descending order.  
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3.11  Load Capture 
Load Capture Unit required (see 2.1.3.4 Load Capture Unit (LCU)) 

To begin load capture: 

1. Plug in the LCU on Channel 1 only. The Test Battery 
caption now changes to Start Capture when the active 
selected channel is connected to the LCU. The channel’s 
status now reads LCU STARTUP. 
 

 

2. Click Start Capture to start the load capture, or right-click 
the LCU’s entry to see the Capture menu and click Start 

Capture. 
 

  
 
Note: The following table describes the entries in the 
Capture menu. 
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Menu Item Description 

Start Capture Starts a load capture. 

Load Capture Set the in-circuit zero offset  

(Current Only):  

Perform zero offset – Set the zero offset 
to the current level being measured.  

Reset Zero offset – Reset the zero offset 
to the default value, determined when 
the LCU was connected to the C8000. 

Reset Capture 
Unit 

Resets the LCU to its StartUp state. 

Note: This functional will perform a 
Zero offset function for both the 
current and voltage inputs. 

 

3. The Load Capture Test window appears. 
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4. Click the eclipse (“…”) button next to the Search Program 
field to open the Program Editor for Load Capture 
programs. All pre-defined programs will appear in a 
window and the active program parameters will be 
populated in the Test Parameters section.   

 The Test Parameters can be modified and will be saved 
on selecting “OK” 

5. Click OK. The capture begins. 

6. Once the program is loaded, the Channel status reads LCU 
ARMED until the trigger condition is met. When 
capturing, the status reads LCU CAPTURING and FINISH 
will appear on completion. A window appears indicating 
the status and the Test ID that has been attached to the 
captured waveform. 

a. If no trigger condition is present the LCU will 
begin capturing immediately. Note: There is an 
approximate 3 ~5 second delay between the 
program begin initialized and the C8000 begin the 
capture. This is normal operation while the Load 
Capture Unit is configured for use. 

7. To view the captured waveform, click Waveforms in the 
Database menu. The Waveform Database window 
appears. 

8. Click the Load Capture folder and open the corresponding 
waveform ID indicated in the pop-up window. 
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The following table describes the fields in the Load Capture Test 
window. (Page 192) 

Field Description 

No. of Samples The number of sample points to be captured 
(minimum=10, maximum=500). 

Rate The sample rate for each point – stated in milli-
seconds with a range of 0.5ms to 30000ms. 

Total Duration The total capture period. 

Trigger Type The method of triggering the capture: 

No trigger: No trigger is defined. The capture starts 
immediately on completing initializing. 

Current limit: A current target level is required to 
start the capture (requires Trigger Method definition). 

Digital Logic: A digital level is required to start the 
capture (requires Trigger Method and Trigger Port 
definition). 

Analog Input Port 4: An analog voltage level is 
required to start the capture (requires Trigger Method 
and Range definition).  

Range: Defines the input voltage range of the analog 
port (selectable ranges: 0-5v, 0-10v, 0-15v). 

Trigger Method Defines the condition for the Trigger Type parameter: 

Trigger High: Reading must be higher than the point 
as defined by the Trigger Type parameter.  

Trigger Low: Reading must be lower than the point 
as defined by the Trigger Type parameter.  

Low-> High: Reading must transition from a lower to 
a higher reading than the target point defined by the 
Trigger Value parameter.  

High->Low: Reading must transition from a higher to 
a lower reading than the target point defined by the 
Trigger Value parameter. 

Note: Current is defined in Negative Logic. 

Trigger Value The trigger point. Defined as current (mA) for 
Current Limit and voltage (mV) for Analog Input Port 
4. 

Current Source & 
Range 

The input source that a current is to be captured on.  

In-circuit: Selects the internal capture circuit of the 
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LCU. 

Sub-Parameters: 

Range 0-10A: captures current range from 0-10A; 
Range: 0-100A: captures the current range from 0-
100A. 

Current Probe: Captures current readings input from 
an external probe. (Scale 1mV to 1A) 

Trigger Port The sub-parameter for the Trigger Type parameter’s 
Digital option that allows the selection of the digital 
input for triggering. 

Remarks Notes about the capture program. 

 

3.11.1 Load Capture Programs Database 

The Load Capture Program window displays a list of load capture 
programs in the BatteryLab database. 

3.11.2 Add a Load Capture Program 

To add a load capture program to BatteryLab: 

1. From the Database menu, click Load Capture. The 
Program Database window appears. 
 

 

2. Click Add. The Load Capture Program Editor window 
appears. 
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(See Page 194 for Test Parameter definitions) 

3. Enter in the Test Parameters. 

a. If required, edit the Comment “x” fields in the 
Load Capture Program Editor window to describe 
the load capture program. 

4. Type a name for the load capture program in the Program 
Name field. 

5. Click OK. The new load capture program appears in the 
Program Database window.  

 

3.11.3 Edit a Load Capture Program 

To edit a load capture program: 

1. From the Database menu, click Load Capture. The 
Program Database window appears. 
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2. Select the load capture program to edit. 

3. Click Edit. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK.   The Load Capture 

Program Editor window appears. 
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5. Edit the information as required. 

6. Click OK. 

 

3.11.4 Delete a Load Capture Program 

To delete a load capture program from BatteryLab: 

1. From the Database menu, click Load Capture. The 
Program Database window appears. 
 

 

2. Select the load capture program to delete. 
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3. Click Delete. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK. The Confirm window 
appears. Click Yes to delete the load capture program. 
 

 
 

. 

3.11.5 Copy a Load Capture Program  

To create a load capture program based on an existing load 
capture program: 

1. From the Database menu, click Load Capture. The 
Program Database window appears. 
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2. Select the load capture program to copy. 

3. Click Copy.  The Load Capture Program Editor window 
appears. 
 

 

4. Edit the settings for the load capture program, as required. 

5. Type a name for the new load capture program in the 
Program Name field. 

6. Click OK. 
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3.11.6 Import a Load Capture Program 

To import a load capture program from a file: 

1. From the Database menu, click Load Capture. The 
Program Database window appears. 
 

 

2. Click Import. The Import a Load Capture Program 
window appears. 
 

 



 C8000 Battery Testing System User Manual 

222  3 Cadex BatteryLab 

3. Click Browse. The Open window appears. 
 

 

4. Select the file to import and click Open. The Information 
window appears, showing the number of load capture 
programs imported. (If the load capture program already 
exists, click Cancel to terminate the import process 
altogether, or OK to overwrite the existing load capture 
program. Alternatively, specify a different name for the 
load capture program and click OK to import it). 

 

3.11.7 Export a Load Capture Program 

To export load capture programs to a file: 

1. From the Database menu, click Load Capture. The 
Programs Database window appears. 
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2. Select the load capture program to export. Note that 
multiple load capture programs can be exported to the 
same file. 

3. Click Export. The Export a Load Capture Program 
window appears. 
 

 

4. Click Browse. The Save As window appears. 
 

 

5. Type a name for the file in the File name field. 

6. Click Save. All selected load capture programs are saved 
to the file. An Information window appears with the 
number of load capture programs exported. (If the file 
already exists, specify a new filename or opt to overwrite 
the existing file – click OK.) 



 C8000 Battery Testing System User Manual 

224  3 Cadex BatteryLab 

 

 

7. Click OK. 

3.11.8 Search for a Load Capture Program 

The BatteryLab database may contain hundreds, or even 
thousands, of load capture programs. To find a load capture 
program, click the Search By Program field to move the cursor to 
that field.  

 

Next, type the first one or two characters of the load capture 
program’s name to find. As BatteryLab locates the partial load 
capture program, it will highlight the corresponding c-code in the 
Program Database window. 

3.11.9 Sort the Load Capture Programs 

The BatteryLab database may contain many load capture 
programs. To sort the load capture programs in ascending order, 
click the Name column in the Program Database window. Click 
the column a second time to sort the load capture programs in 
descending order. 

 

 

3.12 Waveforms 
The Waveforms window lists the custom waveforms available to 
the C8000. For each waveform, the Waveforms Database window 
shows the waveform’s name. A waveform contains one or more 
steps that will be executed in the order specified and will be 
continuously repeated until a program termination has occurred.  

3.12.1 Sample Custom Waveform 

The following shows how to create a custom waveform for one 
variable of GSM pulse.  In this waveform, we create a 2A load on 
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the battery for 550 us and a 200 mA load for 4 ms. First; select the 
device compatibility and the maximum steps. 
 

 

 

 

Step 5 - 550 us load @ 2A 
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Step 6 - 4 ms load @ 200 mA 

Once a GSM waveform is created, it can be used in a custom 
program. The following program will charge the battery, 
discharge the battery using a GSM waveform, and then charge the 
battery back up. 

 

 

Step 7- charge the battery 
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Step 8 - discharge using the GSM waveform 

 

 

Step 9 - Charge the battery back up 
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3.12.2 Add a Waveform 

To add a waveform to BatteryLab: 

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
 

 

2. Select the Custom, Load Capture, or Playback folder and 
click Add. The Add New Waveform window appears. 
 

 
Explanation: 

The Add New Waveform window is used to configure the 
waveform. This configuration allows the C8000 system to 
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recognize the type of waveform that is being created and the 
intended device where the waveform is to be used. 

Add New Waveform 

Device 
Compatibility 

The Device Compatibility option selects the 
device that the waveform is intended for use. 

Options available: 

C8000: supports both charge and discharge 
steps at 500us intervals. (48V/10A/100W) 

BK Precision supports only discharge steps at 
1ms intervals.  

Models Supported: 

8510 – (120V/120A/600W) 

8514 – (120V/240A/1200W) 

8518 – (60V/240A/1200W) 

8520 – (120V/240A/2400W) 

Note: If there is a charge step in a waveform 
and a BK device has been selected a five 
second “0” current step is required between 
the charge and discharge currents. All charge 
steps will be performed by the C8000. 

Maximum Steps This option sets the maximum number of steps 
that a waveform will support. 

50 steps with charge/discharge currents and 
multiple step durations.  

(Minimum 500us, Maximum 12hrs per step) 

500 steps with charge/discharge currents and 
only a single step duration value for all steps.  

(Minimum 500us, Maximum 12hrs) 

 

3. Click the DOWN ARROW in the Device Compatibility field and 
select the appropriate entry. 

4. Select the Maximum Steps for the new waveform. Click OK. 
The Waveform Editor window appears. 
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5. In the Waveform Name field, type a name for this 
waveform. 

6. In the Comment 1 and Comment 2 fields, type any notes 
about this waveform.  

7. Click OK. The new waveform appears in the Waveform 

Database window. 

3.12.2.1 Add a Step to a Waveform 
Note: A zero mA step is required when transitioning between 
charge/discharge and vice-versa. The last waveform step must 
respect this rule when it is compared with the first waveform step. 

1. Click Add in the Waveform Editor window. The new step 
appears in the Custom Waveform window. 

2. Change the values in the Duration and the Charge/Discharge 
Current fields, as needed. 

3.12.2.2 Remove a Step from a Waveform 
1. Select the step to delete. 

2. Click Delete. 

3.12.2.3 Copy a Step to Another Step in a Waveform 
1. Select the step to copy. 

2. Click Copy. 
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3.12.2.4 Move the Order of Steps in a Waveform 
To move the position of a step up or down in the waveform, click 
the field name and then click Move Up or Move Down. This sets 
the order that the steps will be executed in the waveform. 

3.12.3 Organize Waveforms in Folders 

Waveforms can be organized, or grouped, into folders. The 
Waveforms database is divided into three groups. A sub-group 
can be created within each of these three groups. The following 
table describes the Waveform groups: 

Group Name Description 

Custom All standard supported waveforms. Two types 
of waveforms are categorized as custom 
waveforms: 

Waveform #1: Maximum 50 steps with 
charge/discharge steps of any duration. 
(Minimum 500s, Maximum 12hrs) 

Waveform #2: Maximum 500 steps with 
charge/discharge steps with a single duration 
for each step. (Minimum 500us, Maximum 
12hrs) 

Load Capture Displays all captured waveforms from the 
accessory Load Capture Unit.  Waveforms 
cannot be manually added to this group. All 
other functions are available. 

Playback Discharge waveforms supported only. No 
charge pluses are allowed within this group. 
Only one type of waveform is categorized as 
playback waveforms: 

Waveform #1: Maximum 500 steps, with 
discharge steps with a single duration for each 
step. (Minimum 500us, Maximum 12hrs) 

 
To move a waveform to a folder:  

6. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
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7. Select the waveform (identified by a text document icon) to 
move to a folder. 

8. Click Move To. The Target Folder window appears. 
 

 

9. If necessary, create a folder by clicking Add Folder. 
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10. Double-click the name of the folder to move the waveform 
to. The target folder appears. 
 

 

11. Click OK. The waveform is moved to the target folder. 

Note: Waveforms cannot be moved from one group to another. 
The Load Capture Waveforms can be converted from a Load 
Capture waveform to a Playback Waveform. 

 

3.12.4 Edit a Waveform 

To change the information for a waveform: 

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
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2. Select the waveform to edit. 

3. Click Edit. The Waveform Editor window appears. 
 

 

4. Edit the information for the waveform, as required. 

5. Click OK. 

3.12.5 Delete a Waveform 

To delete a custom waveform:  
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1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
 

 

2. Select the waveform to delete. 

3. Click Delete. The Delete Options window appears. To 
delete the waveform from BatteryLab, select the Delete 
From BatteryLab check box. To delete the waveform from 
the connected C8000, select the Delete From Connected 
C8000 check box. Click OK.  

4. The Confirm window appears. 
 

 

5. Click Yes. 

3.12.6 Copy a Waveform 

To create a waveform from an existing waveform:  

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
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2. Select the waveform to copy. 

3. Click Copy. The Waveform Editor window appears. 
 

 

4. Type a name for the new waveform in the Waveform Name 
field. 

5. Type any notes in the Comment 1 and Comment 2 fields, as 
required. 

6. Add, delete, or copy steps for this waveform, as required. 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  237 

7. Click OK. The new waveform appears in the Waveform 

Database window. 

3.12.7 Import a Waveform 

To import a waveform from a file: 

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
 

 

2. Click Import. The Import a Waveform window appears. 
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3. Click Browse. The Open window appears. 
 

 

4. Select the waveform file to import and click Open. Note 
that a file may contain multiple waveforms. The 
Information window appears with the number of 
waveforms imported. (If the waveform already exists, click 
Cancel to terminate the import process altogether, or OK to 
overwrite the existing waveform. Alternatively, specify a 
different name for the waveform and click OK to import 
it.) 

To import a waveform from the C8000: 

Note: Load Capture Waveforms cannot be imported from a 
C8000. 

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
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2. Click Import. The Import a Waveform window appears. 
 

 

3. Click From the C8000.  The window updates with a list of 
connected C8000s and available waveforms for the selected 
C8000. 
 

 

4. Select the waveform to import. 

5. Click Import. The Information window appears with the 
number of waveform files imported. 
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3.12.8 Export a Waveform 

To export a waveform to a file: 

1. From the Database menu, click Waveforms. The 
Waveform Database window appears. 
 

 

2. Select the waveform to export. 

3. Click Export. The Available Waveforms for C8000 window 
appears. 
 



C8000 Battery Testing System User Manual  

3 Cadex BatteryLab  241 

 
 

4. Select the folder to export the waveforms to and click 
Export. 
 

 

5. Click Browse. The Save As window appears. 
 

 

6. Type a name for the export file in the File Name field. 

7. Click Save. The Information window appears with the 
number of waveforms exported to the file. 
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8. Click OK. 

 

To export a waveform to the C8000: 

  

1. From the Database menu, click Waveforms. The Waveform 

Database window appears. 
 

 

2. Select the waveform to export. 
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3. Click Export. The Export a Waveform window appears. 
 

 

4. Click To the C8000.  The window updates with a list of 
connected C8000s. 
 

 

5. Click Export. The Information window appears with the 
number of waveforms exported. 
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3.12.9 Search for a Waveform 

The BatteryLab database may contain many waveforms. To find a 
specific waveform, click the Search By Waveform field to move the 
cursor to that field.  

 

Next, type the first one or two characters of the waveform you 
want to find. As BatteryLab locates the partial waveform, it will 
highlight the corresponding waveform’s name in the Waveform 

Database window. 

3.12.10 Sort the Waveforms 

The BatteryLab database may contain many waveforms. To sort 
the waveforms in ascending order, click the Name column in the 
Waveform Database window. Click the column a second time to 
sort the waveforms in descending order. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.13  Sequences 
Programs may contain one or more program steps. The Sequence 
Database identifies the order the steps in a program will be 
executed. The Sequence Database window displays the program 
step’s name and any corresponding notes about the program step.  
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3.13.1 Add a Program Sequence 

1. From the Database menu, click Sequencer. The Sequence 

Database window appears.  
 

 

2. Click Add. The Add Program Sequence window appears. 
 

 

3. Select the program to add the program sequence to. Next, 
select the C-Code for that program.  

4. Type a name for the program sequence in the Sequence 
Name field. 
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5. Click the DOWN ARROW in the Battery ID field and select a 
battery ID. 

6. Type any remarks in the Notes field. 

7. Click OK. The new program sequence appears in the 
Sequence Database window. 
 

 

 

 

 

 

 

 

 

 

3.13.2 Edit a Program Sequence 

To edit a program sequence: 

1. From the Database menu, click Sequencer. The Sequence 

Database window appears. 

 

2. Select the program sequence to edit. 
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3. Click Edit. If database security is enabled, the Password 
window appears. 
 

 
 

 

 

 

 

4. Enter your password and click OK. The Modify Program 

Sequence window appears. 
 

 

5. Edit the information, as required. 
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6. Click OK. 

3.13.3 Delete a Program Sequence 

To delete a program sequence: 

1. From the Database menu, click Sequencer. The Sequence 

Database window appears. 

 

2. Select the program sequence to delete. 

3. Click Delete. If database security is enabled, the Password 
window appears. 
 

 
 

4. Enter your password and click OK. The Confirm window 
appears. Click Yes to delete the program sequence. 
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3.13.4 Copy a Program Sequence 

Copy a program sequence to create a program sequence: 

1. From the Database menu, click Sequencer. The Sequence 
Database window appears. 
 

 

2. Select the program sequence to copy. 

3. Click Copy.  If database security is enabled, the Password 
window appears. 
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4. Enter your password and click OK. The Copy Program 

Sequence window appears. 
 

 

5. In the Sequence Name field, type a name for the new 
sequence.   

6. Click OK. The new program sequence appears in the 
Sequence Database window. 
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3.13.5 Import a Program Sequence 

To import a program sequence from a file: 

1. From the Database menu, click Sequencer. The Sequence 

Database window appears. 
 

 

2. Click Import. If database security is enabled, the Password 
window appears. 
 

 
 

3. Enter your password and click OK. The Import a Sequence 

window appears.  
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4. Click Browse. The Open window appears. 
 

 

5. Select the file that contains the program sequence to 
import. 

6. Click Open. If the c-code specified in the to-be-imported 
file already exists, this error window will appear. Type a 
new name for the c-code and click OK. 
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7. An Information window appears with the number of 
program sequences imported. 
 

 

To import a program sequence from the C8000: 

1. From the Database menu, click Sequencer. The 
Sequence Database window appears. 
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2. Click Import. If database security is enabled, the 
Password window appears. 
 

 
 

3. Enter your password and click OK. The Import a 

Sequence window appears. 
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4. Click From the C8000. 

5. Select the C8000 that contains the program sequence to 
import. 

6. Click Import and click OK. 

3.13.6 Export a Program Sequence 

Note: Only one sequence program may be exported at a time. To 
export a program sequence to a file: 

1. From the Database menu, click Sequencer. The 
Sequence Database window appears. 



 C8000 Battery Testing System User Manual 

256  3 Cadex BatteryLab 

 

 

2. Select the program sequence to export. Hold the CTRL 
key down to select multiple records. 

3. Click Export. The Export a Sequence window appears. 
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4. Click Browse. The Save As window appears. 
 

 

5. Type a name for the export file in the File name field. 

6. Click Save. 

7. An Information window appears with the number of 
program sequences exported. 
 

 

To export a program sequence to the C8000: 

1. From the Database menu, click Sequencer. The 
Sequence Database window appears. 
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2. Select the program sequence to export. Hold the CTRL 
key down to select multiple records. 

3. Click Export. The Export a Schedule window appears. 
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4. Click To the C8000. A list of connected C8000s appears. 
 

 

5. Click Export.  

3.13.7 Search for a Program Sequence 

The BatteryLab database may contain many program sequences. 
To find a program sequence, click the Search By Name field to 
move the cursor to that field.  

 

Next, type the first one or two characters of the program 
sequence’s name to find. As BatteryLab locates the partial name, it 
will highlight the corresponding sequence in the Sequence 

Database window. 

 

3.13.8 Sort Program Sequences 

The BatteryLab database may contain many program sequences. 
To sort the program sequences in ascending order, click the Name 
column in the Sequence Database window. Click the column a 
second time to sort the program sequences in descending order. 
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3.14 System Updates 

3.14.1 Firmware Information 

 Caution 

Before updating the firmware on the C8000s, 
ensure that test results and calibration data have 
been backed up from the C8000s to the PC. 

 

From the Tools menu you can view the System Update window, 
which shows you:  

 The Device List displays each connected C8000 with its 
associated firmware version’s IP address and status. 

 The System Update file location.  The Browse button will 
accept only valid C8000 System Update (*.c8u) files to 
enable the Update button. 

3.14.1.1 Update the Firmware on the C8000s 

 Caution 

Do not interrupt the update process once it has 
started.  The C8000s could be rendered non-
operational if the update process does not 
complete properly. 

To update the firmware on C8000s connected to the network:  

1. From the Tools menu, click System Update. The System 

Update window appears. 
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Ensure that all connected C8000s are powered on and are 
properly configured. 

2. Click Firmware. 

3. Select the check box for each C8000 to update. 

Note: Only a single C8000 can be updated at any given time. 

4. Click Browse to find the folder containing the new 
firmware file on your hard drive.  (The firmware files have 
a .c8u extension; you can obtain these from Cadex 
Electronics Inc.). 

5. Select the new firmware file. 

6. Click Update to send the firmware to the connected 
C8000s.  

 
Battery Lab must remain open while the C8000s are updated, 
which takes several minutes.  When the update is complete, the 
Status will show Update Completed. 

The Update button is enabled only if the selected file (with a .c8u 
extension) is valid. 
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3.14.1.2 Update the Calibration Data  
To update the calibration data on the C8000s: 

1. From the Tools menu, click System Update. The System 

Update window appears. 

2. Click Calibration Data. 
 

 

3. To back up the calibration data, click Backup Calibration 
Data. 

4. To restore calibration data, click Restore Calibration Data. 
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3.15  Troubleshooting 

3.15.1.1 Communication Issues 
Frequent disconnections between the PC and a C8000 can be 
caused by a duplicated TCP/IP address on the network.  

1. From the C8000 menu, select Data Monitor and verify that 
the C8000 and BatteryLab are communicating.  If nothing is 
displayed, they are not communicating.  You can copy and 
paste the information in the Data Monitor to an e-mail if 
you need to share the information with your network 
administrator. 

2. Ensure that the C8000 is properly connected to the 
network.  At the back of the C8000, the Ethernet port 
should have a solid light and a blinking light.  The solid 
light indicates that the unit is connected to the network and 
the blinking light indicates that data is being transferred 
over the network.  (The LED is beside the Ethernet port on 
the back of the C8000). 

3. Your network administrator can also ping (see Ping the 
Network to Check for Available IP Address) the C8000 to 
make sure it is communicating properly with the network. 

4. If the C8000 is disconnecting and connecting frequently, 
resolve IP Address conflicts with other devices (duplicated 
IP address) on the network. 

3.15.1.2 Frozen Keyboard and LCD Display 
The keyboard and display on the C8000 may stop functioning if 
the Ethernet cable is disconnected and reconnected from the PC, 
the local network hub, or the C8000 while the C8000 is on. To 
solve this problem, recycle the power on the C8000.  

3.15.1.3 Check IP Addresses 
See Add IP Addresses for C8000s on Your PC. 

Check for duplication in the IP Address Manager window. 

Review the topics under TCP/IP Settings. 

3.15.1.4 DAO Error 
If a DAO (Data Access Object) error message appears, it results 
from one of two cases:  

 A corrupt BatteryLab database; or  

 Folder permissions for \batlab have been reset to their 
defaults and are preventing users from accessing the 
database. 
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3.15.1.5 Corrupt Database 
If the BatteryLab database is corrupt, you can restore the database 
from a recent backup of the files from the \batlab folder.   

For information about restoring files backed up using “Windows 
Backup” in Windows XP, use Start > Help and use the Help 

Index to find topics under restoring backed up data. 

If your System Administrator cannot solve the problem, contact 
Cadex Customer Support for help in repairing the database.  

 

3.15.1.6 Folder Access Permissions 
BatteryLab Setup sets the required folder permissions during 
installation. However, if the computers in your network have 
Rights Management controlled from a central server, then you 
may notice folder permissions for the \Batlab folder being reset, 
causing BatteryLab to report a DAO error. 

If a centralized server manages folder permissions on your 
network, then you have one of two options to resolve Folder 
Access Permission issues: 

1. Uninstall BatteryLab from the default install location 
(C:\Program Files\batlab) and re-install to C:\batlab.  
Make a copy of the C:\Program Files\batlab\db folder 
prior to un-installation so that the DB folder can be 
restored from the copy after re-installation. 

2. Make a request of your Systems Administrator to 
configure the central server's rights management policies 
to allow default folder permissions on the batlab folder 
(C:\Program Files\batlab) on your computer as described 
in Set Access Permissions in Windows XP. 

 

3.15.1.7 Set Access Permissions in Windows XP 
To set access permissions in Windows XP: 

1. Log-on as Administrator. 

2. Navigate (using Windows Explorer or My Computer) to 
the \Batlab folder. 

3. Right-click the Db folder and choose Properties. 

4. Click the Security tab. 

5. Choose the User Group and select the Full Control check 
box. 
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6. Clear the Allow inheritable permissions from parent to 
propagate this object check box. 

7. Click Copy. 

8. Click OK. 

If the Security tab is not displayed, use the following method: 

1. Double-click My Documents on the desktop. 

2. From the Tools menu, choose Folder Options…. 

3. Choose the View page. 

4. Clear the Use simple file sharing (recommended) option and 
click OK. 

5. Type C:\Program Files\Batlab for My Documents address 
and press Enter. 

6. Right-click the Db folder and choose Properties. 

7. Click the Security tab. 

8. Choose users in the group or user names list. 

9. Select the Full Control Allow check box. 

10. Click Advanced. 

11. Clear the Inherit from parent… check box and choose Copy. 

12. Click OK to close the dialog box. 

13. Double-click My Documents on the desktop. 

14. From the Tools menu, choose Folder Options…. 

15. Choose the View page. 

16. Select the Use simple file sharing (recommended) option and 
click OK. 

3.15.1.8 Error Writing to the Log File 
While using BatteryLab, an error may occur when the software 
writes to the log file.  In this case, the permissions to the 
\Batlab\Temp folder have been reset.  You need to set the 
appropriate permissions to this folder – follow the same steps on 
the Temp folder as was done in Set Access Permissions in Windows 
XP.  
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4 C-Code Parameters 

The following table lists the parameters for c-codes. Note that not all parameters are used by all 
chemistries. 

Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Chemistry 
Battery 

Chemistry 
All N/A N/A N/A ---- N/A 0x22 

Any change to 

this field to 

affect all other 

fields 

Number of 

Cells 
Cells All 1 

NiMH = 30 

N/A ----  N/A No 

Maximum 

Value is 

Chemistry 

dependent  

(Any change to 

this field to 

affect all other 

fields) 

NiCD = 30 

SLA = 18 

Li = 10 

Primary = 30 

LiPh = 10 

Rating 

Capacity rating 

of the battery 

stated in mAh 

All 0.050 1000 Ah ---- None 0x18 

Any change to 

this field to 

affect all other 

fields 

Minimal 

Safe 

Operating 

The minimal 

Voltage allowed 

for the battery. 

NiMH & 

NiCD 
0.320 * cells 

<MaxVoltage V ---- 
---- 

No ---- 

Li, SLA 1.000 * cells ---- 
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Voltage LiPh 0.750 * cells ---- 

Primary 0.320 * cells ---- 

Maximum 

Safe 

Operating 

Voltage 

The maximum 

Voltage allowed 

for the battery 

NiMH & 

NiCD 

---- 

1.800 * cells  

V 

45.000 

---- No 

Primary 

Chemistry has 

two Maximum 

voltages. The 

selection 

depends on the 

Nominal 

voltage 

selected by the 

user.  

SLA  2.800 * cells 

48.048 

Li 4.500 * cells 

LiPh 4.200 * cells 

Primary (1.2v 

nominal)  
1.800 * cells  

Primary (3v 

nominal) 
4.500 * cells 

Maximum 

Charge  

Maximum safe 

operating 

charge current 

NiMH & 

NiCD 
0.030 

10.000 A ---- ---- No ---- 
SLA, Li, 

LiPh 
0.055 

Maximum 

Discharge 

Maximum safe 

operating 

discharge 

current 

All 

Rating<=100ah 

0.030 
10.000 A ---- ---- No ---- 

Rating>100ah 

0.200 

Maximum 

Temperature 

Maximum safe 

operating 

temperature 

All ---- 105 °C ---- ---- No ---- 

Charge 

Current 
Charge rate 

NiMH & 

NiCD 

Rating<=100ah 

0.030 

= Maximum 

Charge 
A ---- 0.01~2C 0x14   
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Rating>100ah 

0.200 

SLA, Li, 

LiPh 

Rating<=100ah 

0.055 

Rating>100ah 

0.200 

Discharge 

Current 
Discharge rate All 

Rating<=100ah 

0.055 = Maximum 

Discharge 
A ---- 0.01~2C 0x14 ---- 

Rating>100ah 

0.200 

Low 

temperature 

Low 

temperature 

limit 

All -30 80 °C 
< Maximum 

Temperature 
0 ~ 10 No 

Zero value is 

valid 

High 

temperature 

High 

temperature 

limit 

All -10 

<(Maximum 

Temperature -

5) 

°C ---- 40 ~ 50 No 
Zero value is 

valid 

End of 

discharge 

End of 

discharge 

Voltage 

All > Minimal Voltage 

(NiCD, NiMH) 

< Maximum 

Voltage 

V ---- 

(NiCD, NiMH) 

0.76~1.12V*cell  

No ---- 

(SLA) 

1.36~1.95V*cell  

(SLA, Li, LiPh)  

< Charge 

Voltage 

(Li)                

2.30~ 3.20V*cell 

(LiPh) 

1.90~2.35V*cell 
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Rapid 

Charge 

Voltage 

Voltage 

requirement for 

full charge 

current 

All > Minimal Voltage 

(NiCD, NiMH) 

< Maximum 

Voltage 
V ---- ---- No ---- 

(SLA, Li, LiPh)  

< Charge 

Voltage 

Delta T 
Delta-T - °C per 

minute 
All 1 10 °C/Min ---- N/A No ---- 

Charge 

timeout 

Maximum 

duration of a 

charge before 

Failure 

All 0 300 C-Minute ---- ---- No 

Zero value is 

valid and 

indicates 

Parameter is 

"OFF" 

Discharge 

timeout 

Maximum 

duration of a 

Discharge 

before Failure 

All 0 300 C-Minute ---- ---- No 

Zero value is 

valid and 

indicates 

Parameter is 

"OFF" 

Target 

capacity 

Minimal 

Capacity 

Requirement of 

the battery type 

All 1 253 % ---- 70 ~ 90 No   

Automatic 

ohmtest 

Perform 

automatic 

ohmtest  

All N/A N/A ---- ---- ---- No (1=yes, 0=no) 

Milli-ohms 

The pass/fail 

point of the 

battery 

resistance 

All 0 1000 m-ohm ---- ---- No ---- 
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Trickle 

charge rate 
---- 

NiMH & 

NiCD 

Rating<=100ah 

0.055 <= Charge 

Current 
A ---- 0.01~0.05C No ---- 

Rating>100ah 

0.200 

Trickle 

discharge 

rate 

---- 
NiMH & 

NiCD 

Rating<=100ah 

0.055 <= Discharge 

Current 
A ---- 0.1~0.12C No 

Discharge Rate 

during a 

Recondition 

Action for 

NiXX  

Rating>100ah 

0.200 

End of 

recondition 
---- 

NiMH & 

NiCD 
> Minimal Voltage 

< End of 

discharge 
V ---- 0.40~0.80 V/cell No ---- 

Reverse 

load weight 
---- 

NiMH & 

NiCD 
0 20 % ---- 5% – 12% No 

Zero value is 

valid and 

indicates 

Direct Current 

Negative 

slope (delta-

V) 

Fall of the 

voltage for 

charge 

completion 

NiMH & 

NiCD 
0.001 0.200 x cells V ---- 

1mV ~ (Cell 

Count x64mV) 
No 

Negative Slope 

is used to 

determine full 

charge 

condition for 

NiCD or 

NiMH 

batteries. Full 

charge is 

determined by 

measuring the 

voltage drop 

that occurs 

once the 

battery reaches 

full-charge (the 

fast-charge is 
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

terminated 

when the 

voltage drop 

reaches the 

pre-set rate). 

Negative 

slope delay 

time 

Duration before 

a negative slope 

is detected. 

NiMH & 

NiCD 
0 20 C-Minute ---- ---- No 

Zero value is 

valid and 

indicates 

Parameter is 

"OFF" 

Standby 

voltage 
---- 

SLA, Li, 

LiPh 
> End of discharge 

<= Minimal 

Voltage 
V ---- 

(SLA) 

2.15~2.45V/cell 

No ---- 
(Li)  

3.90~4.35V/cell  

(LiPh) 

3.20~3.65V/cell 

Maximum 

charge 

voltage 

The charging 

voltage for 

constant voltage 

batteries 

SLA, Li, 

LiPh 
> Minimal Voltage 

< Maximum 

Voltage 
V 

Maximum charge 

voltage of 45V 

(SLA) 

2.15~2.60V/cell 

0x15 ---- 
(Li) 

3.90~4.35V/cell 

(LiPh) 

3.40~3.85V/cell 

Charge 

termination 

point 

Termination 

Point for 

Constant 

Voltage 

Batteries 

SLA, Li, 

LiPh 

Rating<=100ah 

0.055 <Charge 

Current by 

25mA 

A ---- 0.01~0.10C No ---- 
Rating>100ah 

0.200 

   

Code Options 
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Field  Description  
Compatible 

Chemistry  

Limits 

Units  
Additional 

requirements  
Typical Range(s) 

SM-BUS 

Imported 

Registers  Min. Max. Notes: 

Smart Battery When active the C-code is enabled for SM-BUS batteries and the following 

parameters become available: 

1) “Fully Charged” 2) Terminate Charge Alarm 3) Overcharge Alarm 4) Fully 

Discharged Alarm 5) Terminate Discharge 

Any of the above options can be set to one the following conditions; 

1) Finished –will terminate the program successfully on flag 

2) Fail –will terminate the program with a failure on flag 

3) Ignore – will ignore the flag. 

6) Over temperature Alarm options; 

1) Ignore – will ignore the flag. 

2) Retry x (1~10) – will wait for multiple flag conditions before terminating 

with a failure. (Over temperature Only). 

Use External Load Maximum 

Discharge Rate 

Alters the Maximum Discharge Rate field to use the device’s (specified in the 

program) Maximum current rate.  (Defaults to C8000 maximum of 10A). 
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5 Status Messages 

The following table lists status messages by status code. 

The second table lists status messages by detailed message.  That 
table describes the reason for each type of message and possible 
solutions.   

5.1 Status Messages Listed by Code 

Code Global Message Detailed Message 

0 NO BATTERY NO BATTERY IS CONNECTED TO THE CHANNEL TERMINAL 

1 RESERVED RESERVED 

2 CHARGE A CHARGE CURRENT IS BEING APPLIED 

3 TRKL CHRG A CHARGE CURRENT IS BEING APPLIED AT A RATE 

APPROXIMATELY EQUAL TO THE RATE OF SELF-CHARGE 

FOR NiXX, LEAD ACID BATTERIES, OR AT A RATE 

PROGRAMMED IN THE C-CODE FOR ALL BATTERY TYPES 

IF IN A LOW VOLTAGE CONDITION 

4 RECONDITIONING FOR NiXX BATTERIES ONLY. DISCHARGING BATTERY TO 

THE RECONDITION VOLTAGE PROGRAMMED IN THE C-

CODE 

5 STARTUP A BATTERY IS CONNECTED TO THE CHANNEL AND 

AWAITING SERVICING 

6 AUX I/O NO CURRENT IS ACTIVELY BEING APPLIED TO THE 

BATTERY THROUGH THE BATTERY PORTS. ONLY THE 

AUXILLIARY PORTS ARE ACTIVE 

7 DISCHARGE A DISCHARGE CURRENT IS BEING APPLIED TO THE 

CONNECTED BATTERY 

8 RESERVED RESERVED 

9 NO ACTION NO BATTERY SERVICING IS OCCURRING. PROGRAM IS 

WAITING FOR A TEST CONDITION TO BE MET. DEFAULT 

ACTION IS TO END STEP 

10 RESERVED RESERVED 

11 RESERVED RESERVED 
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12 COLD WAIT THE BATTERY TEMPERATURE BEING REPORTED VIA THE 

CHANNEL THERMISTOR IS BELOW THE “LOW 

TEMPERATURE LIMIT” (C-CODE) AND WAITING FOR THE 

TEMPERATURE TO RISE 5°C ABOVE, BEFORE CONTINUING 

SERVICING THE BATTERY. 

13 HOT WAIT THE BATTERY TEMPERATURE BEING REPORTED VIA THE 

CHANNEL THERMISTOR IS BELOW THE “HIGH 

TEMPERATURE LIMIT” (C-CODE) AND WAITING FOR THE 

TEMPERATURE TO FALL 5°C BELOW, BEFORE CONTINUING 

SERVICING THE BATTERY 

14 OVERHEAT THE BATTERY TEMPERATURE BEING REPORTED VIA THE 

CHANNEL THERMISTOR IS ABOVE THE “MAX 

TEMPERATURE LIMIT” (C-CODE. PROGRAM HAS 

TERMINATED 

15 FINISHED BATTERY SERVICE WAS COMPLETED SUCCESSFULLY AND 

CHANNEL HAS EITHER ENTERED STANDYBY OR HAS 

TERMIANTED THE SERVICE, AS DEFINED BY THE 

PROGRAM (AS DEFINED BY STEP “0” IN A PROGRAM) 

16 PROGRAM FAIL BATTERY SERVICE HAS FAILED 

17 REMOVED THE BATTERY HAS BEEN DISCONNECTED FROM THE 

BATTERY TERMINALS 

18 RESERVED RESERVED 

19 RESTING NO CURRENT IS ACTIVELY BEING APPLIED TO THE 

BATTERY THROUGH THE BATTERY PORTS 

20 INSERTED A BATTERY IS CONNECTED TO THE CHANNEL AND THE 

CHANNEL SCREEN IS ACTIVE AWAITING BATTERY 

PARAMETERS (C-Code) AND PROGRAM TO BEGIN 

SERVICING 

21 PAUSE THE BATTERY SERVICE HAS BEEN SUSPENDED AS 

DEFINED BY THE PROGRAM 

22 RESERVED RESERVED 

23 RESERVED RESERVED 

25 RESUME CYCLE RESUMED 

26 SUSPENDED THE BATTERY SERVICING HAS BEEN PLACED IN 

“SUSPEND” BY THE USER 

27 OHMTEST A DC RESISTANCE TEST IS BEING CONDUCTED 

28 IMPEDANCE AN AC RESISTANCE TEST IS BEING CONDUCTED 

29 LCU ARMED LOAD CAPTURE DEVICE IS ARMED 

30 CYCLE DONE THE CURRENT SERVICE CYCLE HAS BEEN COMPLETED 

31 DISCHARGE DONE THE CURRENT DISCHARGE SERVCICE HAS BEEN 

COMPLETED 

32 RESUMED THE BATTERY SERVICE HAS RESUMED AS DEFINED BY 

THE PROGRAM AFTER BEING EITHER PLACED IN 

”SUSPEND” BY THE USER OR PLACED IN “PAUSE” BY THE 

PROGRAM 

33 USER TIMEOUT THE SERVICE HAS TIMED-OUT AS DEFINED IN THE C-CODE 

34 BATTERY LAB SERVICE IS WAITING FOR COMMUNICATION WITH 

BATTERYLAB SOFTWARE 
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36 LCU READY LOAD CAPTURE UNIT IS CONNECTED AND FUNCTIONAL 

37 RESERVED RESERVED 

50 RESERVED RESERVED 

51 RESERVED RESERVED 

107 RESERVED RESERVED 

108 RESERVED RESERVED 

109 RESERVED RESERVED 

110 RESERVED RESERVED 

111 RESERVED RESERVED 

112 CELL MISMATCH CELLS ARE REACHING FULL CHARGE AT DIFFERENT TIMES 

SO THE NEGATIVE SLOPE IS NOT WELL DEFINED. THE 

PROGRAM PROCEEDS TO THE NEXT CYCLE 

113 PLATEAU TIMEOUT VOLTAGE LEVEL HAS REMAINED CONSTANT FOR AN 

EXTENDED TIME AND END-OF-CHARGE CONDITIONS 

CANNOT BE MET 

115 RESERVED RESERVED 

116 TARGET NOT MET THE “TARGET CAPACITY” VALUE IN THE C-CODE HAS NOT 

BEEN MET 

118 RESERVED RESERVED 

119 WEAK BATTERY BATTERY VOLTAGE FALLS BELOW THE END-OF-

DISCHARGE VOLTAGE (AS DEFINED IN THE C-CODE) 

DURING AN OHMTEST 

120 OVER VOLTAGE THE BATTERY VOLTAGE IS HIGHER THAN THE “MAX. SAFE 

OPERATING VOLTAGE” AS DEFINED IN THE C-CODE 

121 REVERSED BATTERY REVERSED 

122 SHORTED THE BATTERY VOLTAGE IS EITHER EXTREMELY LOW OR 

THE TERMINALS HAVE BEEN SHORTED 

123 L.V. TIMEOUT BATTERY VOLTAGE IS BELOW 800mVcell FOR 1c-minute 

(CHARGE CONDITION ONLY) 

124 L.V. TIMEOUT BATTERY VOLTAGE IS BELOW MINIMAL VOLTAGE LEVEL 

FOR 10C-MINUTE. (CHARGE CONDITION ONLY). NiXX – 

1144Mv, LA – 1990MV. LI-2000mV 

125 NO SLOPE NiXX ONLY. NO NEGATIVE SLOPE DETECTED 

126 LOW VOLTAGE ONE OR MORE CELLS WITHIN THE BATTERY PACK ARE 

LOWER THAN THE “MIN. SAFE OPERATING VOLTAGE” 

(DIVIDED BY THE NUMBER OF CELLS) AS DEFINED IN THE 

C-CODE 

127 LOW VOLTAGE BATTERY VOLTAGE IS BELOW  “MIN. SAFE OPERATING 

VOLTAGE” AS DEFINED IN THE C-CODE 

128 SOFT NiXX ONLY. BATTERY VOLTAGE HAS REACHED THE “MIN. 

SAFE OPERATING VOLTAGE” AS DEFINED IN THE C-CODE 

129 RESERVED RESERVED 

130 CURRENT RISE CURRENT IS INCREASING DURING A CONSTANT VOLTAGE 

131 IMPED. SKIPPED AC RESISTANCE TEST IS A STEP IN A PROGRAM AND HAS 

BEEN SKIPPED, AS AC RESISTANCE TESTING CAN ONLY BE 

PERFORMED ON CHANNEL 1 
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135 RESERVED RESERVED 

136 RESERVED RESERVED 

137 IMPED. SKIPPED AC IMPEDANCE TEST CAN BE PERFORMED ON CHANNEL 1 

ONLY 

139 Out-of-Range AC IMPEDANCE MEASUREMENT VALUE IS OUT OF 

MEASURABLE RANGE. 

142 DCHG TIMEOUT THE MAXIMUM DISCHARGE TIME HAS BEEN REACHED AS 

DEFINED IN THE C-CODE. “DISCHARGE TIMEOUT” 

144 CHRG TIMEOUT THE MAXIMUM CHARGE TIME HAS BEEN REACHED AS 

DEFINED IN THE C-CODE. “CHARGE TIMEOUT” 

146 RECOND TIMEOUT THE MAXIMUM DISCHARGE TIME HAS BEEN REACHED AS 

DEFINED IN THE C-CODE. “DISCHARGE TIMEOUT” (NiXX 

ONLY) 

150 BAD THERMISTOR UNABLE TO READ THE THERMISTOR ATTACHED TO THE 

POWER PORT CABLE 

152 TEMP RISE THE TEMPERATURE ROSE AT A RATE GREATER THAN 2°C 

WITHIN 30 SECONDS 

154 RESERVED RESERVED 

156 RESERVED RESERVED 

158 RESERVED RESERVED 

159 RESERVED RESERVED 

160 FUSE/DRIVER NO CURRENT OUTPUT HAS BEEN DETECTED FOR 1 

MINUTE 

161 NO_PARALLEL THE STEP “PARALLEL DISCHARGE” IS BEING ATTEMPTED 

TO BE RUN AND NO DUAL PORT CABLE IS ATTACHED TO 

THE UNIT 

162 DCHG MA LOW DISCHARGE CURRENT TARGET CANNOT BE MET, BUT A 

LOW RATE OF DISCHAGE WAS DETECTED 

164 CHRG MA LOW CHARGE CURRENT TARGET CANNOT BE MET, BUT A LOW 

RATE OF CHARGE HAS BEEN DETECTED 

170 CAL. FAILED AN ERROR WAS DETECTED WITH THE CALIBARATION 

INFORMATION 

175 UNDERCHARGED BATTERY IS UNDERCHARGED 

176 OVERCHARGED BATTERY IS OVERCHARGED 

177 UNDERCHARGED UNDERCHARGED 

178 OVERCHARGED OVERCHARGED 

188 ABORTED SERVICE INTERRUPTED 

190 AIN ERROR ANALOG PORT VOLTAGE READING OUT OF RANGE 

192 RESERVED RESERVED 

195  CAPACITY GOOD CAPACITY GOOD 

207 SYSTEM TEMP EXTERNAL SYSTEM TEMPERATURE IS ABOVE MAXIMUM 

SYSTEM TEMPERATURE 

208 RESERVED RESERVED 

209 CURRENT > MAX REQUESTED TARGET CURRENT LEVEL IS GREATER THAN 

THE SYSTEM MAXIMUM OUTPUT OF 10A PER CHANNEL 
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210 BAD WAVEFORM THE REQUESTED WAVEFORM EXCEEDS EITHER THE 

SYSTEM MAXIMUM LIMITS OR IS GREATER THAN THE 

BATTERY LIMIT AS DEFINED IN THE C-CODE 

211 WATTS > MAX THE REQUESTED POWER (WATTAGE) IS GREATER THAN 

THE SYSTEM MAXIMUM OF 100W (CHARGE)  / 80W 

(DISCHARGE) 

212 WAVEFORM FAULT ONLY ONE SUB-MILLISECOND WAVEFORM ALLOWED PER 

CHANNEL PAIR 

215 LOW_OFFSET_ERROR THE AUTOMATED CALIBRATION FOR THE LOAD CAPTURE 

UNIT IS OUT OF RANGE 

218 LCU_CHANNEL_1_ONLY LOAD CAPTURE DEVICE IS SUPPORTED ON CHANNEL 1 

ONLY 

219 LCU_CAPTURING LOAD CAPTURE UNIT IS CAPTURING DATA 

220 LOOP CNT TEST LOOP COUNTER TEST 

221 VOLTAGE TEST VOLTAGE TEST 

222 CURRENT TEST CURRENT TEST 

223 TEMP. TEST TEMPERATURE TEST 

224 DELTA-T TEST DELTA-TEMPERATURE TEST TEMPERATURE TEST 

225 IMPED. TEST IMPEDANCE/RESISTANCE TEST 

226 ERROR CODE TEST ERROR CODE TEST 

227 VARIABLE TEST VARIABLE TEST 

228 VARIABLE DIFF VARIABLE DIFFERENCE TEST 

229 AUX. PORT TEST AUX. PORT TEST 

230 AUX. DIFF TEST AUX. DIFFERENCE TEST 

231 LCU_REVERSED LOAD CAPTURE DEVICE IS DETECTING A REVERSE 

CURRENT FLOW 

232 LCU_CALIBRATING LOAD CAPTURE UNIT IS BEING CALIBRATED 

233 TEMPERATURE OF 

RANGE 

TEMPERATURE IS OUT-OF-MEASURABLE RANGE 

234 PARALLEL CHANNEL IS IN PARALLEL MODE 

236 NO PRIMARY CHG NO CHARGE ALLOWED ON PRIMARY CELLS 

255 OFFLINE DSP CONTROLLER IS “OFFLINE” 
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5.2 Status Messages Listed by Detailed Message 

Detailed 
Message 

Code Reason Solution 

BAD FUSE OR 

DRIVER 

160 The tester is not able to supply current to 

the battery through its current drivers.  Very 

low values of current (about 0 mA) are 

displayed on the tester and after 10 

seconds processing stops.  

Clean the battery and adapter contacts.  

Verify that mAh rating of the battery 

matches the C-code. 

Lower the Charge rate and the Trickle 

Charge rate in the C-code. 

The battery may be faulty. Try a different 

battery in the same channel. 

Check the circuit breakers on the tester.  

If all fails, contact Cadex for service. 

BATTERY 

INSERTED 

20 The C8000 detects a battery in an adapter. If message persists, press ESC. 

BATTERY OVER 

TEMP 

14 Battery has overheated during charge.  

Channel goes to Resting 00:00 (code 19) 

until the battery cools. 

Reduce the Charge rate in the C-code. 

BATTERY 

REMOVED 

17 Battery was removed when the program 

completed. 

This message appears briefly when the 

battery is removed.  If message persists, 

press ESC. 

SUSPEND 26 User suspended the test. Resume or wait for the condition that 

caused the "suspend" mode to be 

resolved. If this message persists, abort 

the test. If this condition cannot be 

resolved, contact Cadex for support. 

BATTERY 

REVERSED 

121 Reverse voltage detected on insertion. Battery may be connected backwards in 

the adapter.  Ensure that battery leads 

are firmly connected to the battery. 

BATTERY 

SHORTED 

122 Battery voltage is lower than (the voltage 

remains low). 

Ensure battery leads are firmly 

connected to the battery. 

Battery may be shorted. 

BATTERY TOO 

COLD 

12 Battery temperature is too cold when 

inserted.  The battery is trickle charged until 

temperature rises above minimum. (Only 

for NiCad / NiMH). 

Allow the battery to warm up.  

BATTERY TOO 

HOT 

13 Battery temperature is too hot when 

inserted.  The battery automatically starts 

processing when temperature drops 5°C 

below maximum value. 

Allow the battery to cool or use the tester 

in a cooler room.  
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OFFLINE 255 A system operation, such as a firmware 

upgrade, is being performed. 

 

CELL MISMATCH 112 Cells are reaching full charge at different 

times so the negative slope is not well 

defined.  The program proceeds to the next 

cycle. 

Wait until processing is complete. 

Battery is old or has been in storage.  

Operating time may be reduced.  Either 

monitor battery use or discard the 

battery. 

CHARGE 

CURRENT LOW 

164 Tester cannot provide the requested charge 

current 

See BAD FUSES OR DRIVER, Code 

160. 

CHARGE TIMEOUT 144 Charge time has exceeded the expected 

value for the battery.  

Tester may not have detected the end 

of charge conditions.  

CHARGING 2 Battery is being charged normally.  

RESUMED 32 Power resumed or the battery is re-inserted 

into the adapter. 

 

DISCHARGE 

CURRENT LOW 

162 The tester cannot discharge the battery.  See BAD FUSES OR DRIVER, Code 

160. 

DISCHARGE 

TIMEOUT 

142 Battery capacity has exceeded 250% of the 

rated capacity. 

 

DISCHARGING 7 Battery is being discharged normally. Program will continue when cycle has 

completed. 

HOT BATTERY ON 

TRICKLE CHARGE 

159 Battery temperature has exceeded its 

maximum setting after service has ended 

and battery was on trickle charge.  The 

trickle charge stops. 

Lower the room temperature. 

Verify that the C-Code is correct for the 

battery.  

Battery may be in poor condition. 

INSERT THE 

BATTERY 

8 Insert battery in the battery adapter.  

LOW VOLTAGE 

TIMEOUT1 

123 Battery voltage remains low after 

approximately one minute into the charge 

cycle. 

See BATTERY SHORTED, Code 122. 

LOW VOLTAGE 

TIMEOUT2 

124 Battery voltage remains low after 

approximately ten minutes into the charge 

cycle. 

See BATTERY SHORTED, Code 122. 

NO BATTERY 10 No battery is inserted, or the inserted battery 

is not detected. 

Check and clean all contacts.  

OFFLINE 255   

OVER VOLTAGE 120 Battery voltage is too high. Discard the battery. 

PAUSE 21 PROGRAM IS PAUSED (CUSTOM 

PROGRAM FUNCTION 0NLY). 

 

PLATEAU 

TIMEOUT 

113 Battery was fully charged before full-charge 

conditions were met.  For SLA and Li 

batteries only. 

The end-of-charge setting in the C-

code may have to be increased.  

Battery may be old and operating time 

less than manufacturer's specifications. 

PROCESS 

COMPLETE 

15 Current battery-service program is complete.  

PROGRAM HAS 

FAILED 

16 The program has produced an error.  The 

Next statement is not processed.  The 

program has been terminated. 

See the detailed display for the exact 

nature of battery failure.  
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READY 5 A battery has been inserted and is ready to 

be serviced. (Also, indicated as Startup). 

 

RECONDITIONING 4 Battery is being reconditioned. The program will proceed to the next 

step when recondition has completed. 

RESTING 19 Channel is in a rest period, as specified in 

the program. 

The program will proceed to the next 

step when resting period is complete. 

ABORTED 188 
An abort command has been issued.  Program 
terminated. 

The user issued an abort command. 

SYSTEM TEMP. 

HIGH: COOLING 

207 Service on all channels is temporarily 

suspended due to high temperature inside 

the tester. 

Service will resume in a few minutes, 

after the board has cooled down.  If it 

reoccurs continuously, move the tester 

to a cooler room. 

TARGET 

CAPACITY NOT 

MET after service 

116 Final capacity of the battery is below the 

target capacity.  Attempts to improve battery 

capacity did not succeed in bringing capacity 

above target. 

Battery is old and has less operating 

time than manufacturer’s specification. 

TRICKLE CHARGE 3 The program is running a trickle 
charge. 

The reconditioning process is complete 
and the battery is being recharged. 

 

SOFT 128 Battery voltage is too high.  Processing 
has ended. 

Battery may be a high capacity 
type battery.  

Check that correct contacts are 
used. 

Battery may be in poor condition. 

USER 

PROGRAMMED 

TIMEOUT 

33 The time programmed in a custom 
program setup has completed. 

The program goes to the next step. 
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6 Glossary of Terms 

Amp 

Abbreviation for ampere. 

Amperage 

The strength of a current of electricity expressed in amperes. 

Ampere 

The current produced by one volt across a resistance of one ohm. 

AWG 

American Wire Gauge (US wire size standard). 

Backup 

To copy computer files to removable media (such as a writable CD, writable 
DVD or magnetic tape) files containing data that was current at the time of 
backup.  The latest backup data can be restored to a hard disk in the event that 
files on the hard disk have become damaged. 

Battery 

An electrochemical device comprising two or more galvanic (voltaic) cells 
connected to one another, usually in series. 

Battery Cycle 

A charge followed by a discharge (or a discharge followed by a charge).  A cycle 
is considered to have occurred even if the battery has only been partially charged 
and discharged. 
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Boot 

Start or re-start a computer by reloading its operating system into random access 
memory (RAM).  Any data that was stored in RAM is lost when a computer is re-
booted. 

Byte 

One alphanumeric character or symbol, comprising eight data bits with or 
without a stop bit and with or without a parity bit. 

Capacity 

The amount of energy (in mAh) that a fully charged battery is capable of 
holding. 

C-Code 

Configuration Code, battery parameters that are stored in Cadex Battery Testers, 
and tell the C8000 how to service a specific battery type. 

Cells 

Individual units within a battery.  Cells are connected in series or parallel with 
one another in the battery. 

Check Box 

A square box displayed in a program dialog box, that can contain white space, 
indicating deselected, or a check mark, indicating selected.  When you click the 
box, it toggles between selected and deselected. 

Comm. port 

Communications port (RS-232C serial port) on a computer used for attaching 

modems or other serial interface peripheral devices.  An Intel® compatible PC 
may have up to 4 COM ports (COM1, COM2, COM3, and COM4). 

Configuration Code 

Battery parameters that are stored in Cadex battery testers, and tell the C8000 
how to service a specific battery type. 

C-Rate 

A value (C number) that is used to calculate charge and discharge times.  A 
discharge of 1 C draws a current equal to the rated capacity of the battery.  A 
discharge of 0.5C would take twice as long to fully discharge the battery. 
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Cycle 

One charge and discharge sequence, even if the battery is only partially charged 
or discharged. 

DAO 

A software component, which provides a common interface between an 
application and one or more data storage devices, such as a database files. 

Default 

Default settings or values are the original settings or values built in by the 
manufacturer, before any changes made by users. 

Dialog Box 

A graphical user interface window in which a user can enter or select parameters 
for use by a computer program. 

Dual Port Cable 

Used to parallel discharge.  

EPSU 

Emergency power supply unit. 

Field 

A text box or pull down list (in a dialog box) used for display or entry of 
parameter settings, etc. 

Firmware 

Software and/or data stored in read only memory (ROM), embedded in a device 
for the purpose of control of and communication with the device by a computer. 

Folder 

A computer disk directory or sub-directory, used for storing files.  A folder is the 
disk file equivalent of a drawer in a filing cabinet. 

Host 

A computer to which other devices on a network can connect to access services. 
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Impedance 

The opposition offered by an electric circuit to the flow of an alternating current 
of a single frequency.  It is a combination of resistance and reactance and is 
measured in ohms. 

Intrinsically Safe (I/S) 

A battery with built-in safety protection circuitry.  I/S batteries are used in 
volatile environments. 

Leading zeros 

Zeroes that precede the first significant digit (1 through 9) in a number. 

LAN 

Local area network. 

LCD 

Liquid Crystal Display.  A type of display panel often used on the front panel of 
electronic devices, such as the C8000 Battery Tester. 

LCU 

Load Capture Unit. 

LED 

Light emitting diode.  LEDs are used to display status of a device. 

Li-ion 

Lithium-ion battery chemistry. 

Li-polymer 

Lithium-polymer battery chemistry.  This chemistry is treated similarly to Li-ion. 

mA 

Milliampere.  One thousandth of an ampere.  Also called milliamp. 

mAh 

Milliampere hour.  Battery capacity rating.  A current of one milliampere for one 
hour. 
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Matrix 

The set of battery parameters for a specific battery model that is stored with a C-
Code during the Q-Learn or Learn process.  The matrix is used for doing a 
QuickTestTM on batteries of the same model. 

Memory 

Capacity loss in NiCD and NiMH batteries, caused by an increase in the size of 
crystals formed within the battery. 

Milliampere Hour 

Battery capacity rating, a current of one milliampere for one hour.  Abbreviation 
mAh. 

mOhm 

Milliohm, a measure of resistance or impedance, one thousandth of an ohm. 

RMA 

Return Material Authorization.  A number or form that must be obtained from 
Cadex to return goods for a warranty claim 

NiCD 

Nickel-cadmium battery chemistry. 

NiMH 

Nickel-metal-hydride battery chemistry. 

OEM 

Original equipment manufacturer. 

Ohm 

The SI unit of electrical resistance, transmitting a current of one ampere when 
subjected to a potential difference of one Volt. 

Password 

Passwords must be entered precisely as they were set up.  Passwords are case 
sensitive.  For example, 'a' will not be recognized as 'A’. 

PC 

IBM compatible personal computer. 
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Ping 

Packet Internet Groper.  A software utility used to determine what devices are 
available and responsive on a network. 

Radio Button 

A circle displayed in a program dialog box, that can contain white space, 
indicating deselected, or a black dot, indicating selected.  When you click a radio 
button, it is selected and all the other displayed radio buttons for alternative 
options are deselected. 

 

Recondition 

A deep discharge below 1 volt per cell with a controlled current.  Reconditioning 
applies only to NiCD and NiMH batteries.  Reconditioning helps break down 
large crystals, which develop as a result of memory, to more desirable small 
sizes.  Reconditioning often restores a battery to its full capacity. 

Required Field 

A data field that must have appropriate data entered in it.  Required fields are 
usually identified by an asterisk (*) beside the field name. 

Residual Capacity 

Capacity remaining in a battery when it is connected to a C8000. 

Resistance 

Also called internal resistance of a battery.  Opposition to current flow. 

RF 

Radio frequency. 

P/N 

Part Number. 

Self Discharge 

Battery capacity lost during storage, because of internal leakage between the 
positive and negative cell plates. 
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Serial port 

Serial communications port (RS-232C serial port) on a computer used for 

attaching modems or other serial interface peripheral devices.  An Intel® 
compatible PC may have up to 4 COM ports (COM1, COM2, COM3, and COM4). 

Smart Battery 

A battery equipped with circuits that can communicate with a charger. 

State of Charge 

The energy content of a battery. 

State of Health 

The condition of a battery, that considers its capacity, resistance, and self-
discharge. 

SoC 

State of Charge. 

SoH 

State of Health 

SLA 

Sealed lead acid battery chemistry. 

Target Capacity 

The capacity level (as a percentage of the manufacturer-stated battery capacity) 
that a battery must have to pass a test of battery capacity.  The target capacity is 
an arbitrary benchmark set by the user.  The default setting is 80%, but it can be 
changed. 

TCP/IP 

Transmission Control Protocol/Interface Protocol.  A protocol used for computer 
communications. 

Toggle 

A function that has two states (for example On and Off) that are selected 
alternately each time you click the same button or check box. 

Trickle Charge 

A maintenance charge used to compensate for battery self-discharge. 
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UDP 

User datagram protocol, UDP uses ports to allow application-to-application 
communication on networked computers. 

UPS 

Uninterruptible Power Supply, a device that prevents a power blackout or 
brownout from causing a computer to lose data.  When AC from the power 
utility fails, a UPS converts DC battery power to AC, providing AC power for a 
period of time sufficient for you to shut down the computer. 

USB 

Universal Serial Bus.  A serial bus standard to interface devices. 

User Interface 

The LCD display, LEDs and input keys on the front panel of a battery tester, 
used to display status and control battery tests. 

Volt 

The SI unit of electromotive force, the difference of potential that would carry 
one ampere of current against one ohm of resistance. 

Volts 

Electric potential difference expressed in volts. 

 

 

 

 

 


